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Unit – I     [ Computer Fundamental ] 

WHAT IS A COMPUTER? 

Computer is a device that transforms data into meaningful information. Data can be anything like marks obtained by you in 

various subjects. It can also be name, age, sex, weight, height, etc. of all the students in a class. 

Computer can also be defined in terms of functions it can perform. A computer can i) accept data, ii) store data, iii) process data 

as desired, and iv) retrieve the stored data as and when required and v) print the result in desired format. 

The major characteristics of a computer are high speed, accuracy, diligence, versatility and storage. 

The computer performs basically five major operations of functions irrespective of their size and make. These are  

1) it accepts data or instruction by way of input,  

2) it stores data,  

3) it can process data as required by the user, 

 4) it gives results in the form of output,  

 5) it controls all operations inside a computer. We discuss below each of these operations. 

1. Input: this is the process of entering data and programs into the computer system. 

Input unit Output unit 

Memory Unit 

Control Unit 

Arithmetic Logic Unit 

2. Control Unit (CU): The process of input, output, processing and storage is performed under the supervision of a unit called 

'Control Unit'. It decides when to start receiving data, when to stop it, where to store data, etc. It takes care of step -by-step 

processing of all operations in side the computer.  

3. Memory Unit: Computer is used to store data and instructions.  

4. Arithmetic Logic Unit (ALU): The major operations performed by the ALU are addition, subtraction, multiplication, 

division, logic and comparison.  

5. Output: This is the process of producing results from the data for getting useful information. The ALU and the CU of a 

computer system are jointly known as the central processing unit (CPU). You may call CPU as the brain of any computer 

system. 

 PERIPHERAL DEVICES 

Peripheral devices are  connected to the computer externally. These devices are used for performing some specific functions. 

Peripheral devices are as follows:  

1. Input Devices  

2. Output Devices  

3. Other Peripherals 



4. Data Entry Operations 

INPUT DEVICES 

Input devices accept data and instructions from the user. Following are the examples of various input devices, which are 

connected to the computer for this purpose.  

1. Keyboard  

2. Mouse  

3. Light Pen 

 4. Optical/magnetic Scanner  

5. Touch Screen  

6. Microphone for voice as input  

7. Track Ball 

 Keyboard 

A keyboard  is the most common input device. Several kinds of keyboards are available, but they resemble each other with 

minor variations. The keyboard in most common use is the QWERTY board. Generally standard keyboard has 104 keys. In these 

keyboards, the cursor control keys are duplicated to allow easier use of the numeric pad.  

Keyboards vary greatly in the number and arrangement of keys.  Most keyboards include the following:   

a. Alphanumeric keys - The letters of the alphabet, numerals, and punctuation symbols (numeric keypads may be separate on 

portable computers). b. Dedicated formatting keys - Keys for text formatting operations such as a Space bar, a Tab key, and a 

Return or Enter key. c. Modifier keys - Keys that modify or qualify the effects of other keys for as long as they are held down, 

for example, Shift, Ctrl, and Alt. d. Navigation keys - Keys that move a cursor, for example, Arrow keys, Home, End, Page Up, 

and Page Down. e. Fixed-function key - Keys provided for extra or general functions, typically labeled F1, F2, and so on. f. 

Special purpose keys - Keys that have a special function, such as Help, Delete, and Backspace.   When to use.  If applicable, 

keyboards shall be provided for the entry of alphabetic, numeric, and other special characters into the system.  ,   Include a 

numeric keypad for entering numeric data.  If an application requires substantial and repetitive input of numeric data, the 

keyboard shall include a numeric keypad.   

Keyboards intended solely for the entry of numbers shall have the numerals "1" through "9" arranged in a three by three array, 

with "0" centered below the bottom row.    Numeric keyboards for communication.  If the keyboard will be used primarily for 

communications, it shall use the "telephone" arrangement, that is, with the numerals 1, 2, and 3 in the top row.    Numeric 

keyboards for number manipulation.  If the keyboard will be used primarily for manipulating numbers, it shall use the 

"calculator" arrangement, that is, with the numerals 1, 2, and 3 in the bottom row.   

   Alphanumeric keyboards.  Keyboards intended for the entry of both alphabetic and numeric information shall conform to the 

standard "QWERTY" arrangement.   

 

   Key size.  The minimum horizontal surface width for a key on a typing keyboard should be 12 mm 

  Horizontal spacing of keys.  Horizontal centerline distances should be between 18-19 mm.   

  Vertical spacing of keys.  Vertical centerline distances should be between 18-21 mm.   

   Force to depress keys.  The maximum force needed to depress keys shall measure between 0.25N and 1.5N with a preferred 

range between 0.5N and 0.6N.   



  Keyboard slope.  The slope of the keyboard for typing should be between 0 and 25 degrees, preferably less than 15 degrees.    

Standard keyboards.  If feasible, standard keyboards should be used.  Nonstandard keyboards should contain only those keys that 

are used by the keyboard user.    The presence of non-relevant keys, such as those that might be used by programmers, adds to 

keyboard complexity and may induce errors.  If a keyboard will be used for text processing, it shall provide for movement of the 

cursor in two dimensions, for example by including a set of cursor control keys.   

   Cursor control key layout.  If cursor control keys are included, they should be arranged in a two-dimensional array.  Cursor 

movement keys.  Cursor movement keys shall be arranged in a spatial configuration reflecting the direction of actual cursor 

movement.   

 Mouse 

A mouse is an electro-mechanical, hand-held device .It is used as a pointer. It can perform functions like selecting menu 

commands, moving icons, resizing windows, starting programs, and choosing options. 

The most common mouse uses an internal, magnetically coated ball, to detect the movement of the mouse across a flat surface, 

usually a desktop. Now a days Optical or laser mouse is used to detect the movement.  All windows based applications today are 

designed to work with a mouse. A mouse is used to replace hard -to-remember key combinations with easier "Point and Click" 

actions. However, it cannot substitute all keyboard operations. It can be alternative for commands based operations. 

 Light pen 

An input device that utilizes a light-sensitive detector to select objects on a display screen. A light pen is similar to a mouse 

except that with a light pen you can move the pointer and select objects on the display screen by directly pointing to the objects 

with the pen. 

 Optical Scanner 

These devices are used for automatic data collection. The devices of this category completely eliminate manual input of data. For 

example, the bar-code reader is actually just a special type of image scanner. An image scanner translates printed 

 

images into an electronic format that can be stored in a computer’s memory, and with the right kind of software, one can alter a 

stored image. Another example of scanner is optical character recognition (OCR) device, used by banks to convert the scanned 

image of a typed or printed page into text that can be edited on the computer. 

 Touch Screen 

Touch panel displays and pads are now being offered as alternatives to keyboard. Here the input can be given through the 

computer screen, that accepts the input through monitor; users touch electronic buttons displayed on the screen or they may use 

light pen. 

 Microphone 

Microphone is an input device, which takes voice as input. The voice communication is more error-prone than information 

through keyboard. There are two types of microphones available (as shown in figure 1.8): 

1. Desktop Microphone 

2. Hand held Microphone 

 Track Ball 



Trackball, a pointing device, is a mouse lying on its back (as shown in figure 1. 9). To move the pointer, you rotate the ball with 

your thumb, your fingers, or the palm of your hand. There are usually one to three buttons next to the ball, which you use just 

like mouse buttons. 

The advantage of trackballs over mouse is that the trackball is stationary so it does not require much space to use it. In addition, 

you can place a trackball on any type of surface, including your lap. For both these reasons, trackballs are popular pointing 

devices for portable computers. 

 OUTPUT DEVICES 

Output devices return processed data that is information, back to the user. Some of the commonly used output devices are: 

1. Monitor (Visual Display Unit) 

2. Printers 

3. Plotter 

4. Speakers 

 Monitor 

Out of all the output devices, monitor (as shown in figure 1.10) is perhaps the most important output device because people 

interact with this device most intensively than others. Computer information is displayed, visually with a video adapter card and 

monitor. Information processed within the CPU, that needs to be visually displayed, is sent to video adapter. The video adapter 

converts information from the format used, in the same manner as a television displays information sent to it by a cable service. 

Two basic types of monitors are used with microcomputers, which are as follows: 

1. CRT 

2. LCD 

Cathode Ray Tube (CRT): CRT or Cathode Ray Tube Monitor is the typical monitor that you see on a desktop computer. It 

looks a lot like a television screen, and works the same way. This type uses a large vacuum tube, called cathode ray tube (CRT). 

Liquid Crystal Displays (LCD): This type of monitors are also known as flat panel monitor. Most of these employ liquid crystal 

displays (LCDs) to render images. These days LCD monitor are very popular. 

When people talk about the capabilities of various monitors, one critical statistic is the resolution of the monitor. Most monitors 

have a resolution of at least 800 x 600 pixels. High-end monitors can have resolutions of 1024 x 768 pixels or even 1280 x 1024 

pixels. Thus monitors are available either in low resolution or in high resolution. 

 Printer 

After a document is created on the computer, it can be sent to a printer for a hard copy (printout). Some printers offer special 

features such as colored and large page formats. Some of the most commonly used printers are: 

1. Laser Printer 

2. Ink Jet Printer 

3. Dot Matrix Printer 

4. Line Printer 

Laser Printer: A laser printer produces high quality print that one normally finds in publishing. It is extremely fast and quiet. 

Moreover, the operation of a laser printer is easy with automatic paper loading and no smudging or messing up of ink ribbons. 

The fastest laser printer 



can print up to 200 pages per minute in monochrome (black and white) and up to 100 pages per minute in colour. 

Ink-Jet Printer: An ink-jet printer creates an image directly on paper by spraying ink through as many as 64 tiny nozzles. 

Although the image it produces is not generally quite as sharp as the output of a laser printer, the quality of ink-jet images is still 

high. 

In general, ink-jet printer offers an excellent middle ground between dot matrix and laser printer. Like laser printer, an ink-jet 

printer is quiet and convenient, but not particularly fast. 

Typically, an ink-jet printer is more expensive than a dot-matrix printer, but costs only half as much as a laser printer. 

Dot Matrix Printer: The dot matrix printer was very popular at one point of time. It is a very versatile and inexpensive output 

device. In dot matrix printer the print head physically "hits" the paper through the ribbon and produces text (or images) by 

combinations of dots; hence the name dot matrix printer. Its speed is measured in characters per second (CPS). Although it is 

less expensive, it is louder, slower and produces lower print quality. 

Line Printer: A line printer is generally used with large computer systems to produce text based data processing reports. Line 

printers are high-speed printers with speeds ranging anywhere from 100 to about 3800 lines per minute. In the past, print quality 

on line printers was not high. Developments in technology are improving the print quality on line printers. These are in the cost 

range of lacs of Rupees. 

 Plotter 

A plotter is a special kind of output device that, like a printer, produces images on paper, but does so in a different way. Plotters 

are designed to produce large drawings or images, such as construction plans for buildings or blueprints for mechanical objects. 

A plotter can be connected to the port normally used by a printer. 

An array of different colored pens in a clip rack and a robotic arm is part of plotter. The instructions that a plotter receives from a 

computer consist of a color, and beginning and ending coordinates for a line. With that information, the plotter picks up the 

appropriate pen through its arm, positions it at the beginning coordinates drops the pen down to the surface of the paper and 

draws to the ending coordinates. Plotters draw curves by creating a sequence of very short straight lines. 

Plotters usually come in two designs: 

1. Flat Bed: Plotters of small size to be kept on table with restriction of paper size. 

2. Drum: These plotters are of big size using rolls of paper of unlimited length. 

 SOFTWARE 

As you are aware, computer cannot do anything on its own. It is the user who instructs computer; what to do, how to do and 

when to do. In order to perform any task, you have to give a set of instructions in a particular sequence to the computer. These 

sets of instructions are called Programs. Software refers to a set of programs that makes the hardware perform a particular set of 

tasks in particular order. Software can be classified mainly into following categories and sub-categories are  

Software  

System Software Application Software  

Generalized Packages  

Customized Packages   

Utilities  

Operating System  

 System Software 



When you switch on the computer the programs stored in ROM are executed which activates different units of your computer 

and makes it ready for you to work on it. This set of programs can be called system software. 

System softwares are sets of programs, responsible for running the computer, controlling various operations of computer systems 

and management of computer resources. Operating System (OS) falls under this category. 

An operating system is a system software that provides an interface for a user to communicate with the computer, manages 

hardware devices (disk drives, keyboard, monitor, etc), manages and maintains disk file systems and supports application 

programs. Some popular Operating systems are UNIX, Windows and Linux. 

Although operating system provides all the features users need to use and maintain their systems, inevitably, they still do not 

meet everyone’s expectations.  This has led to another type of system software called "Utilities". These are programs that bridge 

the gap between the functionality of an OS and the needs of users. Utility programs are a broad category of software such as 

compress (zip)/uncompress (unzip) files software, anti virus software, split and join files software, etc. 

 Application Software 

Application software is a set of programs, which are written to perform specific tasks, for example: An application package for 

managing library known as library information system is used to manage information of library such as: keeping book details, 

account holder details, book issue details, book return details etc. Another application package for managing student details is 

called student’s information system, manages student’s roll no, name, parents name, address, class, section, processing of 

examination results etc. Application software can be broadly classified into two types: 

(a) Generalized packages 

(b) Customized packages 

Generalized Packages 

These are user friendly softwares written to cater to user’s very general needs such as preparing documents, drawing pictures, 

database to manage data/information, preparing presentations, play games etc. 

It is a group of programs that provide general purpose tools to solve specific problems. Some of the generalized packages are 

listed below: 

Word Processing Software(for preparing documents): Word Perfect, MS-Word, OpenOffice.org Writer 

Spreadsheets (Data Analysis): Lotus Smart suites, MS- Excel, OpenOffice.org Calc, Apple Numbers 

Presentations : Presentation Graphics, MS-PowerPoint, OpenOffice.org Impress 

Database Management System: MS-Access, OpenOffice.org Base, MS-SQL Server, ORACLE 

Graphics Tools: Paint shop pro, Adobe Photoshop 

Customized Packages 

Computer Generations 

Generation in computer terminology is a change in technology a computer is/was being used. Initially, the generation term was 
used to distinguish between varying hardware technologies. But nowadays, generation includes both hardware and software, 
which together make up an entire computer system. 

There are totally five computer generations known till date. Each generation has been discussed in detail along with their time 
period, characteristics. We've used approximate dates against each generations which are normally accepted. 

Following are the main five generations of computers: 

S.N. Generation & Description 



1 
First Generation 
The period of first generation: 1946-1959. Vacuum tube based. 

2 
Second Generation 
The period of second generation: 1959-1965. Transistor based. 

3 
Third Generation 
The period of third generation: 1965-1971. Integrated Circuit based. 

4 
Fourth Generation 
The period of fourth generation: 1971-1980. VLSI microprocessor based. 

5 
Fifth Generation 
The period of fifth generation: 1980-onwards. ULSI microprocessor based 

First Generation 

The period of first generation was 1946-1959. 

First generation of computers started with using vacuum tubes as the basic components for memory and circuitry for 
CPU (Central Processing Unit). These tubes like electric bulbs produced a lot of heat and were prone to frequent 
fusing of the installations, therefore, were very expensive and could be afforded only by very large organisations. 

In this generation, mainly batch processing operating systems were used. In this generation, Punched cards, Paper 
tape, Magnetic tape Input & Output device were used.  

There were machine codes and electric wired board languages used. 

 

The main features of First Generation are: 

• Vacuum tube technology 

• Unreliable 

• Supported Machine language only 



• Very costly 

• Generate lot of heat 

• Slow Input/Output device 

• Huge size 

• Need of A.C. 

• Non-portable 

• Consumed lot of electricity 

Some computers of this generation were: 

• ENIAC 

• EDVAC 

• UNIVAC 

• IBM-701 

• IBM-650 

Second Generation 

The period of second generation was 1959-1965. 

This generation using the transistor were cheaper, consumed less power, more compact in size, more reliable and 
faster than the first generation machines made of vacuum tubes. In this generation, magnetic cores were used as 
primary memory and magnetic tape and magnetic disks as secondary storage devices. 

In this generation, assembly language and high-level programming language like FORTRAN, COBOL were used. 

There were Batch processing and Multiprogramming Operating system used.  

 

The main features of Second Generation are: 



• Use of transistors 

• Reliable as compared to First generation computers 

• Smaller size as compared to First generation computers 

• Generate less heat as compared to First generation computers 

• Consumed less electricity as compared to First generation computers 

• Faster than first generation computers 

• Still very costly 

• A.C. needed 

• Support machine and assembly languages 

Some computers of this generation were: 

• IBM 1620 

• IBM 7094 

• CDC 1604 

• CDC 3600 

• UNIVAC 1108 

Third Generation 

The period of third generation was 1965-1971. 

The third generation of computer is marked by the use of Integrated Circuits (IC's) in place of transistors. A single 
IC has many transistors, resistors and capacitors along with the associated circuitry. The IC was invented by Jack 
Kilby. This development made computers smaller in size, reliable and efficient. 

In this generation, Remote processing, Time-sharing, Real-time, Multi-programming Operating System were used. 

High-level language (FORTRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, ALGOL-68, etc.) were used during 
this generation. 

 



The main features of Third Generation are: 

• IC used 

• More reliable 

• Smaller size 

• Generate less heat 

• Faster 

• Lesser maintenance 

• Still costly 

• A.C. needed 

• Consumed lesser electricity 

• Support high-level language 

Some computers of this generation were: 

• IBM-360 series 

• Honeywell-6000 series 

• PDP(Personal Data Processor) 

• IBM-370/168 

• TDC-316 

Fourth Generation 

The period of Fourth Generation was 1971-1980. 

The fourth generation of computers is marked by the use of Very Large Scale Integrated (VLSI) circuits. VLSI 
circuits having about 5000 transistors and other circuit elements and their associated circuits on a single chip made it 
possible to have microcomputers of fourth generation. Fourth Generation computers became more powerful, 
compact, reliable, and affordable. As a result, it gave rise to personal computer (PC) revolution. 

In this generation, Time sharing, Real time, Networks, Distributed Operating System were used. 

All the higher level languages like C and C++, DBASE, etc., were used in this generation. 



 

The main features of Fourth Generation are: 

• VLSI technology used 

• Very cheap 

• Portable and reliable 

• Use of PC's 

• Very small size 

• Pipeline processing 

• No A.C. needed 

• Concept of internet was introduced 

• Great developments in the fields of networks 

• Computers became easily available 

Some computers of this generation were: 

• DEC 10 

• STAR 1000 

• PDP 11 

• CRAY-1 (Super Computer) 

• CRAY-X-MP (Super Computer) 

Fifth Generation 



The period of Fifth Generation is 1980-till date. 

In the fifth generation, the VLSI technology became ULSI (Ultra Large Scale Integration) technology, resulting in 
the production of microprocessor chips having ten million electronic components.  

This generation is based on parallel processing hardware and AI (Artificial Intelligence) software.  

AI is an emerging branch in computer science which interprets means and methods of making computers think like 
human beings. 

All the higher level languages like C and C++, Java, .Net, etc., are used in this generation. 

AI includes: 

• Robotics 

• Neural networks 

• Game Playing 

• Development of expert systems to make decisions in real life situations. 

• Natural language understanding and generation. 

 

The main features of Fifth Generation are: 

• ULSI technology 

• Development of true artificial intelligence 

• Development of Natural language processing 

• Advancement in Parallel Processing 

• Advancement in Superconductor technology 

• More user friendly interfaces with multimedia features 



• Availability of very powerful and compact computers at cheaper rates 

Some computers types of this generation are: 

• Desktop 

• Laptop 

• NoteBook 

• UltraBook 

• ChromeBook 

Classification of Computers 

Computers differ based on their data processing abilities. They are classified according to purpose, data handling 

and functionality. 

According to purpose, computers are either general purpose or specific purpose. General purpose computers are 

designed to perform a range of tasks.  

They have the ability to store numerous programs, but lack in speed and efficiency. Specific purpose computers are 

designed to handle a specific problem or to perform a specific task. A set of instructions is built into the machine.  

According to data handling, computers are analog, digital or hybrid. Analog computers work on the principle of 

measuring, in which the measurements obtained are translated into data. Modern analog computers usually employ 

electrical parameters, such as voltages, resistances or currents, to represent the quantities being manipulated. Such 

computers do not deal directly with the numbers. They measure continuous physical magnitudes. Digital computers 

are those that operate with information, numerical or otherwise, represented in a digital form. Such computers 

process data into a digital value (in 0s and 1s). They give the results with more accuracy and at a faster rate. Hybrid 

computers incorporate the measuring feature of an analog computer and counting feature of a digital computer. For 

computational purposes, these computers use analog components and for storage, digital memories are used.  

According to functionality, computers are classified as :  

Analog Computer  

 An analog computer (spelt analogue in British English) is a form of computer that uses continuous physical 

phenomena such as electrical, mechanical, or hydraulic quantities to model the problem being solved  
 

Digital Computer 

 A computer that performs calculations and logical operations with quantities represented as digits, usually in the 
binary number system  
 

Hybrid Computer (Analog + Digital)  

 A combination of computers those are capable of inputting and outputting in both digital and analog signals. A 
hybrid computer system setup offers a cost effective method of performing complex simulations.  
  

On the basis of Size  
 

Super Computer  



 

The fastest and most powerful type of computer Supercomputers are very expensive and are employed for 
specialized applications that require immense amounts of mathematical calculations. For example, weather 
forecasting requires a supercomputer. Other uses of supercomputers include animated graphics, fluid dynamic 
calculations, nuclear energy research, and petroleum exploration.  

The chief difference between a supercomputer and a mainframe is that a supercomputer channels all its power into 
executing a few programs as fast as possible, whereas a mainframe uses its power to execute many programs 
concurrently.  

Mainframe Computer  

 

A very large and expensive computer capable of supporting hundreds, or even thousands, of users simultaneously. In 
the hierarchy that starts with a simple microprocessor (in watches, for example) at the bottom and moves to 
supercomputers at the top, mainframes are just below supercomputers. In some ways, mainframes are more 
powerful than supercomputers because they support more simultaneous programs. But supercomputers can execute 
a single program faster than a mainframe.  

Mini Computer  

A midsized computer. In size and power, minicomputers lie between workstations and mainframes. In the past 

decade, the distinction between large minicomputers and small mainframes has blurred, however, as has the 

distinction between small minicomputers and workstations. But in general, a minicomputer is a multiprocessing 

system capable of supporting from 4 to about 200 users simultaneously.  

 Micro Computer or Personal Computer  

     Desktop Computer: a personal or micro-mini computer sufficient to fit on a desk. 

•  Laptop Computer: a portable computer complete with an integrated screen and keyboard. It is 

generally smaller in size than a desktop computer and larger than a notebook computer. 

•  Palmtop Computer/Digital Diary /Notebook /PDAs: a hand-sized computer. Palmtops have no 

keyboard but the screen serves both as an input and output device.  

Workstations 

A terminal or desktop computer in a network. In this context, workstation is just a generic term for a user's machine 

(client machine) in contrast to a "server" or "mainframe." 

PC as a Virtual Office 

The term "virtual office" implies space utilization, but a full application includes professional live 
communications.[7] 

1. Communications services  

1. Remote receptionist – A team of workers in an office environment working remotely, using high-
tech Computer Telephone Integration software, to replace a traditional receptionist. 

2. Virtual Assistant- A virtual assistant is often a "lone eagle" working from home, who rarely 
meets their clients face-to-face. A virtual assistant typically has no access to CTI Software. Rates 
run $25 an hour and up.  

3. Answering services/Call Centres  - operate from a centralized location for the purpose of 
receiving and transmitting a large volume of requests by telephone. Users lament problems of 
security, impersonal staff with high turnover, language barriers, translation errors and a less-than-
professional image. When selecting an answering service, look for one based in your own country 
so that there are no language barriers. 

4. Voicemail - It is a low-cost technology that stores voice messages electronically. In customer 
service applications, voicemail has limitations. Used for customer service, voicemail has become 
synonymous with frustration. The complaints are legion and have inspired spoofs on the voicemail 



experience. Studies also show that up to 75% of callers simply hang up when their call is 
answered by a machine. 

5. Virtual office space – Virtual office gives you a chance to own a high profile reputed address in a 
city of your choice, at a fraction of the buying or renting cost of such an address. 

6. Phone answering service – Virtual office phone answering service bridging the gap between you 
and your numerous clients. 

2. Space services  

1. Professional address – A prestigious building to be used as the business address. A professional 
address alleviates the privacy and personal security concerns of running a home-based business. A 
user can expand into new markets by utilizing a provider with multiple locations to establish a 
professional presence in the desired growth markets. 

2. Mailing address – The professional address can be used for accepting, sending and forwarding 
mail without the connotations of a PO Box. Under US law, a PO box is to be clearly indicated and 
so not conducive for most corporate entities in this regard. Some VO providers offer 24/7 access 
to individually assigned and locked mailboxes. This allows the staff of a VO user to have a 
centralized location as a convenient vehicle for the secure transfer of paper documents 24/7.  

3. Open envelope scanning – A handler opens the mail and scans the contents, emailing or 
transferring the digitized documents onto a cloud-based file storage system that users can access 
immediately. The opened physical mail is then shredded unless further storage is requested.[19] 

4. Reception courtesies –  Receptionists at the business address can receive and sign for incoming 
overnights, deliveries, packages and provide document drop-off/pick-up services. On-site 
witnesses and notaries may be available, depending on the provider. 

5. Business meeting space – The on-demand use (hourly, daily or weekly) of conference rooms and 
offices for meetings. Meeting space can often be rented at short notice.  

6. Casual workspace – As an alternative to the distractions of co-working or the interruptions of a 
home office, office space is available on an occasional or "drop-in" basis, either hourly, daily or 
monthly. 

7. Executive Suite – A small percentage of VO users lease space full-time time.  
8. On-site amenities – A full-service virtual office will provide broadband Internet,fax,printer, 

advanced phone features, conference calling,video conferencing and a business-worthy 
lobby/waiting area. 

9. Virtual office solution – Virtual office solution gives dual advantages in whichever city you need 
and a reputed business address which would marginalize the gap created by established brand 
value. 

10. Live virtual receptionist – A virtual answering service is an automated system with a live virtual 
receptionist. These kind of services can be enjoyed without purchasing expensive equipment. 

11. Other services - Other services may include creation of a website, business cards, attorney 
consultations. 

A virtual office blends home and work to gain efficiencies in both places.Office expenses are low, while the user's 
professionalism retains the image of a traditional, high-cost office. A virtual office user can reduce their 
environmental impact, as well as the personal negatives of a daily commute.Virtual office clientele have the 
flexibility to match expenses with revenue fluctuations immediately, as the costs are usually variable. A virtual 
office can allow for low-cost expansion with no long-term commitments. Users taking advantage of virtual office 
receptionists eliminate the traditional burden of health care, records, payroll, insurance & rent. Also, traditional 
time-off (sick days, vacations, personal leaves, etc.…) does not apply to a virtual staff.  

Economy 

Virtual offices are experiencing growth even in a recessionary economy and not just in the United States. As 
businesses look to trim expenses, virtual office services help reduce overhead while keeping professionalism high. 
For example, by paying for space and communication infrastructure on an as-needed basis, businesses can keep 
office expenses to a minimum. The portability of today's technology also allows for a more flexible work 

environment.http://en.wikipedia.org/wiki/Virtual_office - cite_note-32 As businesses trend to a more "online" 

workplace, the notion of paying for space full-time becomes anachronistic. Traditional receptionists making $12–
14/hour can be replaced with remote receptionist services at a fraction of the traditional 

cost.http://en.wikipedia.org/wiki/Virtual_office - cite_note-35 Some virtual office companies or telephone 

answering companies offer a franchise system, enabling entrepreneurs to enter the marketplace for a fraction of the 
usual set up costs and with the added bonus of leads being fed to them. 

Unit – II      [ Information Technology ] 



 

Computer Network : It is build up to provide a mean to communicate data from source computer to destination 

computer . It depends upon the requirements of the users which type of facilities they want to avail and is beneficial 

for them . Computer networking is the connectivity among computers to allow communication between computer 

systems or devices. A computer network is any set of computers or devices connected to each other with the ability 

to exchange data.     

Generally , three types of computer networks are available which are : 

1) Local Area Network 

2) Metropolitian Area Network 

3) Wide Area Network 

1)  Local Area Network (LAN)  : Local Area Network (LAN) , which is usually a small network 

constrained to a small geographic area like a home, office, or group of buildings e.g. a school.   Generally 

it is installed within a area of 15 Km to fulfill the requirements of the companies,offices,super 

market,universities , big hospitals etc. 

LAN is having five types of topologies :  

Network Topology : The specific physical, i.e.,real, or logical, i.e.,virtual, arrangement of the elements of 

anetwork. Two networks have the same topology if the connection configuration is the same, although the networks 

may differin physical interconnections, distances between nodes, transmission rates, and/or signal types.  

 

Star Topology :  

• Startopology: there is a central node (switch) and peripheral nodes. The peripheral nodes are connected to 

thecentralnode, which rebroadcasts all transmissions received from any peripheral nodes to all peripheral 

nodes on the network, including the originating node.Ex: switched Ethernet LAN. 

• Extended star: links individual stars together,by linking the centers (hubs/switches); also known as 

snowflake topology. 

• Needfor more distance between computers => Layer 1 device repeater 

• Needfor more workgroup connectivity=>multiportrepeater, or hub.  

• Need for traffic filter => bridge as a way to filter network traffic into local and non- local traffic (Layer 2 

device, based on physical address) 

• Need for Layer 2 connectivity(port-density)=>a multiportbridge, or switch 

• As networks grew, the diversity of platforms, protocols, and media, the geographic distance between 

computers, the number of computers wishing to communicate, and the dynamism inherent in large 

networks,all necessitated the development of the router.Layer 3 device which makes best path and 

switching decisions based on network addresses. 

 

Ring topology 

Ring topology: every node has exactly two branches connected to it(a succession of point-to-point links).Stations 

are connected using interfaces (repeaters). 



Ex: Token Ring LAN. 

Repeaters joined by point to point links in closed loop 

Receive data on one link and retransmit on another 

Links unidirectional 

Data in frames 

Circulate past all stations 

Destination recognizes address and copies frame 

Frame circulates back to source where it is removed 

Media access control determines when station can insert frame 

Dual Ring–allows for a second (reserve) ring; data flow has here an opposite direction; not all stations linked to 

both rings . 

Bus Topology 

Bus topology: all nodes, i.e.,stations, are connected together by a single bus(the main trunk).Stations are connected 

using interfaces, named transceivers or attachment units (AUI). Ex: pure Ethernet LAN, Token Bus. 

Multipoint medium 

Transmission propagates throughout medium  

Heard by all stations 

Need to identify target station 

Each station has unique address 

Full duplex connection between station and AUI 

Allows for transmission and reception 

Need to regulate transmission 

To avoid collisions and hogging 

Data in small blocks -frames 

Terminator absorbs frames at end of medium 

Hierarchical (tree) Topology 

Hierarchical(tree) Topology: existence of a central node(root) and of various sets of level organized nodes 

(intermediary nodes); the leaves of the tree are the workstations. The data flow between any two nodes goes up-

down using the upper levels nodes. 

Mesh Topology 

Mesh Topology:there are at least two nodes with two or more paths between them. 

 

Wide Area Network (WAN ) 

Wide Area Network (WAN ) is usually a larger network that covers a large geographic  

area. WANs are used to connect LANs and other types of networks together, so that users  



and computers in one location can communicate with users and computers in other locations.  By WAN we mean 

internet which is the most widely usable network by the users . It is a interconnection of various servers which is 

accessed through browsers and web servers.  Generally , LAN and MAN are combined to make WAN . 

  

Metropolitan Area Network 

Metropolitan Area Network: A Metropolitan Area Network is a network that connects two or more Local Area 

Networks or Campus Area Networks together but does not extend beyond the boundaries of the immediate town, 

city, or metropolitan area. Multiple routers, switches & hubs are connected to create a MAN.  Wireless LANs and 

WANs (WLAN & WWAN) is the wireless equivalent of the LAN and WAN. Wireless telecommunications  

networks are generally implemented with some type of remote information transmission system that uses 

electromagnetic waves, such as radio waves, for the carrier and this implementation usually takes place at the  

physical level or "layer" of the network.   

 
File service - Allows users to use and share file space on a computer with a lot of file  
space.   
  
Print service - Allows printing to printers connected on the network.   
By completing this module you will be able to understand and learn the following: 
   
  

Intranets and extranets may or may not have connections to the Internet. If connected  

to the Internet, the intranet or extranet is normally protected from being accessed from  

the Internet without proper authorization.   

An intranet is a set of interconnected networks, using the Internet Protocol and uses  

IP-based tools such as web browsers, that is under the control of a single administrative  

entity. That administrative entity closes the intranet to the rest of the world, and allows  

  

An extranet is a network or internetwork that is limited in scope to a single organization or entity but which also has 

limited connections to the networks of one or more other usually, but not necessarily, trusted organizations or 

entities.  Internet : A specific internetwork, consisting of a worldwide interconnection of  governmental, academic, 

public, and private networks. It is based upon the Advanced Research Projects Agency Network (ARPANET) 

developed by ARPA of the U.S.Department of Defense. Its also responsible for the World Wide Web (WWW).   

World Wide Web :   

The World Wide Web (commonly shortened to the Web ) is a system of interlinked hypertext documents accessed 

via the Internet. With a Web browser, a user views Web pages that may contain text, images, videos, and other 

multimedia and navigates between them using hyperlinks. The World Wide Web was created in 1989 by Sir Tim  

Berners-Lee, working at CERN in Geneva, Switzerland.  

Internet working:  

The Internet is a group of computers connected to share the information they hold. The  

connected computers belong to various agencies - government, universities, companies,  

individuals etc.         



  

Most of the Internet Services operate on the client/server model or concept. A computer is a client if it is receiving 

files, and is a server if it is sending files.  To gain access to the Internet most people open an account with an 

Internet Service Provider (ISP) in their area. To connect they "dial-up" to their ISP's server and "log-in" with their 

account name and password. Some of the services accessed through the internet are as follows Electronic Mail (E-

mail) E-mail, is the most popular service of the Internet. It is preferred s the messages get transmitted in seconds. A 

person also has the option to read and respond to the messages at one's convenience. People can send and receive e-

mail wherever they go, when they travel as long as they have access to a connected computer. People can  

send forms, documents, colored pictures, etc. through email as attachments Mailing List An electronic mailing list 

is used when somebody wants to send a message or newsletter, for example, to many people at once.   Newsgroups  

This is the Internet equivalent of a discussion group or an electronic bulletin board. It’s a feature using which 

people discuss on specific areas of interest via the internet. Some newsgroups are moderated, others are not. If it is 

moderated a human moderator screens all messages and decides if these are worth posting. Discussions can be  

"threaded." For example, in a newsgroup for agriculture, one member might ask about suitable crops that can be 

grown in his land. But another member may start discussing how to storage methods for grains.  More than one 

threaded discussion can occur at the same time with different members posting their opinions and reactions to either 

one or more threads.    

Chat  

This is another popular form of communication over the Internet. Unlike e-mail, mailing list and newsgroups, chat 

allows people to converse in "real time." People may actually see you type your questions and responses.   

File Transfer Protocol (FTP)  

File Transfer Protocol is the standard method for transferring files, whether  

downloading or uploading, to and from your computer with another computer on the  

Internet. It is simple to use and is the most popular way to download software and  

other files from the Internet.   

 Telnet  

Telnet is short for "Terminal Emulation." It is a feature of the Internet that lets you use the resources of another 

computer in another part of the world. This is done by remotely logging to the distant computer which is called the 

host. Once you are connected, it is possible to operate a remote computer using one's keyboard. The telnet  

is most useful to access the databases of public services like government directories. An Internet Address: M 

essages are transmitted from one computer to another; every computer in the Internet must have a unique and 

specific address. An Internet or IP address, as it is sometimes called, consists of four numbers separated by periods.  

The smallest address would be 0.0.0.0 while the biggest would be 1234.5678.9101.1121. Only computers are 

expected to remember all these numbers without getting confused.  Domain Name System  

The Domain Name System (DNS) helps users to find their way around the Internet. Every computer on the 

Internet has a unique address, called the "IP address". But it is hard to remember everyone's IP address. The DNS 

makes it easier by allowing a familiar string of letters (the "domain name") to be used instead of the IP address. So  



instead of typing 192.0.34.65, you can type www.indg.in, which is easier to remember. Domain names have the 

format: hostname.subdomain.top-level-domain . Eg. www.indg.gov.in. The third set of letters of an address are 

intended to indicate the type of organization hosting the computer.   Domain name   Meaning  

COM   Commercial organizations  

GOV   Government institutions  

NET   Major Network support centers  

ORG   Organizations other than those above  

Two letter codes - The final two letter codes indicate the country of origin.   

Eg:. 'in' is used for India   

Advantages and disadvantages of Internet  

Advantages  

There are many advantages of using the internet such as:   

Communication :   

The foremost target of internet has always been the communication By the advent of  

computer’s Internet, our earth has reduced and has attained the form of a global village.   

Now we can communicate in a fraction of second with a person who is sitting in the  

other part of the world. Today, for better communication, we can avail the facilities of  

e-mail; we can chat for hours with our loved ones.   

Information   

Information is probably the biggest advantage that internet offers. The Internet is a  

virtual treasure trove of information. Any kind of information on any topic under the sun  

is available on the Internet. The search engines like Google, yahoo is at your service on  

the Internet.    

Entertainment   

Entertainment is another popular area why many people prefer to surf the Internet.  

Downloading games, songs, movies are certain examples.   

Services   

Many services are now provided on the internet such as online banking, job seeking,  

booking railway tickets, etc.    

E-Commerce   

Ecommerce is the concept used for any type of business deals that involves the transfer  

of information across the globe via Internet. Eg. Shopping online for books, household  

goods etc.  

    

 Disadvantages   

Theft of Personal information   



While using the internet, there is the danger of personal information such as name,  

address, and credit card number etc. being accessed and misused by culprits.    

Spamming  

Spamming refers to sending unwanted e-mails in bulk, which are useless and obstruct  

the entire system.   

Virus threat   

Virus is nothing but a program which disrupts the normal functioning of the computer  

systems. Computers attached to internet are more prone to virus attacks and they can  

end up into crashing the whole hard disk.   

Web site / Web Page  

A web page is an area of text and other visual effects that can be seen when we get on the internet.   

A web site is a group of web pages that belong to one section of the internet, such as one person, one company,  

one school, or one government agency, etc.  

Web Portal   

Web portals provide a single point of access to a variety of content and core services. Eg. www.indg.in  

 Web browser  

A web browser is a software application that enables a user to display and interact with text, images, videos, music 

and other information typically located on a Web page at a website on the World Wide Web or a local area network.   

Important web browsers:  

Mosaic, April 22,1993 , Netscape Navigator and Netscape Communicators, October 13, 1994  

Internet Explorer, August 1995 ,Opera,1996 , Mozilla Firefox, 2004   

The most popular browser is Internet Explorer and is published by Microsoft and the  

second most popular browser is Netscape (or Netscape Navigator). It is also freely  

available.  

Under the title bar, a browser displays its main menu .       

The Toolbar : Under the main menu, a browser is equipped with small pictures called buttons. Microsoft Internet 

Explorer usually displays these buttons on their own range (called a toolbar).       

 The Address bar : the space where the address of a particular website is to be typed to view the site     

Internet Service Providers in India An Internet service provider (abbr. ISP , also called Internet access provider or  

IAP ) is a business or organization that provides consumers or businesses access to the Internet and related services.  

Main ISP’s in India:   

BSNL Broadband , Bharti Airtel ,Iqara ,Mahanagar Telephone Nigam Limited ,Reliance Communications 

,Sancharnet ,Spice Telecom ,Tata Teleservices ,Railtel      

 Types of Internet Connections  

I.  Home user connection  

i.  Dial-up  



Dial-up access is a form of Internet access via telephone line. The client uses a modem connected to a computer and 

a telephone line, to dial an Internet service provider's (ISP) node to establish a modem-to-modem link, which is then 

routed to the Internet.  

Modem : Modem (from mo dulator-dem odulator) is a device that modulates an analog carrier signal to encode 

digital information, and also demodulates such a carrier signal to decode the transmitted information. The goal is to 

produce a signal that can be transmitted easily and decoded to reproduce the original digital data. Modems  

can be used over any means of transmitting analog signals, from driven diodes to radio.  

ii.  DSL ( Digital subscriber line) : DSL or xDSL , is a technology that provides digital data transmission over the  

wires of a local telephone network.   

iii.  Broadband wireless access : Wireless Broadband is a technology that provides high-speed wireless internet 

and data network access over a wide area.  

iv. Cable modem: A cable modem is a type of modem that provides access to a data signal sent over the cable 

television infrastructure. Cable modems are primarily used to deliver  broadband Internet access in the form of 

cable internet.   

v. ISDN: Integrated Services refers to ISDN's ability to deliver at minimum two simultaneous connections, in any 

combination of data, voice, video, and fax, over a single line. Multiple devices can be attached to the line, and used 

as needed. That means an ISDN line can take care of most people's complete communications needs  

at a much higher transmission rate, without forcing the purchase of multiple analog phone lines. In a 

videoconference, ISDN provides simultaneous voice, video, and text transmission between individual desktop 

videoconferencing systems and group (room) videoconferencing system.  

II.  Business connections  

i. DSL  

ii. SHDSL            

 Search Engines  

Although the internet is highly rich with information, the information is not always organized in a way that a person 

expects. When "browsing", it is hard to get to the particular information one is looking for. To provide an 

alternative, there are some specialized sites that can perform the search for users, with more or less same  

accuracy. These sites are referred to as search engines. Some of the most popular of  them are:  Examples : Google , 

Yahoo , MSN , Netscape , Alta Vista Search   

Steps to do a search  

To do a search, first access a search engine site.  

Eg. www.search.com  

Each one of them provides you with a convenient box in which you can type the word or sentence to search and 

press Enter. Eg.  

The results are displayed in a list.   

You can then click each link and check it. If a link doesn't provide the type of information you are looking for, you 

can click Back (the shortcut to go back on most browsers is Alt + left arrow key) and click the next link in the list.  



If you still don't find what you are looking for, you can change the word or sentence that you typed and start 

searching again. You can also try another search engine site.  Most of the search engine sites provide more services 

than searching the web. For example, both Yahoo and MSN provide free email services. 

 

Electronic -Mail    

Email (electronic mail) lets you type and send a message to anyone, anywhere in the world who has an Internet 

connection and an email account. Once sent, the message usually arrives within seconds. However, before sending 

mail you have to learn how to compose your messages.  

If you are using Microsoft Internet Explorer you will be using Outlook Express which is Microsoft's own Email 

program. Netscape has Netscape Messenger as its Email program. When the Internet service was installed the Email 

address of your Internet connection should have been established.  

Once Microsoft Internet Explorer is installed the Outlook Express icon will appear on the desktop, or the Taskbar as 

the bottom of the screen.  

When you have clicked on Outlook Express you will see the following:    

This window is divided into frames - on the left is the outline of the "filing system." By clicking on the different 

folders you will have access to different options, see following example:    

  

EMAIL - SENDING A MESSAGE   

Notice that I have entered the In box - this will show me a list of documents received   

Sending a Message   

Identify the button "New Mail" on the main toolbar. Click on the words "New Mail" and the following window will 

appear. See next page.     

   

TO: Here you must type the Email address of the recipient; notice there are NO spaces in the address and capital 

letters are rarely used. Letters with accents cannot be used for an Email address.    

cc: If you wish to send a copy to a second person but don't want to address them directly, click here and write their 

Email address, they will receive their carbon copy at the same time as the recipient.  

Subject: Senders frequently leave this item blank, however, it is a good idea to give the recipient an idea of the 

content of the message. This is particularly important for those who receive a large quantity of mail.     

  

EMAIL - SENDING AND RECEIVING A MESSAGE   

In the space provided, type your message. This is not a formal letter so the content is usually more direct and fairly 

brief. If you wish to include a letter or other formal document it is possible to do so as an attachment (see Attaching 

A Document).  

Notice you have not included your own Email address - this is added automatically so the recipient will know who 

sent it even if you don't sign your name.   

To check if the message was sent, close the message window and in the left frame click on Sent Items, your 

message should be listed there.   



Can I make my message look more elaborate?  

By using the tool bar you can change font, size, and position of text.       

  

EMAIL - RECEIVING AND READING MESSAGES   

To rapidly see the contents of your Inbox (messages received) either click on Inbox or on the main tool bar Send 

and Receive. You will see there a full list of messages received. Those which are not read are usually in darker 

lettering.  

If you do not want to keep a message once it is read, close the window and return to your Inbox, point at the 

message in question, click right and choose delete.   

A word of warning: Email is a pipeline of information open to anyone who has access to the Internet and an Email 

account. There are many strange people sending messages. As a rule of thumb, I don't open the message unless I 

know of the person/organization sending the message. In particular if the message includes words like "Urgent", 

"Open immediately", etc. I delete these automatically.  

Deleted items are sent to the Deleted Items folder. If the message is suspect, I erase it from the Deleted folder by 

pointing the mouse at the item, click right and choose Empty Contents.  

USING THE ADDRESS BOOK  

The address book is a list of frequently-used names and Email addresses; just like any address book these names 

can be kept in alphabetical order for easy reference. To add a name (contact) to the address book, click on-      

  

ADDRESS BOOK; ATTACHMENTS    

Once you have added a name and Email address to your list of contacts in the address book, you no longer need to 

insert them manually in the message. Instead, you double click on the icon which has the shape of a book; this will 

bring you to your list of contacts. Double click to insert a name in the message.  

ATTACHING A DOCUMENT  

Sometimes, it is necessary to add a separate document to your Email. Perhaps you want to include a financial 

statement prepared in Excel, or a report in Word. In that case you need the attachment feature.   

1. Compose the message as usual. Click on    

2. From the dialogue box, select the location of the file you want to send. Point at the file and click on Attach. 3. 

You will return to your original message and see below the main text an icon which represents the document you 

have attached.    

  

OPENING AN ATTACHMENT YOU RECEIVE  

Of course, it would be difficult to open a document sent to you which is prepared in WordPerfect if you do not have 

that program. If you have Word and receive a Word document. So, when you receive a document with an 

attachment, open the document then double click the attached file to open it. To save the document on your system, 

point at the attachment, right click and choose Save, or Save As, then select the appropriate destination for this 

document and click Save.   

SAVING ONLINE TIME AND MONEY  



If you have a limited amount of time available on the Internet, say, 10 hours a month and you use most of that time 

compose your message offline (that's to say not connect to your ISP).  

To do this, enter as usual through the Icon, go to your mail connection, open then choose, File, Work Offline. You 

will be temporarily disconnected. As soon as your message/messages are ready to send, click on Send and the usual 

window will appear asking if you wish to be connected now.     

  

FREE EMAIL   

Yes, it's really free. You just have to type in "hotmail. com" for example and follow the directions to log on.  

Although this is free, of course, you need to have access to a computer with a modem and Internet server to be able 

to access your free Email. Once you have signed on, you can send and retrieve your Email by typing in the address 

space: www.Hotmail.com. When the site appears on the screen, type in your user name, and password. Press Enter, 

contact is made and you go straight to your Email account (no cost here). Proceed as for any Email. Check your 

Inbox, etc.  

Now that free Email has become so popular, there have been some restrictions applied. For instance, with Hotmail 

you can now only accumulate 2000 kbytes of mail, either messages sent or received. Above this amount Hotmail 

will automatically erase material.      

Unit – III    [ Operating System and Word Processing ] 

 Disk Operating System 

Learning MS-DOS Basics - A Tutorial   

This tutorial gives you an opportunity to try basic MS-DOS commands. By following the procedures in this section, 

you will learn to:   

o View the contents of a directory  o Change from one directory to another  o Create and delete directories  o 

Change from one drive to another  o Copy files  o Rename files  o Delete files  o Format a floppy disk   

The Command Prompt   

When you first turn on your computer, you will see some cryptic information flash by. MS-DOS displays this 

information to let you know how it is configuring your computer. You can ignore it for now. When the information 

stops scrolling past, you'll see the following:   

C:\>  

This is called the command prompt or DOS prompt. The flashing underscore next to the command prompt is called 

the cursor. The cursor shows where the command you type will appear.    

Typing a Command   

This section explains how to type a command at the command prompt and demonstrates the "Bad command or file 

name" message.   

• To type a command at the command prompt   

1. Type the following at the command prompt (you can type the command in either uppercase or lowercase letters):   

nul  

If you make a typing mistake, press the BACKSPACE key to erase the mistake, and then try again.   

2. Press ENTER.   



You must press ENTER after every command you type.   

The following message appears:   

Bad command or file name   

The "Bad command or file name" message appears when you type something that MS- DOS does not recognize. 

Because nul is not a valid MS-DOS command, MS-DOS displays the "Bad command or file name" message.   

3. Now, type the following command at the command prompt:  

ver  

The following message appears on your screen:   

MS-DOS version 6.22  

Viewing the Contents of a Directory   

In this section, you will view the contents of a directory by using the dir command. The dir command stands for 

"directory."   

• To view the contents of a directory   

1. Type the following at the command prompt:  

dir   

A list similar to the following appears:  

Volume in drive C is MS-DOS_6.22  Volume Serial Number is lE49-15E2  Directory of C:\    

WINDOWS      <DIR>    09-08-92 10:27p  TEMP         <DIR>    05-15-92 12:09p  CONFIG  SYS       278 09-23-

92 10:50a  COMMAND COM     53014 09-18-92 6:00a  WINA20  386      9349 11-11-91 5:00a  DOS          <DIR>    

09-02-92 4:23p  AUTOEXEC BAT      290 09-23-92 10:54a    

               7 file(s) 62931 bytes                         8732672 bytes free   

This is called a directory list. A directory list is a list of all the files and subdirectories that a directory contains. In 

this case, you see all the files and directories in the main or root directory of your drive. All the files and directories 

on your drive are stored in the root directory.   

Changing Directories   

Look at the list on your screen. All the names that have <DIR> beside them are directories. You can see a list of the 

files in another directory by changing to that directory, and then using the dir command again. In this case, you will 

change to the DOS directory.   

Before you begin this section, make sure you have a directory named DOS by carrying out the following procedure.   

o To make sure you have a directory named Windows   

1.If you do not see a line in the directory list indicating that you have a directory named Windows, type the 

following at the command prompt:   

dir /s Windows   

You will see a message that includes a line such as the following:   

Directory of C:\DIRNAME   

o To change from the root directory to the WINDOWS directory   

To change directories, you will use the cd command. The cd command stands for "change directory."   



1. Type the following at the command prompt:   

cd windows   

The command prompt changes. It should now look like the following:   

C:\WINDOWS>   

Next, you will use the dir command to view a list of the files in the DOS directory.  

o To view a list of the files in the WINDOWS directory  

1. Type the following at the command prompt:   

dir   

A list of the files in the WINDOWS directory appears, but scrolls by too quickly to read. You can modify the dir 

command so that it displays only one screen of information at a time.   

o To view the contents of a directory one screen at a time   

1. Type the following at the command prompt:   

dir /p   

One screen of information appears. At the bottom of the screen, you will see the following message:   

Press any key to continue . . .   

2. To view the next screen of information, press any key on your keyboard. Repeat this step until the command 

prompt appears at the bottom of your screen.   

When you typed the dir command this time, you included the /p switch after the command. A switch modifies the 

way MS-DOS carries out a command. Generally, a switch consists of a forward slash (/) that is followed by one or 

more letters or numbers. When you used the /p switch with the dir command, you specified that MS-DOS should 

pause after it displays each screen of directory list information. The p actually stands for "page"  

Another helpful switch you can use with the dir command is the /w switch. The /w switch indicates that MS-DOS 

should show a wide version of the directory list.   

o To view the contents of a directory in wide format   

1. Type the following at the command prompt:   

dir /w   

The directory list appears, with the filenames listed in wide format. Note that only filenames are listed. No 

information about the files' size or date and time of creation appears.   

2. If the directory contains more files than will fit on one screen, you can combine the /p and /w switches as 

follows:   

dir /w /p   

Changing Back to the Root Directory   

Next, you will change from the DOS directory to the root directory. The root directory is the directory you were in 

before you changed to the DOS directory. Before you begin this section, make sure your command prompt looks 

like the following:   

C:\DOS>   

o To change to the root directory   



1. Type the following at the command prompt:   

cd \   

Note that the slash you type in this command is a backslash (\), not a forward slash (/).   

No matter which directory you are in, this command always returns you to the root directory of a drive. The root 

directory does not have a name. It is simply referred to by a backslash (\).   

The command prompt should now look like the following:   

C:\>   

When your command prompt appears similar to this---that is, when it does not contain the name of a directory---

you are in the root directory.   

Creating a Directory   

In this section, you will create two directories. Creating a directory is helpful if you want to organize related files 

into groups to make them easy to find. Before you begin this section, make sure the command prompt looks like the 

following:   

C:\>   

To create a directory, you will use the md command. The md command stands for "make directory."   

o To create and change to a directory named FRUIT  

1. Type the following at the command prompt:   

md fruit   

You have now created a directory named FRUIT. You won't see the new FRUIT directory until you carry out the 

dir command in the next step.   

2. To confirm that you successfully created the FRUIT directory, type the following at the command prompt:   

dir   

or   

dir /p   

Look through the directory list. A new entry somewhere in the list should look similar to the following:   

FRUIT <DIR> 09-25-93 12:09p   

3. To change to the new FRUIT directory, type the following at the command prompt:   

cd fruit   

The command prompt should now look like the following:   

C:\FRUIT>   

You will now create a directory within the FRUIT directory, named GRAPES.   

o To create and work with a directory named GRAPES   

1. Type the following at the command prompt:   

md grapes   

You will not see the new GRAPES directory until you carry out the dir command in the next step.   

2. To confirm that you successfully created the GRAPES directory, type the following at the command prompt:   



dir  

A list similar to the following appears:   

Volume in drive C is MS-DOS-6  Volume Serial Number is lE49-15E2  Directory of C:\FRUIT   

.          <DIR>        09-25-93 12:08p  ..         <DIR>        09-25-93 12:08p  GRAPES     <DIR>        09-25-93 12:10p                      

3 file(s) 0 bytes                         11534336 bytes free   

Note that there are three entries in the FRUIT directory. One is the GRAPES directory that you just created. There 

are two other entries---one looks like a single period (.) and the other looks like a double period (..). These directory 

entries are important to MS- DOS, but you can ignore them. They appear in every directory and contain information 

relation to the directory structure.  

The GRAPES directory is a subdirectory of the FRUIT directory. A subdirectory is a directory within another 

directory. Subdirectories are useful if you want to further subdivide information.   

3. To change to the GRAPES directory, type the following at the command prompt:   

cd grapes   

The command prompt should now look like the following:   

C:\FRUIT\GRAPES>   

4. To switch back to the FRUIT directory, type the following:   

cd ..   

The command prompt should now look like the following:   

C:\FRUIT>   

When the cd command is followed by two periods (..), MS-DOS moves up one level in the directory structure. In 

this case, you moved up one level from the GRAPES directory to the FRUIT directory.   

Deleting a Directory   

If you no longer use a particular directory, you may want to delete it to simplify your directory structure. Deleting a 

directory is also useful if you type the wrong name when you are creating a directory and you want to delete the 

incorrect directory before creating a new one.   

In this section, you will delete the GRAPES directory. Before you begin this section, make sure the command 

prompt looks like the following:   

C:\FRUIT>   

To delete a directory, use the rd command. The rd command stands for "remove directory."   

o To delete the GRAPES directory   

1. Type the following at the command prompt:   

rd grapes   

2. To confirm that you successfully deleted the GRAPES directory, type the following at the command prompt:   

dir   

The GRAPES directory should no longer appear in the directory list.   

Note You cannot delete a directory if you are in it. Before you can delete a directory, you must make the directory 

that is one level higher the current directory. To do this, type cd.. at the command prompt.   



Changing Drives   

This section describes how to change drives. Changing drives is useful if you want to work with files that are on a 

different drive.   

So far, you have been working with drive C. You have other drives you can use to store information. For example, 

drive A is your first floppy disk drive. The files and directories on drive A are located on the floppy disk in the 

drive. (You might also have a drive B, which contains the files and directories stored on the floppy disk in that 

drive.)   

Before you begin this section, make sure your command prompt looks like the following:   

C:\FRUIT>   

o To change to and view files on a different drive   

1. Insert a 3.5" floppy disk in drive A label- side up. Make sure the disk clicks into the drive.   

1. Type the following at the command prompt:   

a:   

Note that the command prompt changed to the following:   

A:\>   

This message may appear:   

Not ready reading drive A   

Abort, Retry, Fail?   

If you see this message, the disk may not be inserted properly. Place the disk label-side up in the disk drive, and 

make sure the disk clicks into the disk drive. Then, type r for Retry. If this message appears again, press F for Fail, 

and then type b: at the command prompt. If you no longer see this message, type b: instead of a: throughout the rest 

of the tutorial.   

There must be a floppy disk in the drive that you want to change to.   

2. Change back to drive C by typing the following at the command prompt:   

c:  

Your command prompt should return to the following:   

C:\FRUIT>   

When you type a drive letter followed by a colon, you change to that drive. The drive letter that appears in the 

command prompt shows which drive is the current drive. Unless you specify otherwise, any commands you type 

are carried out on the current drive and in the current directory.   

So far, all the commands you typed were carried out on the current drive and in the current directory. You can also 

carry out a command on a drive that isn't current. For example, you can view the files on a disk in drive A without 

switching to drive A by following this procedure.   

   

o To view the contents of the WINDOWS directory on drive C  

1. Type the following at the command prompt:   

dir c:\windows   



A list of the files in the DOS directory on drive C should scroll past on your screen.   

Copying Files   

This section describes how to copy a single file and a group of files. Copying files creates a duplicate of the original 

file and does not remove the original file. This is useful for many reasons. For example, if you want to work on a 

document at home, you can copy it from your computer at work to a floppy disk and then take the floppy disk 

home.   

To copy a file, you will use the copy command. When you use the copy command, you must include two 

parameters. The first is the location and name of the file you want to copy, or the source. The second is the location 

to which you want to copy the file, or the destination. You separate the source and destination with a space. The 

copy command follows this pattern:   

copy source destination   

• Copying a Single File   

In this section, you will copy the notepad.exe files from the WINDOWS directory to the FRUIT directory. You will 

specify the source and destination of these files in two different ways. The difference between the two methods is 

explained at the end of this section.   

Before you begin this section, make sure the command prompt looks like the following:   

C:\FRUIT>   

To copy the NOTEPAD.EXE files from the WINDOWS directory to the FRUIT directory   

1. Return to the root directory by typing the following at the command prompt:   

cd\  

The command prompt should now look like the following:   

C:\>  

Change to the DOS directory by typing the following at the command prompt:   

cd windows  

The command prompt should now look like the following:   

C:\WINDOWS>   

2. Make sure the file you are going to copy, NOTEPAD.EXE, is located in the WINDOWS directory by using the 

dir command followed by a filename.   

dir notepad.exe  

A list similar to the following appears:   

3. To copy the NOTEPAD.EXE file from the WINDOWS directory to the FRUIT directory, type the following at 

the command prompt:   

copy c:\windows\notepad.exe c:\fruit   

The following message appears:   

1 file(s) copied   

4. To confirm that you copied the files successfully, view the contents of the FRUIT directory by typing the 

following at the command prompt:  



dir \fruit   

You should see the file listed in the FRUIT directory.   

Renaming Files   

This section explains how to rename files. You may want to rename a file if the information in it changes or if you 

decide you prefer another name.   

To rename a file, you will use the ren command. The ren command stands for "rename." When you use the ren 

command, you must include two parameters.   

The first is the file you want to rename, and the second is the new name for the file. You separate the two names 

with a space. The ren command follows this pattern:   

ren oldname newname   

• Renaming a File   

In this section, you will rename the README.TXT file.   

Before you begin this section, make sure your command prompt looks like the following:   

C:\FRUIT>  

1. To rename the NOTEPAD.EXE file to PADNOTE.TXT, type the following at the command prompt:   

ren notpad.exe padnote.txt   

2. To confirm that you renamed the file successfully, type the following at the command prompt:   

dir   

Deleting Files   

This section explains how to delete, or remove, a file that you no longer want on your disk. If you don’t have very 

much disk space, deleting files you no longer use is essential.   

To delete a file, you will use the del command. The del command stands for "delete."   

• Deleting a File   

In this section, you will delete two files using the del command.   

Before you begin, make sure your command prompt looks like the following:   

C:\FRUIT>  

To delete the PEARCOM and PEAR.HLP files   

1. Delete the PADNOTE.TXT file by typing the following at the command prompt:   

del PADNOTE.TXT   

2. To confirm that you deleted the files successfully, type the following at the command prompt:   

dir   

• Deleting a Group of Files   

In this section, you will use wildcards to delete a group of files.   

Before you begin this section, make sure your command prompt looks like the following:   

C:\FRUIT>   

To delete files in the current directory that end with the extension OLD by using wildcards   



1. View all files that end with the extension OLD by typing the following at the command prompt:   

dir *.old   

A list of all the files that end with the extension OLD appears. Make sure that these are the files you want to delete. 

When you are deleting files by using wildcards, this step is very important. It will prevent you from deleting files 

accidentally.   

2. Delete all files ending with OLD by typing the following at the command prompt:   

del *.old   

3. To confirm that all the files with the extension OLD have been deleted, type the following at the command 

prompt:   

dir   

The FRUIT directory should contain no files.   

Now that the FRUIT directory is empty, you can delete it by using the rd (remove directory) command that you 

learned to use in "Deleting a Directory" earlier in this chapter.   

• To delete the FRUIT directory   

1. Return to the root directory by typing the following at the command prompt:   

cd \   

2. You can see the FRUIT directory in the directory list by typing the following at the command prompt:   

dir or dir /p   

3. Remove the FRUIT directory by typing the following at the command prompt:   

rd fruit   

4. To verify that the FRUIT directory has been removed, type the following at the command prompt:   

dir or dir /p   

The FRUIT directory should not appear in the directory list.   

 

UNIX Introduction  

What is UNIX?  

UNIX is an operating system which was first developed in the 1960s, and 

has been under constant development ever since. By operating system, we 

mean the suite of programs which make the computer work. It is a stable, 

multi-user, multi-tasking system for servers, desktops and laptops.  

UNIX systems also have a graphical user interface (GUI) similar to Microsoft Windows which provides an 

easy to use environment. However, knowledge of UNIX is required for operations which aren't covered by a 

graphical program, or for when there is no windows interface available, for example, in a telnet session. 



Types of UNIX 

There are many different versions of UNIX, although they share common similarities. The 

most popular varieties of UNIX are Sun Solaris, GNU/Linux, and MacOS X.  

Here in the School, we use Solaris on our servers and workstations, and Fedora Linux on the 

servers and desktop PCs. 

The UNIX operating system  

The UNIX operating system is made up of three parts; the kernel, the shell and the programs.  

The kernel  

The kernel of UNIX is the hub of the operating system: it allocates time and memory to programs and handles 

the filestore and communications in response to system calls.  

As an illustration of the way that the shell and the kernel work together, suppose a user types rm myfile 

(which has the effect of removing the file myfile). The shell searches the filestore for the file containing the 

program rm, and then requests the kernel, through system calls, to execute the program rm on myfile. When 

the process rm myfile has finished running, the shell then returns the UNIX prompt % to the user, indicating 

that it is waiting for further commands.  

The shell 

The shell acts as an interface between the user and the kernel. When a user logs in, the login program checks 

the username and password, and then starts another program called the shell. The shell is a command line 

interpreter (CLI). It interprets the commands the user types in and arranges for them to be carried out. The 

commands are themselves programs: when they terminate, the shell gives the user another prompt (% on our 

systems).  

The adept user can customise his/her own shell, and users can use different shells on the same machine. Staff 

and students in the school have the tcsh shell by default.  

The tcsh shell has certain features to help the user inputting commands. 

Filename Completion - By typing part of the name of a command, filename or directory and pressing the 

[Tab] key, the tcsh shell will complete the rest of the name automatically. If the shell finds more than one 

name beginning with those letters you have typed, it will beep, prompting you to type a few more letters 

before pressing the tab key again.  

History - The shell keeps a list of the commands you have typed in. If you need to repeat a command, use the 

cursor keys to scroll up and down the list or type history for a list of previous commands.  



Files and processes  

Everything in UNIX is either a file or a process.  

A process is an executing program identified by a unique PID (process identifier).  

A file is a collection of data. They are created by users using text editors, running compilers etc.  

Examples of files:  

• a document (report, essay etc.)  

• the text of a program written in some high-level programming language  

• instructions comprehensible directly to the machine and incomprehensible to a casual user, for example, a 

collection of binary digits (an executable or binary file);  

• a directory, containing information about its contents, which may be a mixture of other directories 

(subdirectories) and ordinary files.  

The Directory Structure  

All the files are grouped together in the directory structure. The file-system is arranged in a hierarchical 

structure, like an inverted tree. The top of the hierarchy is traditionally called root (written as a slash / )  

 

In the diagram above, we see that the home directory of the undergraduate student "ee51vn" contains two 

sub-directories (docs and pics) and a file called report.doc.  

The full path to the file report.doc is "/home/its/ug1/ee51vn/report.doc"  

Starting an UNIX terminal  

To open an UNIX terminal window, click on the "Terminal" icon from Applications/Accessories menus. 



 

  

An UNIX Terminal window will then appear with a % prompt, waiting for you to start entering commands. 
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Berkeley Software Distributions (BSD) compatibility 

Sockets is a Berkeley Software Distributions (BSD) interface. The semantics, such as the return codes that an 
application receives and the arguments available on supported functions, are BSD semantics. Some BSD semantics, 
however, are not available in the OS/400® implementation, and changes may need to be made to a typical BSD 
socket application in order for it to run on the system. 

The following list summarizes the differences between the OS/400 implementation and the BSD implementation.  

/etc/hosts, /etc/services, /etc/networks, and /etc/protocols 

For these files, the OS/400 implementation supplies the following database files which serve the same 

functions, respectively.  

QUSRSYS file Contents 

QATOCHOST List of host names and the corresponding IP addresses. 

QATOCPN List of networks and the corresponding IP addresses. 

QATOCPP List of protocols that are used in the Internet. 

QATOCPS List of services and the specific port and protocol that the service uses. 

/etc/resolv.conf  

The OS/400 implementation requires that this information be configured using the TCP/IP properties page 

in iSeries™ Navigator. To access the TCP/IP properties page, complete the following steps:  

1. In iSeries Navigator, expand your iSeries server --> Network --> TCP/IP Configuration. 
2. Right-click TCP/IP Configuration. 
3. Click Properties. 

bind() 

On a BSD system, a client can create an AF_UNIX socket using socket(), connect to a server using 

connect(), and then bind a name to its socket using bind(). The OS/400 implementation does not support 

this scenario (the bind() fails).  

close() 

The OS/400 implementation supports the linger timer for close(), except for AF_INET sockets over SNA. 
Some BSD implementations do not support the linger timer for close(). 

connect() 

On a BSD system, if a connect() is issued against a socket that was previously connected to an address and 

is using a connectionless transport service, and an invalid address or an invalid address length is used, the 

socket is no longer connected. The OS/400 implementation does not support this scenario (the connect() 

fails and the socket is still connected).  

A connectionless transport socket for which a connect() has been issued can be disconnected by setting the 
address_length parameter to zero and issuing another connect(). 

accept(), getsockname(), getpeername(), recvfrom(), and recvmsg()  

When using AF_UNIX or AF_UNIX_CCSID address family and the socket has not been bound, the 

default OS/400 implementation may return an address length of zero and an unspecified address structure. 

The OS/400 BSD 4.4/UNIX 98 and other implementations may return a small address structure with just 

the address family specified.  

ioctl() 



• On a BSD system, on a socket of type SOCK_DGRAM, the FIONREAD request returns the 
length of the data plus the length of the address. On the OS/400 implementation, FIONREAD only 
returns the length of data. 

• Not all requests available on most BSD implementations of ioctl() are available on the OS/400 
implementation of ioctl(). 

listen() 

On a BSD system, issuing a listen() with the backlog parameter set to a value that is less than zero does not 

result in an error. In addition, the BSD implementation, in some cases, does not use the backlog parameter, 

or uses an algorithm to come up with a final result for the backlog value. The OS/400 implementation 

returns an error if the backlog value is less than zero. If you set the backlog to a valid value, then the value 

is used as the backlog. However, setting the backlog to a value larger than {SOMAXCONN}, the backlog 

will default to the value set in {SOMAXCONN}.  

Out-of-band (OOB) data  

In the OS/400 implementation, OOB data is not discarded if SO_OOBINLINE is not set, OOB data has 

been received, and the user then sets SO_OOBINLINE on. The initial OOB byte is considered normal data.  

protocol parameter of socket() 

As a means of providing additional security, no user is allowed to create a SOCK_RAW socket specifying 

a protocol of IPPROTO_TCP or IPPROTO_UDP.  

res_xlate() and res_close() 

These functions are included in the resolver routines for the OS/400 implementation. res_xlate() translates 

DNS packets from EBCDIC to ASCII and from ASCII to EBCDIC. res_close() is used to close a socket 

that was used by res_send() with the RES_STAYOPEN option set. It also resets the _res structure.  

sendmsg() and recvmsg() 

The OS/400 implementation of sendmsg() and recvmsg() allows up to and including 
{MSG_MAXIOVLEN} I/O vectors. The BSD implementation allows {MSG_MAXIOVLEN - 1} I/O 
vectors. 

shutdown() 

On an OS/400 implementation, the output function that is currently blocked on the socket descriptor will 

continue to block after a shutdown(). On a BSD implementation, the blocking output function is ended 

with the [EPIPE] errno value. Similarly, a BSD implementation ends blocking input operations with a zero 

output value when they are blocking and a shutdown() is issued from another process or thread. The 

OS/400 implementation simply fails any subsequent input function with a zero output value, but the 

blocking input function continues to block until data is received or some other action is taken to remove it 

from a waiting state.  

Signals  

There are several differences relating to signal support:  

• BSD implementations issue a SIGIO signal each time an acknowledgement is received for data 
sent on an output operation. The OS/400 sockets implementation does not generate signals related 
to outbound data. 

• The default action for the SIGPIPE signal is to end (terminate) the process in BSD 
implementations. To maintain downward compatibility with previous releases of OS/400, the 
OS/400 implementation uses a default action of ignore for the SIGPIPE signal. 

SO_REUSEADDR option  

On BSD systems, a connect() on a socket of family AF_INET and type SOCK_DGRAM causes the system 
to change the address to which the socket is bound to the address of the interface that is used to reach the 
address specified on the connect(). For example, if you bind a socket of type SOCK_DGRAM to address 
INADDR_ANY, and then connect it to an address of a.b.c.d, the system changes your socket so it is now 
bound to the IP address of the interface that was chosen to route packets to address a.b.c.d. In addition, if 
this IP address that the socket is bound to is a.b.c.e, for example, address a.b.c.e now appears on 
getsockname() instead of INADDR_ANY, and the SO_REUSEADDR option must be used to bind any 
other sockets to the same port number with an address of a.b.c.e. 



In contrast, in this example, the OS/400 implementation does not change the local address from 
INADDR_ANY to a.b.c.e. getsockname() continues to return INADDR_ANY after the connect is 
performed. 

SO_SNDBUF and SO_RCVBUF options  

The values set for SO_SNDBUF and SO_RCVBUF on a BSD system provide a greater level of control 

than on an OS/400 implementation. On an OS/400 implementation, these values are taken as advisory 

values.  

 Windows Operating System 

Introduction to Operating Systems  

It is important that you familiarize yourself with Windows and Linux in preparation for this course. The exercises in 

this book assume a basic knowledge of both of these operating systems. This chapter provides an overview of both 

operating systems. It is not intended as a comprehensive guide to Windows and Linux; it is intended to help prepare 

you for this course.  

Windows (1)  

The Windows operating system is a dynamic and continually changing operating system with new security patches 

and hot fixes being released often. In a normal production environment, it is highly recommended that you maintain 

a patching schedule to keep your systems up-to-date.   

This "Introduction to Windows" guide teaches you about the basic commands and actions you need to know for the 

Security Essentials Labs. This document introduces you to the following: cmd, ipconfig, regedit, netstat, cls, dir, 

mkdir, and the Task Manager.   

The Cmd Prompt Since the release of Windows 2000 Professional, the old 16-bit command.com program has been 

replaced with the cmd.exe program. There are many benefits of using cmd including the following:  

x The capability to run scripts in the CMD language x WMIC (Windows Management Instrumentation Console) x 

There are no 8.3 filename limitations x The capability of running multiple commands on the same command line x 

Support for command pipelines x Help functionality with /?  

The following list of tasks shows you how to use the command prompt to obtain help or information about your 

system:   

1. To display the command prompt, select the Start icon and type cmd.    

2. The following window appears...     

3. If you need help with a command while using cmd, type /? after the command in question. For example, to get 

NIC TCP/IP information, type ipconfig. To get a list of the available ipconfig options, type ipconfig /? after the 

command prompt, as shown in the following screen.    

4. To get the IP address information for your system, type ipconfig /all. This also displays your MAC address, as 

shown in the following screen.  If you have a virtual machine application installed, you will receive other interfaces 

in addition to the below.     

Windows (2)  

To edit the registry in a Windows environment you can use the regedit command at the Run prompt. One of the nice 

features of using regedit is that you can search every hive for specific keys, values, and data.    

Warning: When using regedit, exercise extreme caution because any change you make is permanent and could 

potentially render your system unusable.    



The following list of tasks explains how to edit the registry and how to use regedit:   

1. To start regedit, choose Start, Run. Then, type regedit and press Enter.  The following is a screen shot of regedit.     

2. To ensure you can recover from making detrimental mistakes when editing the   registry, you should always save 

a copy of the keys you change. To do this, right click on a registry key and select export from the menu.   

3. There are a lot of powerful things you can do with the registry.  To minimize any impact on your system, let’s 

look at a relatively save example.  To change the logon screen background color you would edit HKEY_USERS -> 

DEFAULT -> Control Panel -> Colors.  You would change the color using RGB settings.  For example 0 0 0 is 

black and 255 255 255 is white.  If you do change the color, you would have to reboot the system for the change to 

apply.  This was meant as an example, but it is not recommended that you change the color at this time.   

IP Changes The following steps are necessary for making IP changes on your Windows system:   

1. To make IP address changes to your local machine, open the NIC properties. Open up your Control Panel by 

choosing Start, Control Panel, select Network and Internet, then select View network status and tasks and finally 

select change adapter settings.  Highlight the local area connection. Right-click the Local Area Connection, and 

click Properties. The following screen appears.   

3. Highlight Internet Protocol (TCP/IP) and click the Properties button.  Most systems use DHCP but this is where 

you would change an address.  This could also be used as a basic way to spoof an IP address for certain types of 

attacks.  

Viewing Ports To see what ports are open on your box, you can use the netstat command, as shown in the following 

screen.   Since you are not connected to a network, you might receive limited information.     

You can see every open port and the state of each port. States include listening, waiting, or connected. The netstat 

command also shows you TCP and UDP connections.    

While netstat will show you which ports are open, by default it does not show you which service is causing a given 

port to be open. Attackers connect to systems via ports. The more ports that are open, the more avenues of attack. 

Therefore it is important to shut down unneeded ports. In order to close a port you need to know which service is 

causing a given port to be open. By typing the following command: netstat -o will show which service is causing a 

given port to be open.  It is important to note that if you do not have an active network connection, you might 

receive limited information.       

Other Useful Commands Some other commands to use at the cmd prompt are:    

x cls-Clears everything on the screen and returns you to the top of the cmd window x dir-Displays a directory listing  

x cd \-Returns you to c:\ from whatever directory you are in   

Task Manager Another great built-in tool in Windows is the Task Manager. The following list shows you how to 

open and use the Task Manager:    

1. To open hold down CTRL-ATL-DEL at the same time and select Task Manager. The default screen that opens 

shows which applications are running on the system.       

2. From this window, you can check the running processes on the device, the performance trends, and the 

applications that are currently running.  It is a great tool to open if you have an application that stops responding. 

You can open Task Manager, highlight the application, and then choose to close the offending application. By 

clicking on the performance tab, you can see CPU and memory usage.      



There are many other Windows functions that are not covered in this book. Our goal is to give you the basics, so 

that you can quickly install and run the tools covered throughout the following chapters.    

Setting Up the Directory Structure Now that you have installed the operating system and seen some of the tools that 

are built into it, you need to set up your directory structure, so that it's consistent with the directory structure used 

for installing and storing the tools discussed in this book. Follow these steps to setup the directory structure:    

1. First click on Start, My Computer and then double-click Local Disk (c:). The window that appears lists the 

structure of the C:\ drive.  Right-click a spot in the window that is blank. Move your mouse down the menu that 

appears and left-click New and choose  

Folder. Name the folder tools. The following screen shows a directory structure with the new tools folder.   

 2. The exercises in this book require you to run several tools from the command line. Thus, you need to add the 

new folder we created, c:\tools, to PATH. If you do this, you won't have to navigate to the tools folder each time 

you want to run an application. To add the folder to PATH, Click on Start, right-click on My Computer, and choose 

Properties from the pop-up menu. Click the Advanced system settings option, as shown in the following screen.   

 3. Click the Environment Variables button. In the System Variables section, highlight the line labeled Path and 

click Edit.     

4. In the Variable Value field, move your cursor to the end of the line and add the following exactly as it is shown 

here:   

Click OK on each of the Edit System Variable, Environment Variables and System Properties windows.    

The executables located in c:\tools can now be run from any directory in your file structure. This saves a lot of time 

when you are using the command prompt and want to run an application from it.  

 

MICROSOFT EXCEL TUTORIAL                         

  

GETTING STARTED  

  Microsoft Excel is one of the most popular spreadsheet applications that helps you  

manage data, create visually persuasive charts, and thought‐provoking graphs. Excel  

is supported by both Mac and PC platforms. Microsoft Excel can also be used to  

balance a checkbook, create an expense report, build formulas, and edit them.      CREATING A NEW 

DOCUMENT    

OPENING MICROSOFT EXCEL ON A PC 

To begin Microsoft Excel, Go to Start > All Programs > Applications > Microsoft  

Office > Microsoft Excel (Figure 1). When opened a new spreadsheet will pop up  

on the screen, if this does not happen click on the Office Icon   > New. From here  

a dialog box with various different templates will appear on the screen that you can  

choose from. Once a template is chosen, click Create.    

 



SAVING YOUR DOCUMENT  

  Computers crash and documents are lost all the time, so it is best to save often.    SAVING INITIALLY   

Before you begin you should save your document. To do this, click on the floppy disk  

located at the top of the screen  . Then Microsoft Excel will open a dialog box  

(Figure 3) where you can specify the new file’s name, location of where you want it  

saved, and format of the document. Once you have specified a name, place, and  

format for your new file, press the Save button.    

Note: Specifying your file format will allow you to open your document on a PC as  

well as a MAC. To do this you use the drop down menu next to the Format option.  

Also, when you are specifying a file extension (i.e. .doc) make sure you know what  you need to use.    

 SAVING LATER   After you have initially saved your blank document under a new name, you can  

begin your project. However, you will still want to periodically save your work as  

insurance against a computer freeze or a power outage. To save, just click on the  

floppy disk, or for a shortcut press CTRL + S.              

TOOLBARS  

  In Microsoft Excel 2007 for a PC, the toolbars are automatically placed as tabs at the  

top of the screen. Within these tabs you will find all of your options to change text,  

data, page layout, and more. To be able access all of the certain toolbars you need to  

click on a certain tab that is located towards the top of the screen.      THREE COMMONLY USED TABS 

The Home Tab: (Figure 4). This is one of the most common tabs used in Excel. You  

are able to format the text in your document, cut, copy, and paste information.  

Change the alignment of your data, insert, delete, and format cells. The Home Tab  

also allows you to change the number of your data (i.e. currency, time, date).    

  Home Tab.    The Insert Tab:  This tab is mainly used for inserting visuals and graphics  

into your document. There are various different things that can be inserted from  

this tab such as pictures, clip art, charts, links, headers and footers, and word art.     

 . Insert Tab.    The Page Layout Tab: (Figure 6). Here you are able to add margins, themes to your  

document, change the orientation, page breaks, and titles. The scale fit of your  

document is also included as a feature within this 

 tab, if needed.     

FORMATTING  

   CELLS   Cells are an important part of any project being used in Microsoft Excel. Cells hold  

all of the data that is being used to create the spreadsheet or workbook. To enter  

data into a cell you simply click once inside of the desired cell, a black border will  

appear around the cell (Figure 7). This border indicates that it is a selected cell. You  

may then begin typing in the data for that cell.    

 Entering Data.    CHANGING AN ENTRY WITHIN A CELL   

You may change an entry within a cell two different ways:  • 

Click the cell one time and begin typing. The new information will replace  



any information that was previously entered.  • 

Double click the cell and a cursor will appear inside. This allows you to edit  

certain pieces of information within the cells instead of replacing all of the  data.    CUT, COPY, AND PASTE   

You can use the Cut, Copy and Paste features of Excel to change the data within  

your spreadsheet, to move data from other spreadsheets into new spreadsheets, and  

to save yourself the time of re‐entering information in a spreadsheet. Cut will  

actually remove the selection from the original location and allow it to be placed  

somewhere else. Copy allows you to leave the original selection where it is and  

insert a copy elsewhere. Paste is used to insert data that has been cut or copied.    To Cut or Copy:   

Highlight the data or text by selecting the cells that they are held within.  

Go to the Home Tab > Copy (CTRL + C) or Home Tab > Cut (CTRL + X).  

Click the location where the information should be placed.  

Go to Home Tab > Paste (CTRL + V) to be able to paste your information.     

FORMATTING CELLS   There are various different options that can be changed to format the spreadsheets  

cells differently. When changing the format within cells you must select the cells  that you wish to format.    

To get to the Format Cells dialog box select the cells you wish to change then go to  

Home Tab > Format > Format Cells. A box will appear on the screen with six  

different tab options (Figure 8). Explanations of the basic options in the format  dialog box are bulleted below.    

 Formatting Cells  

  Number: Allows you to change the measurement in which your data is used. (If  

your data is concerned with money the number that you would use is currency)  

Alignment: This allows you to change the horizontal and vertical alignment of your  

text within each cell. You can also change the orientation of the text within the cells  

and the control of the text within the cells as well.  

Font: Gives the option to change the size, style, color, and effects.  

Border: Gives the option to change the design of the border around or through the  cells.     

FORMATTING ROWS AND COLUMNS   

When formatting rows and columns you can change the height, choose for your  

information to autofit to the cells, hide information within a row or column, un‐hide  

the information. To format a row or column go to Home Tab > Row Height (or  

Column Height), then choose which height you are going to use (Figure 9). The cell  

or cells that are going to be formatted need to be selected before doing this. When changing the row or column visib

ility (hidden, un‐hidden) or autofit, you will go to  



the Home Tab and click Format. The drop down menu will show these options      

 Formatting Rows and Columns Height    

  ADDING ROWS AND COLUMNS   

When adding a row or column you are inserting a blank row or column next to your  

already entered data. Before you can add a Row you are going to have to select the  

row that you wish for your new row to be placed. (Rows are on the left hand side of  

the spreadsheet) once the row is selected it is going to highlight the entire row that  

you chose. To insert the row you have to go to Home Tab > Insert > Insert Sheet  

Rows . The row will automatically be placed on the spreadsheet and any  

data that was selected in the original row will be moved down below the new row.    

 Inserting Rows    

  

Before you can add a Column you are going to have to select a column on the  

spreadsheet that is located in the area that you want to enter the new column.  

(Columns are on the top part of the spreadsheet.) Once the column is selected it is  

going to highlight the entire row that you chose. To insert a column you have to go  

to Home Tab > Insert > Insert Sheet Column .The column will  

automatically be place on the spreadsheet and any data to the right of the new  

column will be moved more to the right.    

  Inserting Columns    

WORKING WITH CHARTS   

Charts are an important part to being able to create a visual for spreadsheet data. In  

order to create a chart within Excel the data that is going to be used for it needs to  

be entered already into the spreadsheet document. Once the data is entered, the  

cells that are going to be used for the chart need to be highlighted so that the  

software knows what to include. Next, click on the Insert Tab that is located at the  top of the screen.  

  

Figure 12. Charts Tab    You may choose the chart that is desired by clicking the category of the chart you  

will use. Once the category is chosen the charts will appear as small graphics within  

a drop down menu. To choose a particular chart just click on its icon and it will be  

placed within the spreadsheet you are working on. To move the chart to a page of its  

own, select the border of the chart and Right Click. This will bring up a drop down  

menu, navigate to the option that says Move Chart. This will bring up a dialog box  

that says Chart Location. From here you will need to select the circle next to As A  

New Sheet and name the sheet that will hold your chart. The chart will pop up  

larger in a separate sheet ,but in the same workbook as your entered  data.  

Chart in new sheet  

      CHART DESIGN   There are various different features that you can change to make your chart more  

appealing. To be able to make these changes you will need to have the chart selected  



or be viewing the chart page that is within your workbook. Once you have done that  

the Design Tab will appear highlighted with various different options to format  your graphic .   

  Design Tab for chart design.  

  CHART OPTIONS: Titles: To add titles to a chart of graphic you have to click on the Insert Tab. Once  

you have done this, click on the Text Box Icon. This will insert a text box that you can  

type the title and place anywhere you wish on the chart.   

Change Chart Type: You can change your chart easily by selecting this icon and  

navigating to a more desirable chart. This feature is very convenient for someone  

who chose the wrong chart and doesn’t wish to reselect all their data and go through  the process a second time.  

Format Chart Area: This allows for changes to be made to the chards border, style,  

fill, shadows, and more. To get this option you will need to right click on the charts  

border and navigate to the Format Chart Area option. Once this is clicked a dialog  box will appear.    

CHART STYLE: Here you are able to change the color of the bars that are within your chart.      INSERTING 

SMART ART GRAPHICS   PICTURES   To insert Pictures:  

Go to the Insert Tab> Picture, a dialog box will appear and then you can select the  

desired picture from the location that is it stored (Figure 15). The picture will be  

inserted directly onto your document, where you can change the size of it as desired.    

  

 Inserting a picture    

Inserting Clipart:  To insert Clip Art you will need to go to the Insert Tab > Clip Art. A navigation  

pane will appear on the left hand side of the screen where you can search for words  

that pertain to the picture you are looking for.    

Clip Art  

    CREATING FUNCTIONS   When creating a function in Excel you must first have the data that you wish to  

perform the function with selected.   • Select the cell that you wish for the calculation to be entered in (i.e.: if I want  

to know the sum of B1:B5 I will highlight cell B6 for my sum to be entered  into) . 

 . Choosing calculation cell  • Once you have done this you will need to select the Formulas Tab located at  

the top of the screen.  • A list of Most Recently Used, Financial, Logical, Text, Date and Time,  

Math and Trig formulas will appear. To choose one of the formulas click the  

icon that holds the formula you are looking for.  • 

Once you have clicked your formula this will display a dialog box on your  screen.  

 . First calculation display  

  In this screen it lists the cells that are being calculated, the values within the cells,  and the end result.    • 

To accept that calculation you can press OK and the result will show up in the  selected cell.      PRINTING   

It is important to always save your document before you print!    PRINTING   

To print your document, go to the Office Icon > Print, select your desired settings,  

and then click OK. You can also do this by using the shortcut CTRL + P    

To be able to change the orientation of your page for printing you can click on the  

Properties button under the option to Print then click the Layout Tab .    



  Page Setup button and printing  

 OTHER HELPFUL FUNCTIONS  

  UNDO AND REDO   In order to undo an action, you can click on the blue arrow icon that is pointing to  

the left at the top of the screen. To redo an action, you can click on the blue arrow  

icon pointing to the right. It is important to note that not all actions are undoable,  

thus it is important to save before you make any major changes in your document so  

you can revert back to your saved document.    QUITTING   

Before you quit, it's a good idea to save your document one final time. You will need  

to choose the Office Icon and choose Exit Excel. This is better than just closing the  

window, as it insures your document quits correctly. 

 

Getting Started Now that you have an understanding of where things are located, let’s look at the steps needed to 

create an Excel document.   

Opening Outlook You may have a shortcut to Word on your desktop, if so double click the icon and Word will 

open.  If not  follow the steps below: 1. Click on the Start button 2. Highlight Programs 3. Highlight Microsoft 

Office 4. Click on Microsoft Excel 2010          

Create a New Workbook 1. Click the File tab and then click New.  2. Under Available Templates, double click 

Blank Workbook or Click Create.    

Find and Apply Template Excel 2010 allows you to apply built-in templates and to search from a variety of 

templates on Office.com.  To find a template in Excel 2010, do the following: 1. On the File tab, click New.  2. 

Under Available Templates, do one of the following:  a. To reuse a template that you’ve recently used, click Recent 

Templates, click the template that you want, and then click Create.  b. To use your own template that you already 

have installed, click My Templates, select the template that you want, and then click OK.  c. To find a template on 

Office.com, under Office.com Templates, click a template category, select the template that you want, and then 

click Download to download the template from Office.com to your computer.  3. Once you click on the template 

you like it will open on your screen as a new document.   

Enter Data in a Worksheet 1. Click the cell where you want to enter data. 2. Type the data in the cell.  3. Press enter 

or tab to move to the next cell.   

Created By: Amy Beauchemin Source: office.microsoft.com 1/13/11  

Select Cells or Ranges In order to complete more advanced processes in Excel you need to be able to highlight or 

select cells, rows and columns.  There are a variety of way to do this, see the table below to understand the options.   

To select Do this A single cell Click the cell, or press the arrow keys to move to the cell. A range of cells Click the 

first cell in the range, and then drag to the last cell, or hold down SHIFT while you press the arrow keys to extend 

the selection. A large range of cells Click the first cell in the range, and then hold down SHIFT while you click the 

last cell in the range. You can scroll to make the last cell visible. All cells on a worksheet  Click the Select All 

button or press CTRL+A.  

Nonadjacent cells or cell ranges  



Select the first cell or range of cells, and then hold down CTRL while you select the other cells or ranges. NOTE: 

You cannot cancel the selection of a cell or range of cells in a nonadjacent selection without canceling the entire 

selection. An entire row or column Click the row or column heading.    Row heading  Column heading  

Adjacent rows or columns Drag across the row or column headings. Or select the first row or column; then hold 

down SHIFT while you select the last row or column. Nonadjacent rows or columns Click the column or row 

heading of the first row or column in your selection; then hold down CTRL while you click the column or row 

headings of other rows or columns that you want to add to the selection. Cells to the last used cell on the worksheet 

(lower- right corner) Select the first cell, and then press CTRL+SHIFT+END to extend the selection of cells to the 

last used cell on the worksheet (lower-right corner). Cells to the beginning of the worksheet Select the first cell, and 

then press CTRL+SHIFT+HOME to extend the selection of cells to the beginning of the worksheet. NOTE: To 

cancel a selection of cells, click any cell on the worksheet.  This is not applicable to cells with formulas in it.   

Modifying Spreadsheets In order to create an understandable and professional document you will need to make 

adjustments to the cells, rows, columns and text.  Use the following processes to assist when creating a spreadsheet.   

Cut, Copy, and Paste Data You can use the Cut, Copy, and Paste commands in Microsoft Office Excel to move or 

copy entire cells or their contents.  NOTE: Excel displays an animated moving border around cells that have been 

cut or copied. To cancel a moving border, press ESC.       

Move/Copy Cells When you move or copy a cell, Excel moves or copies the entire cell, including formulas and 

their resulting values, cell formats, and comments. 1. Select the cells that you want to move or copy. 2. On the 

Home tab, in the Clipboard group, do one of the following:  a. To move cells, click Cut .  b. To copy cells, click 

Copy .  3. Click in the center of the cell you would like to Paste the information too. 4. On the Home tab, in the 

Clipboard group, click Paste .  NOTES: Excel replaces existing data in the paste area when you cut and paste cells 

to move them.  When you copy cells, cell references are automatically adjusted. If the selected copy or paste area 

includes hidden cells, Excel also copies the hidden cells. You may need to temporarily unhide cells that you don't 

want to include when you copy information.    

Move/Copy Cells with Mouse 1. Select the cells or a range of cells that you want to move or copy.  2. To move a 

cell or range of cells, point to the border of the selection. When the pointer becomes a  

move pointer , drag the cell or range of cells to another location.    

Column Width and Row Height On a worksheet, you can specify a column width of 0 to 255 and a row height of 0 

to 409. This value represents the number of characters that can be displayed in a cell that is formatted with the 

standard font. The default column width is 8.43 characters and the default row height is 12.75 points. If a 

column/row has a width of 0, it is hidden.   

Set Column/Row Width/Height 1. Select the column(s) or row(s) that you want to change.  2. On the Home tab, in 

the Cells group, click Format.  3. Under Cell Size, click Column Width or Row Height.  4. A Column Width or 

Row Height box will appear. 5. In the Column Width or Row Height box, type the value that you want your column 

or row to be.       

Automatically Fit Column/Row Contents 1. Click the Select All button 2. Double-click any boundary between two 

column/row headings. 3. All Columns/Rows in the entire worksheet will be   changed to the new size NOTE: At 

times, a cell might display #####. This can occur when the cell contains a number or a date that exceeds the width 



of the cell so it cannot display all the characters that its format requires.  To see the entire contents of the cell with 

its current format, you must increase the width of the column.  

Set Column/Row Width/Height with Mouse  To change the width of one column/row 1. Place you cursor on the 

line between two rows or columns. 2. A symbol that looks like a lower case t with arrows on the horizontal line will 

appear 3. Drag the boundary on the right side of the column/row heading until the column/row is the width that you 

want.   To change the width of multiple columns/rows 1. Select the columns/rows that you want to change 2. Drag a 

boundary to the right of a selected column/row heading.  3. All selected columns/rows will become a different size.  

To change the width of columns/rows to fit the contents in the cells 1. Select the column(s) or row(s) that you want 

to change 2. Double-click the boundary to the right of a selected column/row heading. 3. The Column/Row will 

automatically be size to the length/height of the longest/tallest text.   

Merge or Split Cells When you merge two or more adjacent horizontal or vertical cells the cells become one larger 

cell that is displayed across multiple columns or rows.  When you merge multiple cells, the contents of only one cell 

appear in the merged cell.   

Merge and Center Cells 1. Select two or more adjacent cells that you want to merge.  2. On the Home tab, in the 

Alignment group, click Merge and Center.  3. The cells will be merged in a row or column, and the cell contents 

will be centered in the merged cell.    

Merge Cells To merge cells only, click the arrow next to Merge and Center, and then click Merge Across or Merge 

Cells.   

Split Cells 1. Select the merged cell you want to split 2. To split the merged cell, click Merge and Center .  The cells 

will split and the contents of the merged cell will appear in the upper-left cell of the range of split cells.   

Automatically Fill Data To quickly fill in several types of data series, you can select cells and drag the fill handle . 

To use the fill handle, you select the cells that you want to use as a basis for filling additional cells, and then drag 

the fill handle across or down the cells that you want to fill. 1. Select the cell that contains the formula that you 

want to be brought to other cells. 2. Move your curser to the small black square in the lower-right corner of a 

selected cell also know as the fill handle.  Your pointer will change to a small black cross.  3. Click and hold your 

mouse then drag the fill handle across the cells, horizontally to the right or vertically down, that you want to fill.  4. 

The cells you want filled will have a gray looking border around them.  Once you fill all of the cells let go of your 

mouse and your cells will be populated.  

Formatting Spreadsheets To further enhance your spreadsheet you can format a number of elements such as text, 

numbers, coloring, and table styles.  Spreadsheets can become professional documents used for company meetings 

or can even be published.   

Wrap Text You can display multiple lines of text inside a cell by wrapping the text. Wrapping text in a cell does not 

affect other cells. 1. Click the cell in which you want to wrap the text.  2. On the Home tab, in the Alignment group, 

click Wrap Text.  3. The text in your cell will be wrapped. NOTE: If the text is a long word, the characters won't 

wrap (the word won't be split); instead, you can widen the column or decrease the font size to see all the text. If all 

the text is not visible after you wrap the text, you might have to adjust the height of the row. On the Home tab, in 

the Cells group, click Format, and then under Cell Size click AutoFit Row   

Format Numbers In Excel, the format of a cell is separate from the data that is stored in the cell. This display 

difference can have a significant effect when the data is numeric.  For example, numbers in cells will default as 



rounded numbers, date and time may not appear as anticipated.  After you type numbers in a cell, you can change 

the format in which they are displayed to ensure the numbers in your spreadsheet are displayed as you intended. 1. 

Click the cell(s) that contains the numbers that you want to format.  2. On the Home tab, in the Number group, click 

the arrow next to the Number Format box, and then click the format that you want.    

If you are unable to format numbers in the detail you would like that you can click on the More Number Formats at 

the bottom of the Number Format drop down list. 1. In the Category list, click the format that you want to use, and 

then adjust settings to the right of the Format Cells dialog box.  For example, if you’re using the Currency format, 

you can select a different currency symbol, show more or fewer decimal places, or change the way negative 

numbers are displayed.        

Cell Borders By using predefined border styles, you can quickly add a border around cells or ranges of cells. If 

predefined cell borders do not meet your needs, you can create a custom border. NOTE: Cell borders that you apply 

appear on printed pages. If you do not use cell borders but want worksheet gridline borders for all cells to be visible 

on printed pages, you can display the gridlines.   

Apply Cell Borders 1. On a worksheet, select the cell or range of cells that you want to add a border to, change the 

border style on, or remove a border from.  2. Go to the Home tab, in the Font group 3. Click the arrow next to 

Borders  4. Click on the border style you would like 5. The border will be applied to the cell or cell range NOTE: 

To apply a custom border style, click More Borders. In the Format Cells dialog box, on the Border tab, under Line 

and Color, click the line style and color that you want.    

Remove Cell Borders 1. Go to the Home tab, in the Font group 2. Click the arrow next to Borders  3. Click No 

Border .  NOTES: The Borders button displays the most recently used border style. You can click the Borders 

button (not the arrow) to apply that style.    

Cell Styles You can create a cell style that includes a custom border, colors and accounting formatting. 1. On the 

Home tab, in the Styles group, click Cell Styles.  2. Select the different cell style option you would like applied to 

your spreadsheet. NOTE: If you would like to apply a cell fill and a cell border, select the cell fill color first the 

ensure both formats are applied.    

Cell and Text Coloring You can also modify a variety of cell and text colors manually. Cell Fill 1. Select the cells 

that you want to apply or remove a fill color from. 2. Go to the Home tab, in the Font group and select one of the 

following options: a. To fill cells with a solid color, click the arrow next to Fill Color , and then under Theme 

Colors or Standard Colors, click the color that you want.  b. To fill cells with a custom color, click the arrow next to 

Fill Color , click More Colors, and then in the Colors dialog box select the color that you want.  c. To apply the 

most recently selected color, click Fill Color .  NOTE: Microsoft Excel saves your 10 most recently selected custom 

colors. To quickly apply one of these colors, click the arrow next to Fill Color , and then click the color that you 

want under Recent Colors.    

Remove Cell Fill 1. Select the cells that contain a fill color or fill pattern.  2. On the Home tab, in the Font group, 

click the arrow next to Fill Color, and then click No Fill.    

Text Color 1. Select the cell, range of cells, text, or characters that you want to format with a different text color.  2. 

On the Home tab, in the Font group and select one of the following options: a. To apply the most recently selected 

text color, click Font Color .  b. To change the text color, click the arrow next to Font Color , and then under Theme 

Colors or Standard Colors, click the color that you want to use.    



Bold, Underline and Italics Text 1. Select the cell, range of cells, or text. 2. Go to the Home tab, in the Font group 3. 

Click on the Bold (B) Italics (I) or Underline (U) commands. 4. The selected command will be applied.   

Customize Worksheet Tab 1. On the Sheet tab bar, right-click the sheet tab that you want to customize 2. Click 

Rename to rename the sheet or Tab Color to select a tab color.  3. Type in the name or select a color you would like 

for your spreadsheet. 4. The information will be added to the tab at the bottom of the spreadsheet.     

Formulas in Excel Formulas are equations that perform calculations on values in your worksheet. A formula always 

starts with an equal sign (=).  An example of a simple is =5+2*3 that multiplies two numbers and then adds a 

number to the result. Microsoft Office Excel follows the standard order of mathematical operations. In the 

preceding example, the multiplication operation (2*3) is performed first, and then 5 is added to its result.   

You can also create a formula by using a function which is a prewritten formula that takes a value, performs an 

operation and returns a value.  For example, the formulas =SUM(A1:A2) and SUM(A1,A2) both use the SUM 

function to add the values in cells A1 and A2.   

Depending on the type of formula that you create, a formula can contain any or all of the following parts.  Functions 

A function, such as PI() or SUM(), starts with an equal sign (=).  Cell references You can refer to data in worksheet 

cells by including cell references in the formula. For example, the cell reference A2 returns the value of that cell or 

uses that value in the calculation.  Constants You can also enter constants, such as numbers (such as 2) or text 

values, directly into a formula.  Operators Operators are the symbols that are used to specify the type of calculation 

that you want the formula to perform.    

Create a Simple Formulas 1. Click the cell in which you want to enter the formula.  2. Type = (equal sign).  3. Enter 

the formula by typing the constants and operators that you want to use in the calculation.  4. Press ENTER.   

Create a Formula with Cell References  

 The first cell reference is B3, the color is blue, and the cell range has a blue border with square corners.  The 

second cell reference is C3, the color is green, and the cell range has a green border with square corners. To create 

your formula: 1. Click the cell in which you want to enter the formula.  2. In the formula bar, at the top of the Excel 

window that you use, , type = (equal sign).  3. Click on the 1st cell you want in the formula. 4. Enter an Operator 

such as +, or *. 5. Click on the next cell you want in the formula.  Continue steps 3 – 5 until the formula is complete 

6. Hit the ENTER key on your keyboard.    

EXAMPLE FORMULA   

WHAT IT DOES  

=5+2 Adds 5 and 2 =5-2 Subtracts 2 from 5 =5/2 Divides 5 by 2 =5*2 Multiplies 5 times 2 =5^2 Raises 5 to the 2nd 

power  

EXAMPLE FORMULA   

WHAT IT DOES  

=A1+A2 Adds the values in cells A1 and A2 =A1-A2 Subtracts the value in cell A2 from the value in A1 =A1/A2 

Divides the value in cell A1 by the value in A2 =A1*A2 Multiplies the value in cell A1 times the value in A2 

=A1^A2 Raises the value in cell A1 to the exponential value specified in A2 Create a Formula with Function 1. 

Click the cell in which you want to enter the formula.  2. Click Insert Function on the formula bar .  Excel inserts 

the equal sign (=) for you. 3. Select the function that you want to use.  NOTE: If you're not sure which function to 

use, type a question that describes what you want to do in the Search for a function box (for example, "add 



numbers" returns the SUM function), or browse from the categories in the Or Select a category box. 4. Enter the 

arguments.  5. After you complete the formula, press ENTER.     

Use Auto Sum  

To summarize values quickly, you can also use AutoSum. 1. Select the cell where you would like your formulas 

solution to appear. 2. Go to the Home tab, in the Editing group,  3. Click AutoSum, to sum your numbers or click 

the arrow next to AutoSum to select a function that you want to apply.      

Delete a Formula When you delete a formula, the resulting values of the formula is also deleted. However, you can 

instead remove the formula only and leave the resulting value of the formula displayed in the cell.  To delete 

formulas along with their resulting values, do the following:  1. Select the cell or range of cells that contains the 

formula.  2. Press DELETE.   To delete formulas without removing their resulting values, do the following:  1. 

Select the cell or range of cells that contains the formula.  2. On the Home tab, in the Clipboard group, click Copy . 

3. On the Home tab, in the Clipboard group, click the arrow below Paste , and then click Paste Values.     

Avoid common errors with formulas The following table summarizes some of the most common errors that you can 

make when entering a formula and how to correct those errors: MAKE SURE THAT YOU… MORE 

INFORMATION Match all open and close parentheses     Make sure that all parentheses are part of a matching 

pair. When you create a formula, Excel displays parentheses in color as they are entered. Use a colon to indicate a 

range     When you refer to a range of cells, use a colon (:) to separate the reference to the first cell in the range and 

the reference to the last cell in the range. For example, A1:A5. Enter all required arguments     Some functions have 

required arguments. Also, make sure that you have not entered too many arguments. Nest no more than 64 

functions     You can enter, or nest, no more than 64 levels of functions within a function. Enclose other sheet 

names in single quotation marks     If the formula refers to values or cells on other worksheets or workbooks, and 

the name of the other workbook or worksheet contains a non-alphabetical character, you must enclose its name 

within single quotation marks ( ' ). Enter numbers without formatting     Do not format numbers as you enter them 

in formulas. For example, even if the value that you want to enter is $1,000, enter 1000 in the formula.   

Charts in Excel Microsoft Excel no longer provides the chart wizard. Instead, you can create a basic chart by 

clicking the chart type that you want on the Insert tab in the Charts group.  Charts are used to display series of 

numeric data in a graphical format to make it easier to understand large quantities of data and the relationship 

between different series of data. To create a chart in Excel, you start by entering the numeric data for the chart on a 

worksheet. Then you can plot that data into a chart by selecting the chart type that you want to use on the Insert tab, 

in the Charts group.       Worksheet data  Chart created from worksheet data   

Getting to know the elements of a chart  

A chart has many elements. Some of these elements are displayed by default, others can be added as needed. You 

can change the display of the chart elements by moving them to other locations in the chart, resizing them, or by 

changing the format. You can also remove chart elements that you do not want to display. 1 The chart area is the 

entire chart and all its elements 2 The plot area is the area of the chart bounded by the axes.  

USING MICROSOFT POWERPOINT   

Microsoft PowerPoint is a professional presentation program that allows the user to create "presentation slides" that 

can be displayed on the computer screen or through a projector that is plugged in to the computer.  A PowerPoint 

presentation is a good way to convey pieces of information, usually in the form of an outline, to a large audience.  



Generally, PowerPoint presentations are appealing to users because they are easy to create and edit and generally 

small enough to fit onto a CD or a USB Jump Drive.  Therefore, a user does not have to carry around any slides or a 

slide project, and, if necessary, can make last-minute changes to the presentation.   

Microsoft PowerPoint Components:   

Before you get started with Microsoft PowerPoint (commonly referred to as PowerPoint), you will need to locate 

and open it on the computer.  It may be on your desktop.   

On the computer desktop:   

1. Double-click on the MS PowerPoint icon   

If the MS PowerPoint icon is not on the desktop, go to the Start menu:   

1. Click ► Star t ► Programs ► Microsoft PowerPoint*   

*Occasionally, Microsoft PowerPoint will be in a folder called "Microsoft Office" or similar – this will make one 

more step between "Programs" and "Microsoft PowerPoint" in the diagram above.   

MS PowerPoint will open a blank page called "Presentation1."   

The Title Bar     

This is a close-up view of the Title Bar, where file information is located.  Notice the default title "Presentation1."  

You will get a chance to rename your presentation slides the first time you choose to save it.   

The Menu Bar     

The Menu Bar is a common sight in almost all Microsoft Windows programs.  It features text- based menus, on 

which virtually every option available to the user in the entire program is listed.  Each menu expands when clicked 

(with the left mouse button), offering many options categorized by specific tasks.  

 Standard Toolbar     

Toolbars provide "shortcuts" to commands also found in the Menu Bar.  Toolbars are usually located just below the 

Menu Bar and exist to offer another way to perform the same task.   

The most commonly used commands in MS PowerPoint are also the most accessible.  Some of these commands 

are:    

New | Open | Save | Print | Preview | Spell-check | Copy | Paste | Undo | Insert   

Formatting Toolbar     

The Formatting Toolbar offers options that can change the font, size, color, alignment, organization, and style of the 

text in the presentation slides.  For example, (starting from the left side of the Toolbar) the "Arial" indicates the 

FONT of your text; the "32" indicates the SIZE of your text; and so on.   

This toolbar works the exact same way as the MS Word Formatting Toolbar.  The main difference is that the format 

changes will only affect the text box in which you are currently working.  All other text boxes will remain in the 

default setting ("Arial" font, size "32").   

Design/New Slide Icons     

Two additional shortcut icons appear on the MS PowerPoint toolbar: the Design icon and the New Slide icon.  Both 

commands are frequently used, and it is good to be familiar with their location on the toolbar.   

The Design icon is a shortcut to the slide design page.  Here you will be able to create and edit the appearance of 

your slide(s).   



The New Slide icon automatically adds a new, blank slide for you to work on.  You can keep track of the slides you 

have already worked on in the Slide Outline box on the left-hand side of the screen. You can access a slide at any 

time by clicking on it with your mouse through this screen.  

SIMPLE TASKS IN MICROSOFT POWERPOINT   

Text Boxes:   

Text Boxes are "designated" areas that allow you to type words, sentences, and bullet points into the slide.  You can 

adjust the size and placement of the text box within any given slide.  It is also possible to have multiple text boxes 

per slide.   

When you first open MS PowerPoint, there will automatically be two text boxes on the slide: "Click to add title" 

and "Click to add subtitle."  These text boxes already have a preset format applied to them.  The "title" box has a 

font size of "44" while the "subtitle" box has a font size of "32."  You can change the text format of any box at 

anytime by adjusting the format settings on the Formatting Toolbar.   

To adjust the size of the text box, first click on the text box.  Notice the change in border.  Once you have clicked 

on a text box, the border of the box becomes thicker and little circles appear on the corners and at the midpoints of 

the box.     

Move the mouse pointer over any one of the circles.  Notice that the mouse pointer will change to either ↔ or ↕.  

Click and hold down the left mouse button.  To adjust the height, move the mouse up or down; to adjust the width, 

move the mouse left or right.  Note that the corner circles can adjust both height and width, while the mid-point 

circles can only adjust either height or width.   

To move the text box to a different location on the slide, move your mouse pointer over any part of the thick, gray 

box outline.  Notice the change in your mouse pointer (it will look something like a "plus" sign (+) with arrows).  

Click and hold down the left button on your mouse.  You can now drag the text box to any position on the slide by 

simply moving your mouse.   

To write in a text box, simply click inside the box with your mouse.  When a cursor is flashing, you are ready to 

type.   

Slide Design:   

One of the more popular features of MS PowerPoint is that it gives the use a wide variety of design choices.  At 

some point, you may wish to change the design and color of the background of your slides.  To do so, simply click 

on the Design icon:   

On the right-hand side of your screen, the "Slide Design" pane will appear.  Here, you are given three design 

options to apply to your slides.   

Design Templates:  Here is a list of over 20 templates that you can choose from to apply to the background of your 

slides.  For each template, you have the option of applying the design to all slides or to only the selected slide.  You 

can view these options by clicking on the arrow on the right side of the template.    

If you are connected to the Internet, you can also choose to view hundreds of additional templates by choosing 

"Design Templates on Microsoft Office Online" on the bottom of the template screen.   

Color Schemes:  This option gives you a variety of color schemes to choose from to apply to you r selected design 

template.   



Animation Schemes:  This option will allow you to select different types of animation that can be applied to either 

all the slides or selected slides.  The animation schemes are different ways the slides are "introduced" to your 

audience, such as "faded wipe" or "pinwheel."   

Designing your own background:  Sometimes you may wish to design your own background.  To do this, select 

Format ► Background… from the Menu Bar.  Select the Color Bar on the bottom of the Background window and 

choose the appropriate color and or/effects that you desire.     

There is no right or wrong way to design your own background, so if you choose this option, have some patience 

and don't be afraid to experiment.    

Slide Layout:   

The default in PowerPoint for each new slide is to have a Title text box and a Text text box.  As discussed earlier, 

you do have the option of rearranging the text boxes to fit any layout you have in mind.  However, sometimes it will 

be easier simply to select a layout that fits your needs rather than reformatting the default layout for each slide.   

To choose a slide layout, select Format ► Slide Layout from the Menu Bar.  On the right-hand side of your screen, 

the "Slide Layout" pane will appear.  From here, you have the option of applying a slide layout either to a selected 

slide or to a new slide that has yet to be inserted.   

You can view these options by clicking on the arrow on the right side of the template.     

Note the four different types of layout categories.   

Text Layout:  These options are for choosing a layout in which you are only organizing different text boxes.  There 

is no room for pictures, charts, or graphs.   

Content Layout:  These options are for choosing a layout that will only contain pictures, charts, or graphs.  There is 

no room for text boxes.   

Text and Content Layout: These options have room for both text boxes and pictures, charts, or graphs.   

Other Layouts:  These layouts are designed for other media content such as video clips or audio tracks.   

Inserting a Picture:   

Inserting a picture into MS PowerPoint is very similar to inserting a picture into MS Word.   

1. Select the slide that you wish to add a picture to.   

2. From the Menu Bar, select Insert ► Picture ► From File (or Clip Art).   

3. Choose the picture you wish to insert and select "Insert."   

*Note: The picture will be inserted in its original size, so you will probably have to re-size it.  You can re-size a 

picture the same way you re-sized a text box.  Click on the picture and note the circles at the corners and at the 

midpoints of the length and width.  Move your mouse pointer over the circles, left-click the mouse and hold the 

button down.  Move the mouse vertically or horizontally to re-size.   

Rotating a picture:  It is possible to rotate pictures in MS PowerPoint.  Once a picture has been inserted onto a slide 

and you have clicked on the picture so it is "outlined," notice the green circle above the center of the picture.     

Move the mouse pointer over the green circle, and left-click and hold the button down.  Now move the mouse either 

clockwise or counter-clockwise and the picture will rotate in the same direction.   

Inserting a Graph or Table:   

There are two ways to insert a graph or table into a PowerPoint slide.   



1.  The graph or table may already exist in another document or file.  If this is the case, then you can simply insert 

the graph or table as you would a picture.  Follow the instructions under Inserting a Picture.   

Or you could Cut and Paste a graph or chart from another document or file into your slide presentation.   

2. MS PowerPoint can create graphs or tables directly in the slide.  From the Menu Bar, select Insert ► Chart (or 

Table).   

For the Chart option, PowerPoint will present a very simple bar graph.            

You will need to go in and edit the information in the bar graph to conform to the information you wish to represent 

in a chart.  From the Datasheet, you can enter in the appropriate values for the columns and re-name the entities.   

The Table option will present you with the following window:     

Select the appropriate number of rows and columns you wish to have in your table.  Click "OK" to insert the table.  

Once the table has been inserted you will be able to put information into the table cells.   

Slide Management:   

Once you have completed a slide, you can create a new slide by clicking on the New Slide icon.     

Notice that your previous slides still appear on the left-side frame.  You can still access your previous slides by 

simply clicking on them from this location.   

Once all your slides have been completed, you can present your slides in a "slideshow."  From the Menu Bar select 

Slide Show ► View Show.   

Notice that the slide takes over our entire screen.  To navigate through the slides, use the arrow keys on your 

keyboard (←, → or ↑, ↓).  You can also navigate through your slides by clicking on the left or right arrows in the 

lower left corner of your slide.   

To end your slide show, click on the square box on the lower left side of your slide show (this is difficult to see at 

first because it is designed to blend into you slide show so it won't be noticeable to your audience).  Select End 

Show from the pop-up window.       

 CLOSING MICROSOFT POWERPOINT   

Saving Slide Shows:   

When you come to a stopping point and want to leave the computer, it is important to save your work (even if you 

are printing a hard copy — saving should be a reflex). To save your work in MS PowerPoint, it is essential to know 

WHAT you are trying to save as well as WHERE you are trying to save it.    

Click ►File ►Save from the Menu Bar to get started.    

You can change the filename that PowerPoint has chosen just by typing a new one in the File name box at the 

bottom of the window that appears.    

MS PowerPoint will automatically save your document with the suffix “.ppt” – this is simply a tag that lets 

PowerPoint know that your work is specific to this program. You do not have to type it – just highlight what is there 

(default is “Presentation1”) and write a new file name.    

The My Documents folder on your computer’s hard drive is a good place to store your documents. A blank CD 

(compact disc) or a USB Jump Drive are great portable storage devices and can contain a LOT of data.   

It is important to note that every consequent command of SAVE will overwrite your original file, creating the most 

up-to-date version.    



If you want to save any changes to your PowerPoint slides without destroying the original one:    

In the Menu Bar, click ►File ►Save As from the menu bar and give your document a new filename (unique from 

the original).    

To bring a saved document back up on the screen from MS PowerPoint:    

Click ►File ►Open from the Menu Bar.   

Locate where the file is located (which folder, that is) and click on the filename of the document you want.    

Click ►Open.   

Printing Slides:   

To print your MS PowerPoint slides:    

Click ►File ►Print from the Menu Bar and a Print window will pop up on the screen.  Click ►OK for your 

document to start printing.    

As with all commands in MS PowerPoint, you can make changes along the way. From the Print menu, you can alter 

how many copies will be made, in what order the pages will be, and much more.    

Other useful tools are the Print Preview function found alongside the Print command and the Page Setup function. 

Print Preview will allow you to look over an exact copy of what will come out of the printer before actually 

executing the print command.   

Finding More Help:   

You can get help with MS PowerPoint by choosing Microsoft PowerPoint Help or Show the Office Assistant from 

the Help menu on the main menu bar.    

Tutorials are also available on the Internet. Your instructor can help you with locating some of these resources.   

Closing the Program:   

Congratulations! You have completed this course in Microsoft PowerPoint Basics. As you become more and more 

comfortable with the program, it is always helpful to continue to experiment with options that you come across – 

sometimes, you can uncover a tool that would have stayed hidden – and you can improve proficiency by learning 

the fine details of the program. When you are finished,    

Click ►File ►Exit from the menu bar    

OR    

Click on the X in the top right corner of the computer screen.   

NOTE: Images and screen captures may differ from those seen on another system.     

 

The MS PowerPoint Window The MS PowerPoint 2007 interface brings out all the functionality of the software 

using tabs rather than drop-down menus. You should get acquainted with the different parts of the main window:  

 Slide: A content holder for text and images. To insert additional slides click New Slide under the Slides section of 

the Home tab. The slide below is called the Title slide where you should enter the title of your presentation and 

information related to you, your organization, and colleagues.   Text box: A box outlined by dotted lines is where 

you enter your textual content.  Slides tab: A tab located in the left pane named Slides shows mini-versions of your 

slides and allows you to view many slides at once.  Outline tab: A tab located in the left pane name Outline that 

shows mini-versions of your slides but only the text.  Notes section: The section below the slide where you can 



write notes relating to the slide. This can be used by the presenter for practicing the presentation or handed out to 

the audience.   

Title Bar  The title bar contains (left to right) the Office Button, Quick Access Toolbar, the filename of your 

document (middle), and minimize, restore down, and close buttons (right).   

Office Button  The Office button (located at the top left of the MS PowerPoint Window) is a drop-down menu of 

commands (see figure on the right) that you can use on MS PowerPoint files. It includes creating a new file, 

opening an existing file, saving, and printing. A menu choice with a right pointing arrow expands to another menu 

of command choices.  

Saving Your Work   

For the first time To save your document for the first time, select the Save As→PowerPoint Presentation command. 

Fill in the entries for the Save As pop-up window and click the Save button when you are done:  

Save in Choose the location to place your file, i.e. to your desktop, a folder on the hard disk, flash drive, etc.  

File name Choose a name for your file. Note, do not include a file extension.  

Save as type Make sure „PowerPoint Presentation‟ appears here. Otherwise, select it in the drop down menu.  

While you work After saving for the first time, you will only need to select the Save menu choice for subsequent 

saves. An even faster way to do this is to use the hot button provided on the Quick Access Toolbar. Remember to 

save your document frequently.  

Backing up your work You can also save your document a second time in a different place. This is called “backing 

up your files”. Follow the directions under Saving Your Work: For the first time to create a second copy of your 

file. Although not necessary, it is suggested just in case you lose your first copy. Save to this backup copy every so 

often as a version to fall back to.  

MS PowerPoint 1997-2003 File Format Compatibility MS PowerPoint 2007 is backwards compatible because you 

are able to edit and save your MS PowerPoint 1997-2003 document files. When an MS PowerPoint 1997-2003 

document is opened for editing using the MS PowerPoint 2007 software, the window‟s title bar will indicate this by 

displaying [Compatibility Mode] next to the file name (see figure below). The document will be saved using the 

MS PowerPoint 1997-2003 file format when you use the Save command.   

You can save an MS PowerPoint 1997-2003 document to the new MS PowerPoint 2007 file format using the Save 

As→PowerPoint Presentation command (see figure on the left). Note, you can save an MS PowerPoint 2007 

document to the older MS PowerPoint 1997-2003 file format using the Save As→PowerPoint  97-2003Presentation 

command (see figure on the right).  

   Printing When you are ready to print your document on paper (called a hard copy) choose the command Print 

from the Office Button. Fill in the entries to the Print pop-up window and click the OK button when you are done:  

Name Choose the title of the printer you are sending your document to.  

Page range Lets you choose if you want to print your entire document or just a particular page or pages. For 

example, to print pages 1 through 5 of your 13 page document, you can type 1-5 in the Pages tab.  

Copies The Number of copies tab allows you to select how many duplicates of your document you want to print.  



You can view your document conveniently on the screen as it will appear on paper before you send it to the printer 

using Print→Print Preview. It is a good idea to get in the habit of using this feature before you decide to create a 

hard copy.   

Quick Access Bar The commonly used commands Save, Undo, and Redo can be found at the top left of the MS 

PowerPoint window as hot buttons (see below from left to right). You can customize this toolbar using the down 

arrow drop down menu (rightmost).   

Status Bar The Status bar is located at the bottom of the MS PowerPoint window. It displays the current slide (see 

1). You may view your document in different ways using the hot buttons to the right of the status bar (see 2): 

Normal , Slide Sorter , and Slide Show . You can find a description of each of these views in the discussion on the 

View ribbon. A slider allows you to zoom in or out of your document (see 3).    

Ribbons All MS PowerPoint commands that allow editing of the content of your document are organized into 

groups of related commands called ribbons. Each ribbon is displayed by clicking its tab found below the title bar. 

Each collection of commands found in a ribbon is further grouped into sections. A command is invoked by clicking 

on its hot button. The settings for a command are chosen by either using a drop-down menu or clicking on the 

Dialog Box launcher button  of a section, which appears at the bottom right of the section. A dialog box may have 

additional settings that do not appear on the ribbon.  

Home Ribbon The Home ribbon is the first place to start working on your slide because it contains commands 

related to editing text, paragraphs, and the clipboard.   

Slides Use the drop-down menu under New Slide to choose a format for your slide.  

Text and Paragraph Formatting The font associated with any text is the way your words look when typed. You can 

format your text with alignment, indentation, and line spacing.   

Font Section    

Paragraph Section The top row (left to right): Bulleting, numbering, decrease indent level, increase indent level, and 

line spacing (e.g. single or double spacing). The bottom row (left to right): Alignment (left, center, right, and 

justify), and number of columns.   

Bulleting breaks the flow of your content. You can use them for listing and prioritizing items in your document. For 

example,  

School Supply List  Books  Pens  Paper Numbering is used for creating outlines, instructions, to do lists, etc. For 

example,  

Opening Microsoft Word 1. Select Start 2. Select All Programs 3. Select Microsoft Office 4. Select Microsoft Word  

Clipboard Section The clipboard temporarily holds text, shapes, pictures, etc., previously cut or copied from your 

document. The Clipboard section contains commands to cut or copy content from your document to the clipboard 

and paste content from the clipboard back to your document. The paste command will insert at the insertion point 

the most recent item that was cut or copied to the clipboard.   

In fact the clipboard maintains up to 24 items in the order they were previously cut or copied. Click on the Dialog 

box launcher button  to view the entire contents of the clipboard.  

             

Unit – IV    [ Introduction to Accounting ]  



 
   COMPILATION OF VOUCHERS IN THE ACCOUNTING SECTION 

 1      On receipt of the daily memorandum of pre-check payments (i.e. carbon copies of the relevant page of the 
register of cheques delivered) along with the vouchers from the cheque Section, the Accounts Section should verify 
whether all the vouchers mentioned in the daily memorandum have been received and whether the amount and total 
are correctly entered. (When a cheque is issued in lieu of a time-barred cheque, the latter duly cancelled should be 
treated as the voucher bearing classification minus credit 8670-Cheques and Bills etc. thereon, for issuing a fresh 
cheque in lieu of the cancelled one.) After this verification, one copy of the daily memorandum shall be returned to 
the Cheque Section as acknowledgement for the vouchers received. Similar action should be taken when a copy of 
the list of payments along with paid vouchers is received from the Cheque Section, as per the procedure mentioned 
in para 3.4 of Chapter 3 of this Manual. If any voucher is found to be missing, the fact should be entered in the 
relevant memo/list of payments and efforts should be made to trace it/obtain it. If it is not traced/obtained before the 
month's posting is completed, the amount of the voucher should be posted against the sub head "Challans/Vouchers 
Suspense" under the major/minor heads "8658-Suspense Accounts-Suspense Account (Civil)". 

2    The grand total of the amounts of cheques delivered during the entire month as derived from the said 
memos/lists of payments for that month should be posted on the credit(receipt) side against the inner column 
'Original' under the minor heads 'PAO Cheques' and 'Departmental Cheques' respectively under the major head 
'8670-Cheques and Bills' in the classified abstract. 

3    The vouchers should be compiled on the same day on which they are received from the Cheque Section. They 
should be posted in the Compilation Book or Compilation Sheet (Form CAM 33).Separate sheets should be used for 
the vouchers passed by the P.A.O. and for those passed by Cheque Drawing D.D.Os. The gross amounts indicated in 
the voucher against various units of appropriation or public account etc. should be posted against the concerned 
heads; deductions/ recoveries shown in payment vouchers will be compiled under each relevant head such as 
income-tax, surcharge, licence fee, recovery of house building advance, motor car advance, G.P. Fund contribution 
etc. or 'PAO Suspense' head etc. where a credit is adjustable finally in the books of another accounts authority. The 
recoveries of overpayments whether made in cash or by short drawal from a bill, shall be taken in reduction of 
expenditure under various detailed heads, if they are refunded in the same account year. Such recoveries pertaining 
to previous year(s) shall be recorded under a distinct minor head, “Deduct Recoveries of Overpayments” below the 
concerned major/sub-major head. The P.A.O. should also ensure each day that the total amount of cheques delivered 
during the day and the amounts appearing under the head 'PAO Cheques' in the compilation sheet agree and 
similarly that the total amount of cheques issued by Cheque Drawing DDOs each week tallies with the amounts 
appearing under the head 'Departmental Cheques' for that week. Correctness of posting of each voucher in the 
compilation sheet should be checked by tallying the total of the debits under various detailed heads with the total of 
the credits which represents the deductions/recoveries plus the net amount of the voucher. 

4    At the end of each month, it should also be ensured that the grand total of the debits for all the vouchers together 
in the compilation sheet(s) set apart for the PAO's vouchers (and separately for each Cheque Drawing DDO's 
vouchers) agree with the grand total of the credits therein. 

Note:    The effect of payments of outstation pay bills by bank drafts is that the bank would account for the payment 
of salary for March in its daily scroll for March itself on the day on which it issues the bank drafts. The P.A.O. 
would debit the net amount for which the bank draft has been issued to the suspense head 'Outstation Pay Bills for 
March' under the minor head 'Suspense Accounts (civil) below the major head '8658 Suspense Accounts' per contra 
credit to the minor head 'PAO cheques' below the major head '8670 Cheques and Bills'. While the minor head 'PAO 
- Cheques' would be cleared by minus credit per contra credit to the minor head 'P.S.B. suspense' below the major 
head '8658- Suspense Accounts' or to the head '8675 - Deposits with Reserve Bank Central (civil)' as the case may 
be, on receipt of the payment scroll from the bank ,in March itself and the debit under the suspense head would be 
cleared by the PAO in April by debiting the head salaries for the gross amount and minus debiting the head 
'Outstation pay bills for March' and crediting the relevant receipt/recovery heads of accounts, by proposing transfer 
entries in the first week of April to ensure prompt clearance of the suspense head. 

   COMPILATION OF RECEIPTS 



5.2.1    On receipt of the receipt scrolls from the bank(s) alongwith challans, the entries should be tallied with the 
individual challans and totals should be checked. If any challans are found to be wanting, the absence thereof should 
be specifically noted in the register in form CAM.17 (i) for being obtained from the bank and (ii) for being exhibited 
in the accounts against the sub head "Challans/Vouchers Suspense" under the major/minor head '8658-Suspense 
Accounts' etc at the end of the month, if still awaited. This suspense head would be cleared by minus credit on 
receipt of the challan by classifying the same under the relevant receipt/refund head of account. 

5.2.2    The receipts should be compiled in Compilation Sheet(s) (separate sheet or portion being utilised for booking 
credit against each bank account) under the relevant major, minor and sub/detailed heads of accounts. At the end of 
each month, it should be ensured that the grand total of the credit in the compilation sheet tallies with the grand total 
of the amount of all the receipt scrolls together as posted in the register (Form CAM 17) referred to in para 1.9.4 of 
Chapter 1 of this Manual. 

5.2.3    Notwithstanding the above instructions, separate procedure for compilation if any, prescribed by 
CBDT/CBEC in regard to compilation of accounts for revenue collected under the provisions of their schemes 
would continue to be followed by them. 

5.3    TRANSFER ENTRIES 

5.3.1    Transfer Entries, which are entries intended to transfer an item from one head of account to another, are 
necessary:- 

(a)    in order to correct an error of classification in the original accounts; 

(b)    in order to adjust by debit or credit to its proper head, an item outstanding under a Debt, Deposit or Remittance 
head; 

(c)    to effect periodical adjustments such as : 
(i)    annual adjustment of interest payable on the accumulations/accretions of G.P.Fund/C.P.Fund etc. by debiting 
the major head '2049 - Interest payments' and crediting the heads '8009-State Provident Fund-G.P.Fund/C.P.Fund 
etc.  

(ii)    adjustment by Pr.A.O. to transfer/clear the amount from the minor head 'Public Sector Bank Suspense' below 
the major head '8658- Suspense Accounts' to major/minor heads '8675-Deposits with Reserve Bank-Central (civil)' 
etc.  

(d)    to arrange payments of grants in aid/loans to state governments/union territory governments etc. 

Transfer entries should be prepared in the Form CAM-34. On one side of every transfer entry, there should be only 
one major head but there may be a debit or credit to various other heads or vice-versa. In a transfer entry all 
particulars explaining both the nature of the adjustment and the grounds for the correction must be clearly stated. 

5.3.2     A list of adjustments which have to be made periodically should be maintained in order to ensure that they 
are regularly made. 

5.3.3.    If an item which properly belongs to a revenue or expenditure head is wrongly classified under another 
revenue or expenditure head in the accounts, the error may be corrected at any time before the accounts of the year 
are closed by proposing a transfer entry; but after the accounts are closed, no correction is admissible, it being 
sufficient to make a suitable note of error against the original entry. If, however, the error affects the receipts and 
disbursements of another Government or the transactions of a commercial department, it should be corrected by 
transfer in all cases as soon as the error is discovered. Corrections or transfers affecting capital major heads which 
do not affect the accounts of other governments, should be effected by merely altering the progressive figures and on 
'proforma' basis for purposes of Statement No.12 of Finance Accounts, that is , without passing debit and credit 
entries through the accounts of the year’s financial transactions. This would avoid unnecessary inflation of the actual 
expenditure appearing in the accounts of the year in which the misclassification etc. was detected. 

5.3.4    An error which affects a debt, deposit, suspense or remittance head must be corrected by transfers, however, 
old and small it may be. If the accounts of the year in which the error takes place are not closed, the correction 
should be made by the removal (through minus entry) of the item from the head under which it was wrongly taken to 
that to which it properly belongs. 



For example a debit amounting to Rs. One lakh representing house-building advance has wrongly been booked 
under 'Motor Car Advance' below the major head '7610-Loans to government servants etc.'. As the accounts of the 
year are yet open, the correction may be made by debiting the head 'House Building Advance' and withdrawing the 
same by minus debit to the head 'Motor Car Advance' below the major head '7610-Loans to government servants 
etc.' in the same year in which the error has crept in. 

If the accounts of the year in which the error takes place are closed, then the following procedure may be adopted: 

(i)    an item taken to one debt, deposit, suspense or remittance head instead of another the correction should be 

made by transfer from the one to the other.  

(ii)    an item credited to a debt, deposit, suspense or remittance head instead of to a revenue head; or debited to a 
debt, deposit, suspense or remittance head instead of to an expenditure head-the correction should be made by 
transfer to the head under which it should originally have appeared;  

(iii)    an item credited to a revenue head instead of to a debt, deposit, suspense or remittance head-correction should 
be made by debiting refunds and crediting the proper head; e.g. Transactions relating to 'Central Government 
Employees Group Insurance Scheme' below the major head '8011-Insurance and Pension Funds' have wrongly been 
credited to the minor head 'Government Employees Insurance Schemes below the major head '0235-Social Security 
and Welfare', the corrections after the close of the year would be as under:  

Dr 

Major Head 0235 - Social Security and Welfare 
Sub-major Head 60 - Other Social Security and Welfare Programmes 

Minor Head 105- Government Employees Insurance Schemes 
Deduct - refunds 

To 

Major Head 8011 - Insurance and Pension Funds 
Minor Head 103 - Central Government Employees Group Insurance Scheme  

Cr. 

(iv)    an item debited to an expenditure head instead of to a debt, deposit, suspense or remittance head-correction 
should be made by debiting the appropriate head and crediting the relevant receipt head; in the case of department 
not having a corresponding receipt head, to the M.H.0075-Misc. General Services. 

However, when the correction affects a head for which budget provision is obtained, the correction/transfer may be 
effected by affording plus credit or minus credit under the head concerned, without affecting the actual expenditure 
(i.e., debit side of the head) for the year. 

(Errors in the accounts of works in the Central Public Works Deptt. are governed by the provisions of article 200 of 
Account Code Vol. III) 

5.3.5    All transfer entries prepared during a month should be entered in the Transfer Entry Number Book (Form 
CAM 35). The effect thereof should be reflected in the monthly accounts of that month after preparing a 'Summary 
of Transfer Entries' (Form CAM 36) as described in the next sub para. 

5.3.6    As and when approved, transfer entries should be posted individually into columns 1 and 2 of Form CAM-35 
against the respective heads of account affected. After all the T.Es. for the month are, thus entered, the total effect 
against each head of account separately under debit and credit columns should be worked out and posted into money 
columns 5 and 6 respectively of that form. Thereafter the grand total under columns 5 and 6 should be worked out 
and agreed with the grand total under columns 1 and 2 respectively to serve as a cross check. The figures appearing 
in columns 5 and 6 against each head of account should be posted against the corresponding head of account in the 
departmental classified abstract in the appropriate column. In case a bound book is not used for entering each year's 
monthly Summary of T.Es, then at the end of the year the monthly sheets of the document should be arranged in the 
order of the months and bound into a convenient volume. 



Travel Vouchers - Preparation 

Procedure No. 4-31 Revision 7/2009 

I. Memorandum of Expenditures 
 
A memorandum of all travel expenditures properly chargeable to the University shall be kept by 
individuals subject to the travel regulations. The information thus accumulated shall be available for the 
proper preparation of travel vouchers. 

II. Preparation of Travel Vouchers 

A. Travel Voucher Forms-All claims for the reimbursement of traveling expenses shall be 
submitted on authorized reimbursement forms and shall be itemized in accordance with the 
regulations. The computerized form is available on the Accounting Office home page at 
<http://www.finfacil.niu.edu/Accounting/AccountingOffice.htm> 

 

B. Routing-The original completed travel voucher and receipts should be forwarded to your 
Department Head or Fund Advisor. The traveler should retain a copy of the voucher and all 
receipts for his files. After approval, the Department Head or Fund Advisor should forward the 
original to the Accounting Office for processing. The department number or fund number on 
which the funds are to be drawn should be placed above the Department Head’s signature in 
the space provided. 

 

C. When to Submit-Travel vouchers should be submitted to the Accounting Office as soon as 
possible after completing travel. As a guideline, they should be submitted within 30 days of 
completion of travel. 

 

D. Departure and Arrival Time-The date and time of departure from and the date and time of 
return to traveler’s official headquarters should be shown. 

E. Reporting of Expenses (voucher columns) 

1. Auto Reimbursement-Report trip mileage and among for private automobiles used on 
official business. Parking and toll charges must be reported under “Other Expenses”. 
When a privately owned vehicle is used, the travel voucher shall show the dates and 
points of travel, mileage, and mode of transportation. If the distance traveled between 
any given points is greater than the usual route between these points as shown on the 
road map, the reason for the greater distance shall be stated on the voucher. A 
statement indicating the reason for using a privately owned vehicle shall also be 
shown on the face of the travel voucher. 

2. Plane, Train or Bus Fare-This column should be used to report the cost of the primary 
mode of transportation. Incidental charges should be reported under “Other 
Expenses.” 

3. Lodging-For hotel or motel accommodations, the receipts bill or invoice form must be 
attached. Lodging, telephone charges, and restaurant charges are frequently listed 
together on a hotel bill. These charges must be separated and listed under the 
appropriate columns of the voucher. These charges should not be listed together in the 
“Lodging” column. 

4. Meals-Report actual cost of meals including tips, not to exceed amounts specified in 
the travel regulations, Procedure No. 4-30. When the per diem rate applies, do not 
attempt to separate incidental expenses included in the per diem rate. Cost centers 
may require receipts for meal charges. 

5. Other Expenses-All other allowable expenditures not covered above should be 
reported under this caption. Sample Travel Voucher 

F. Receipts-All receipts must be original documents and are mandatory for expenses in excess of 



$10.00. 

G. Purpose-The purpose of each trip must be stated below the other trip data. 
H. Signatures-All copies of the voucher must be signed by the individual who has incurred the 

expense and by the appropriate Department Head. Vouchers submitted by a Department Head 
must be signed by a Dean or Division Head, those submitted by a Dean or Division Head must 
be signed by the responsible Vice President, and those of a Vice President must be forwarded 
to the Office of the President for approval. Vouchers submitted by Grant or Local Fund 
advisors require the signature of an appropriate upper level staff member. 

I. Other Information 
1. Submitting the Travel Voucher-All travel expenses incurred in any one month may be 

shown on one voucher. For the traveler’s convenience, a travel voucher may be 
prepared upon the completion of each individual trip. 

2. Requesting a Car-If a University car is to be used for transportation, a “Request for 
Transportation” form must be filled out, signed by the Department Head, and 
submitted to the Transportation Office, Dorland Building. The Transportation Office 
requires the recording of the user’s Driver’s License identification number and 
expiration date prior to releasing a University vehicle. 

3. Fund Sources-These travel procedures apply to all University travel regardless of 
source of funds. A travel voucher involving more than one source of funds or line 
item should indicate account number and amounts. 

4. Travel of Candidates-(See Procedure No. 4-37) 
J. Individuals submitting travel vouchers are personally responsible for their accuracy and 

propriety. Any misrepresentation may be cause for disciplinary or legal action. 
K. Accounting Office Responsibilities-Each travel voucher will be reviewed for completeness, 

proper receipts, clerical accuracy and University policy. Questions will be referred to the 
traveler or, if necessary, to the Department Head (of Fund Advisor). Travel voucher checks 
will be written from university funds and sent to the address shown on the travel voucher. 

If there are any questions concerning the completion of your travel voucher, contact the Travel Voucher clerk in 
the Accounting Office-Telephone: 753-6128. 

  

 

RENDITION OF MONTHLY ACCOUNTS BY PAY AND ACCOUNTS OFFICES 

5.7.1    Each Pay and Accounts Office shall send by the 7th of the following month to its Principal Accounts Office, 
a monthly account in computer format prescribed by the Controller General of Accounts separately for each 
ministry/department. The account shall show the monthly as well as progressive figures of receipts and payments 
against the final level of classification. The expenditure shall further be exhibited grant-wise against each primary 
unit of appropriation showing Plan and Non Plan, Voted and Charged expenditure separately. At the end of the 
account, a proof sheet shall be attached showing Grant-wise/Major head-wise totals (separately for Plan and Non-
Plan, Voted and Charged Expenditure) with grand totals to ensure that the total of receipts agree with the total of 
payments i.e. the account is balanced. 

5.7.2    On receipt of Pay & Accounts Office monthly accounts in the Principal Accounts Office, they will be 
checked especially to detect prima-facie errors in classification. The Principal Accounts Office will consolidate the 
Pay and Accounts Office Accounts on computer through the software package 'Contact' and print on the computer 
an abstract group minor head-wise totals for the purposes of appropriation control. Certain checks are to be 
exercised to ensure that all the transactions of each P.A.O. are compiled on the Computer and the amounts of each 
transaction properly classified and taken on the computer. These checks are listed in Annexure-A-Part I. 

After the proof sheet has been reconciled (as detailed in Annexure-A-Part I), a floppy containing the Consolidated 
accounts for the Controller is to be created using the "clear files" option of 'Contact' and sent to C.G.A. 's office by 
the 20th of the following month. The format of the forwarding letter should be as given in the Annexure-A-Part III. 



5.7.3    The Chief Accounting Authority of the Ministry/ Department may require Principal Accounts Office/Pay and 
Accounts Offices functioning under him, to render accounts showing expenditure against grants/units of 
appropriations in such form as may be required. 

5.8    SUBMISSION OF MONTHLY ACCOUNTS BY THE PRINCIPAL ACCOUNTS OFFICE OF THE 

MINISTRIES/ DEPARTMENTS TO THE CONTROLLER GENERAL OF ACCOUNTS. 

(i)    For Civil Ministries  

Consolidated Monthly accounts from Principal Accounts Office to Controller General of Accounts - 15th of the 
following month. 

(ii)    For Non-Civil Ministries and U.T. Administrations :  

17th of the following month. 

5.9    STATEMENT OF CENTRAL TRANSACTIONS AND JOURNAL ENTRIES 

5.9.1    A Statement of Central Transactions will be prepared by each Principal Accounts Office at the end of every 
financial year representing the progressive effect of all the transactions during the year upto and including March 
(supplementary) transactions and prepared only with minor head-wise details under different major heads concerned 
and showing charged, voted, Plan and Non-Plan expenditure distinctly. No alterations should be made in the 
classified abstract or consolidated abstract of any month after they have been closed. When errors are discovered in 
the same year involving a correction by transfer of amount from one minor head to another under the same major 
head or from one major head to another after the Statement of Central Transactions is prepared and submitted, 
necessary corrections termed Journal Entries (in short J.Es) should be proposed by using the same form as for 
transfer entry and supported by a "statement of effect of the corrections " wherein the amount of each correction and 
amount, after the correction, are to be indicated against the concerned heads. Corrections between detailed heads 
under the same minor head may be carried out by P.A.Os by making plus and minus entries against the affected 
heads keeping a note of error in such cases in the relevant ledger. 

5.9.2    All Journal Entries should be serially numbered for easy identification and signed by the head of the 
Accounting Organisation viz., CCA/CA/Dy.CA/AG as the case may be. Approval of the C.G.A. should be obtained 
therefor for incorporation in the accounts. The Principal Accounts Office should also apprise concerned P.A.O. of 
the details of J.Es accepted by the C.G.A. for incorporation in the accounts, in so far as they affect the figures held in 
the books of each such P.A.O. to enable the latter to prepare his ledger etc. on the basis of the updated data. 

5.10    LEDGER OF BALANCES UNDER DEBT, DEPOSIT, SUSPENSE & REMITTANCE HEADS. 

5.10.1    (a)    The monthly figures posted in the various broadsheets pertaining to debt, deposit, suspense and 
remittance heads will have to be compared with the figures of that month's transactions under relevant heads in the 
monthly account for verifying that the two sets of figures tally; discrepancy if any, between the two should be 
analysed forthwith to set right any unposted item or misclassification. 

(b)    The two heads of account '7810-Inter-State Settlement' (Sector G) and '7999-Appropriation to Contingency 
Fund' (Sector H) are not of the nature of debt, deposit, suspense or remittance heads and are also to be closed to 
Government Account annually vide para 5.11. Balances under debt, deposit, suspense and remittance heads are to be 
individually closed to balance(as per para 5.9.2),except that balances under the head '8680-Miscellaneous Govt. 
Account' are to be closed to Govt. Account annually and those under '8675-Deposits with Reserve Bank' held in the 
books of Principal Accounts Offices should be closed annually to Govt. Account, but those in the books of the 
Controller General of Accounts are to be transferred to the head '8999-Cash Balance', every month. 

5.10.2    The `Ledger' for Debt Deposit Suspense and Remittance heads closing to balance viz. those under Sectors 
E,F,I,J,K,L, (excluding major heads `8675 -Deposits with Reserve Bank and "8680-Miscellaneous Government 
Account and "M" of the List of Major and Minor Heads of Account may be prepared half-yearly for the first six 
months from April to September after the accounts of September are closed and thereafter quarterly from October to 
December and from January to March including March Supplementary by using proforma-Form CAM-40. It will be 
prepared by P.A.O.s upto sub/detailed heads, as may be necessary, based on the figures of first six months and 
subsequently for the two quarters, and sent to Principal Accounts Office so as to reach by 5th November, 5th 
February and 5th July of each year respectively. Amounts of balances adopted/transferred, if any, on "Proforma" 



basis in terms of provisions of para 16.4 of Chapter 16 will be clearly indicated in the relevant columns of Forms 
CAM-40 & 41. Amounts adopted on transfer consequent on the Departmentalisation of Accounts from Accountants 
General would have to be exhibited similarly in the Ledger of the respective year in which the 'Proforma' transfer 
was effected. Principal Accounts Office will prepare a 'Ledger' comprising the transactions of all "P.A.Os" under his 
jurisdiction put together, with minor head-wise details only on the basis of figures furnished by the PAOs 
periodically. The Ledger will be submitted to the respective CCA/CA for review by 10th November, 10th February 
and 10th July of each year. A copy of the Periodical Statement together with the comments of the respective 
CCA/CA with action initiated to liquidate huge outstanding balances and to wipe out adverse balances under various 
Debt, Deposit Suspense and Remittance Heads should be sent to the Finance Accounts Section of the Controller 
General of Accounts by 15th November, 15th February and by 15th July respectively each year for regular 
monitoring. It may be ensured that the progressive figures appearing during the course of the year tally with those 
appearing in the Statement of Central Transactions including the effect of all Journal Entries incorporated therein. 
Balances under the head "Public Sector Bank Suspense" need not be included in the 'Ledger' to be maintained by 
P.A.Os, since clearance against this head for adjustment against the head "Reserve Bank Deposits" is carried out 
only in the Principal Accounts Office. A sector-wise abstract of balances figuring in the 'Ledger' will be prepared 
thereafter by the Principal Accounts Office in form CAM-40. 

5.11    COMPUTATION OF GOVERNMENT ACCOUNT 

5.11.1    Progressive figures as at the end of each year under the heads falling under sectors A, B, C, D, G & H 
appearing under the Consolidated Fund as well as under the major heads 8675-R.B.D. and 8680-Miscellaneous 
Government Account under Sector 'L' under the Public Account are to be closed to Government and not carried over 
to the following year. The total of the progressive figures to the end of each year under them is to be worked out to 
arrive at the balance under "Government Account" in the manner shown in Annexure "C". The closing balance 
under "Government Account" will have to be carried over to the statement "Summary of Balances" described in the 
next paragraph and as shown in the illustrative example. 

5.12    SUMMARY OF BALANCES 

5.12.1    A statement called "Summary of Balances" is to be prepared comprising sector-wise balances etc. in the 
proforma indicated in Annexure "B". The closing balances under "Government Account" and the closing balance 
under various debt, deposit, suspense and remittance heads which close to balance are to be entered therein. The 
total under each of the two sides (Debit and Credit sides) of the statement should be equal. 

5.12.2    The statement prepared for the transactions of Government of India as a whole by the C.G.A. will form 
Statement No 5 of the Finance Accounts. 

5.13    ILLUSTRATIVE EXAMPLE 

5.13.1    An illustration for the preparation of Sector-wise 'Ledger', Sector -wise "Government Account" and Sector-
wise "Summary of Balances" is appended at Annexure B. Though amounts are shown therein to the nearest crore of 
rupees, in actual accounts they have to be shown upto a unit of rupee. 

5.14    SUBMISSION OF MATERIAL FOR STATEMENT No.5 OF FINANCE ACCOUNTS TO C.G.A. 

5.14.1    PAOs should submit to the Principal Accounts Office (say by the 10th October every year), a copy of the 
'Ledger' with only minor head-wise figures. The Principal Accounts Office will tally the figures in the 'Ledger' 
(except under P.S.B. Suspense) as prepared by it from its S.C.T. with the total for all its PAOs and prepare a 
statement of " Summary of Balances". A copy each of the Sector-wise 'Ledger', 'Government Account' and 
'Summary of Balances' will be sent by each Principal Accounts Office to the CGA's Office every year by the date 
prescribed by the latter. 

5.15    PROFORMA CORRECTIONS 

5.15.1    "Proforma" corrections to balances of earlier years (in cases where provisions of Rule 38 of Government 
Accounting Rules,1990 are not attracted), wherein either (a) a head closing to balance vis-a-vis a head closing to 
Government Account are involved or (b) correction of a balance under a head (closing to balance) purely as an 
accounting device is involved, are to be effected by affording relevant contra effect to "Government Account" 
referred to above . Approval of the C.G.A. is required to be obtained in each case for the incorporation of any such 
'Proforma' correction(s) or of any other type, indicating full background/justification therefor. 



5.15.2.    Expenditure incurred under the Consolidated Fund of India and booked to the correct heads is also 
accounted for in the Appropriation Accounts and forms part of the balances under "Government Account" or under 
Loan, debt, etc. heads in the Finance Accounts. 

Certain types of decisions taken by Government occasionally, affect such balances (which represent progressive 
effect of bookings during earlier years),and necessitate alteration in the figures of balances exhibited in the "Ledger 
of Balances", Finance Accounts, etc. For this purpose, the device of "Proforma Correction" is adopted so as not to 
have to pass the old transactions of expenditure, etc. once again through the monthly accounts/S.C.T. of the year 
whose accounts are open at the time the relevant Government decision is taken. 

The following are some main types of situations in which "Proforma corrections" are required to be MADE :- 

(i)    Whenever a decision is taken by Govt. (i.e. Ministry/Department concerned in consultation with the Budget 

Division of the Department of Economic Affairs, C.G.A. and on the advice of the C. & A.G.) to change 

classification of a specific type of transaction from a head closing to "Government Account" or to balance under a 

Loan, Debt, etc. head to another Loan, Debt, etc. head which closes to balance. The decision would imply that the 

aggregate effect of transactions booked during earlier years under the relevant affected head would have to be 

transferred to the new head selected for the purpose. An example of this type is of consolidation of loans given to 

States, as a result of recommendation of the Finance Commission, which involves transfer of aggregate balances 

from Minor Heads under relevant sub-Major heads to various Minor Heads under the new Sub-Major Head e.g. "F-

Pre 1984-85 Loans" below the Major Head "7601-Loans and Advances to State Governments."  

(ii)    Based on decisions of Government, Controller of Aid Accounts and Audit as well as Railway Board effect 
certain increases or decreases in the opening balances of heads of accounts operated upon exclusively by them, 
without routing adjustments through the monthly accounts or Statement of Central Transactions of the year for 
which the Finance Accounts are under preparation.  

(iii)    If and when under special orders of Government, a Government aided institution is taken over without any 
cash outgo for being run as a Departmental Undertaking, balances pertaining to its liabilities, namely, loans and 
advances borrowed by it and assets and investments owned by it, are taken under the relevant head of account with a 
contra entry against "Government Account" and or loan head under which loans may have been given to it earlier. 
Similarly, where a Departmental Undertaking is converted into a Company or Corporation, etc. the balance (or 
progressive capital expenditure under various capital expenditure heads) pertaining to the Undertaking, would need 
re-classification under the appropriate heads in the light of the change in status of the Undertaking. In such cases 
also, "Proforma corrections" of the balances under relevant heads would be necessary.  

(iv)    Whenever a decision is taken by Central Govt. for conversion of a Grant-in-aid given during any earlier 
financial year to a State Govt. or U.T. Govt. into a loan; or a loan given into a Grant-in-aid with retrospective effect, 
after issuing necessary sanction therefor and including necessary explanation in the notes on Demands for Grant 
concerned. In the former type of cases, the progressive figure under the Major Head "7601" ( see Para 10.8.7 as 
well) -Loans and Advances to State Governments" will be increased through a "Proforma correction" after affording 
contra credit for a corresponding amount under "Government Account". This will have to be reflected in the ledger 
of balances "Form CAM-41", "Government Account" (Form CAM-42) and in the material for Finance Accounts to 
be submitted to CGA. A note should also be kept in the loan register indicating briefly the terms and conditions of 
the repayment of loan. In the case of retrospective conversion of a loan given earlier into a Grant-in-aid, the relevant 
sanction order should indicate the treatment to be given to the portion of loan which had already been repaid and 
also to the interest paid to Central Govt. by the recipient of the loan. "Proforma correction" would similarly be 
required so as to decrease the progressive figure under the relevant Minor Head under the Major Head "7601-Loans 
and Advances to State Governments" by affording contra debit to "Government Account" in the documents referred 
to above.  

(v)    Paras 10.8.5 and 10.8.6 envisage the raising of or lowering down of balance under the two Minor Heads 
"Advances for purchase of other conveyances" and "Other advances", by Principal Accounts Offices, wherever 
necessary, with the approval of the C.G.A. To give effect to this, they would have to effect proforma corrections to 
the closing balance(s) against the affected head(s) in their ledger of balances in form CAM-41 reflecting contra 
effect in their "Government Account" in form CAM-42 and in the material for Finance Accounts to be submitted to 
C.G.A.  

5.15.3    Adjustments relating to "Proforma Corrections" in respect of the type of transactions referred to in para 
5.15.2 should not be passed through the regular monthly accounts or appear in the Statement of Central 
Transactions, nor should the opening balances be corrected with a foot note. But a full account of such adjustments 



under an account named "Prior Period Adjustment Account" should be submitted with the material for the Union 
Govt. Finance Accounts. [Annexure C to this Chapter provides illustration with Part I containing three different 
examples falling under this account. Part II indicates the manner in which the first example is to be reflected in the 
material for the affected statements for Finance Accounts, and part III indicates entries generated by the said first 
example in the computation of closing balance of "Government Account" entering material for the Summary of 
Balances (Statement No. 5) of the Finance Accounts. 

The effects of these adjustments should be incorporated in the material for relevant statements of Finance Accounts 
distinctly in a separate line under the opening balance of the concerned minor head below the relevant major head, 
with the nomenclature "Prior Period Adjustment Account". The net effect of these adjustments on "Government 
Account" would have to be worked out for arriving at the balance as on 31st March, thereunder, for purposes of 
insertion against this head in the material for Statement No. 5 Finance Accounts. 

Annexure - A 

(Refer Para 5.7.2) 

Procedure for consolidation of Controller accounts on Computer. 

PART-I :    Checks to be exercised to ensure reconciliation between the figures of the Pr. AO and PAOs. 

1.    The proof sheet (summary of Grant-wise, Category-wise, Major-Headwise totals) appearing at the end of the 
PAO accounts is to be compared with the proof sheet (Control Totals) as printed through the computer. 

This check is exercised to ensure that the grant-wise, category-wise, major head-wise figures are exactly the same as 
indicated by the PAO in the proof sheet- besides the totals tallying there should not be an interchange between Plan 
and Non-Plan, voted and charged between figures appearing in the PAOs proof sheet and the computer generated 
control totals. 

Two copies of this verified control totals should be prepared. One copy is to be retained in the Pr. AO for record and 
the other duly signed by the Pr.A.O. should be sent to the CGA's office alongwith the floppy containing the 
consolidated accounts. 

(2)    To ensure accurate classification below major head level - every quarter a progressive PAO-wise account 
should be generated through the computer and despatched to the PAOs for confirmation. Corrections, if any, will be 
incorporated as per procedure indicated in Annexure-A-Part II. 

At the close of the March accounts, only the last quarter's reconciliation remain. Corrections, if any, for this quarter 
can be incorporated in one of the supplementary accounts and communicated to the office of the CGA on floppies as 
in the case of normal monthly accounts. 

A certificate signed by the Pr. AO indicating that the figures for the quarter have been tallied with the PAOs, is to be 
sent to the CGA's office along with the accounts for the month following the end of the quarter. (The certificate for 
the quarter ending June will be sent in August along with the July accounts). 

PART-II :    Procedure for carrying out corrections in the Controller's Monthly accounts. 

Corrections to the transactions of the previous months will be incorporated in the current monthly accounts by the 
PAOs concerned. These corrections will be entered through 'CONTACT' like normal transactions at the end of 
PAO's accounts. A list of these PAO-wise/ month-wise corrections carried out will be forwarded along with the 
accounts. No manually prepared correction cards will be sent to the office of the CGA. 

PAOs accounts which have been excluded from the preceding month's accounts will be entered in the following 
month. Details of such accounts should be forwarded along with the floppy. 

PART-III :    Contents of the forwarding letter of the Monthly accounts. 

The forwarding letter accompanying the floppy containing the monthly accounts should invariably contain: - 



1.    A certificate to the effect that the grant-wise , category-wise and major head-wise figures of each PAO have 
been compared with the proof sheet attached by the PAOs at the end of the booklet; 

2.    A list of PAOs which have been excluded from the monthly accounts; otherwise a 'NIL' statement; 

3.    PAO-wise, month-wise details of accounts pertaining to previous months included in the present month or a 
'NIL' statement. 

4.    PAO-wise, month-wise details or corrections to the accounts of preceding months which have been carried out 
in the present month. 

ANNEXURE `B' 

(Para 5.12.1) 

ILLUSTRATIVE EXAMPLE LEADING TO PREPARATION OF "SUMMARY OF BALANCES" 

1.    DATA FOR THE ILLUSTRATION 

Supposing transactions arising during 1990-91 are as at (a) to (f) below, receipt of balances on `proforma' basis as 
per Para 16.4 of Chapter 16 of this Manual as at (g), and opening balances as on 1.4.90 as at (h) below: 

(a) Receipts (Revenue) received during the year : 

April, 1990  3460 

May,1990 3461 

Feberuary,1991 3459 

March,1991 (including supplementary)  3463 

Progressive Total (including JEs)  13843 

 Total of Sectors A+B in the S.C.T. to be carried to Government Account[Form CAM-42] 

(b) Expenditure (Revenue) incurred during the year 

April,1990 3353 

May,1990 3352 

February,1991 3354 

March,1991 (including Supplementary & JEs)  3355 

(Progressive Total (including JEs) 13414 

Total of sectors A+B+C+D in the S.C.T. carried to a Government Account [Form CAM-42]     



(c) Expenditure (Capital) incurred during the year 

April,1990   560 

May,1990   561 

February,1991   559 

March,1991 (including Supplementary)   563 

Progressive Total (including JEs) 2243  

Total of Sectors A+B+C+D in the S.C.T. carried to Government Account [Form CAM-42] 

(d) DDR Transactions (Receipts) during the year : 

Sector April,90 May,90 February, 
91 

March,91 
(including JEs etc.) 

Progressive total (including JEs)  
as per SCT under respective sector carried to 

Sector-wise Ledger Form CAM -41 

E 4602 4601 4603 4602 18408 

F 572 573 571 572 2288 

I I 816 817 816 818 3267 

J 151 151 153  151 606 

K 583  584 585 583 2335 

L 105 106 105 107 423 

M 16 16 16 16 64 

TOTAL 6845 6848 6849 6849 27391 

  

(e) DDR Transactions (Payments) during the year : 

Sector April,90 May,90 February, 
91 

March,91 
(including JEs etc.) 

Progressive total (including JEs)  
as per SCT under respective sector carried to 

Sector-wise Ledger Form CAM -41 

E 3374  3373 3375 3374 13496 



F 1038 1040 1038 1039 4155 

I 459 458 459 461 1837 

J 126 127 126 126 505 

K 555 556 555 556 2222 

L 173 172 175 174 694 

M 40 40 41 41 162 

TOTAL 5765 5766 5769 5771 23071 

  

(f) DDR heads closed to Government (RBD in this case) appearing on debt side : 

April,90 May,90 February,91 March,91 Progressive total (including JEs) figure appearing  
in SCT against the head 8675-RBD carried to Government Account 

[Form CAM-42] 

627 630 626 623 2503 

(g)    During the year balances were received by the Pr.A.O. on `proforma' basis from another such office as follows 
:- 

Debit balance of Rs.80 crores under Sector F(Loans & Advances), and of Rs.5 crores under Sector L (Suspense & 
Misc., other than Major Heads 8675 and 8680) and Credit balance of Rs.21 crores under Sector I(Small Savings, 
P.F. etc). and of Rs.7 crores under Sector K (Deposits & Advances). 

(h)    Closing balances under various DDR heads of the preceding year (i.e. as on 31.3.1990) which would be 
opening balances as on 1.4.1991 are as follows :- 

In Pr.A.O. books     In CGA's books     

  Dr. Cr.   Dr. Cr. 

Govt. Account 15184 --       

E. Public Debt -- 23068 E. Public Debt -- 23068 

F. Loans & Advances 17920 -- F. Loans & Advances 17920 -- 

      Contingency Fund -- 50 

I. Small Savings & P.F. etc. -- 7699 I. Small Savings & P.F. etc. -- 7699 

J. Reserve Funds -- 1027 J. Reserve Funds -- 1027 



K. Deposits & Advances -- 1743 K. Deposits & Advances -- 1743 

L. Suspense & Misc. (except 8675 & 
8680) 

405 -- L. Suspense & Misc. (except 8675 & 
8680) 

405 -- 

M. Remittances 28 -- M. Remittances 28 -- 

      N. Cash Balance 15234 -- 

  33537 33537   33587 33587 

Notes : (1)    For purposes of simplicity of the illustration, break up of figures has not been indicated under the 
sectors F,J,K & L into categories as follows as normally required in the summary of balances (Statement No.5 of 
Finance Accounts). 

Sector Categories 

(i) Loans & Advances to State & U.T. Governments F. Loans & Advances 

(ii) Other Loans 

(a) Reserve Funds bearing interest 
Gross balance 
Investment  

J. Reserve Funds 

(b) Reserve Funds bearing interest 

(a) Deposits bearing interest 

Gross balance 

Investment 

(b) Deposits not bearing interest 

K. Deposits & Advances 

(c) Advances 

(a) Coinage Accounts 

(b) Suspense Gross balance Investment 

L. Suspense & Miscellaneous 

(c) Other Accounts 
Gross balance 
Investment 
Accounts with Govts. of Foreign countries 

Note : (2)     In the illustration, for the sake of simplicity, all figures are shown in crores of rupees only, though these 
documents are to be prepared up to unit of rupee and transactions under (a) to (f) of the data are shown as though 
they occurred during 4 months only. 

Note : (3)    For the sake of simplicity in the illustration, the transactions/balances in only one Pr.A.O. and its effect 
reflected in the CGA's office are indicated though the portion of the data showing receipt of balances on `proforma' 
basis during the year from a different Pr. Accounts Office presupposes the existence of another Pr. Accounts Office 
whose balances should have also formed part of the balances held in the books of the CGA but not specifically 
indicated in the illustration. 



Note : (4)    For the sake of simplicity, it has been assumed that the entire balance under `PSB Suspense' has been 
cleared and transferred to the head `8675-Deposits with Reserve Bank' by the Pr.A.O., before close of the accounts. 

II.    SECTORWISE ABSTRACT (LEDGER) OF DDR HEADS CLOSING TO BALANCE COMPUTATION OF 
"GOVERNMENT ACCOUNT" AND STATEMENT OF "SUMMARY OF BALANCES". 

The above documents as in the books of Pr.A.O. and the last one as in the books of CGA adopting the assumed data 
are as shown in CAM-41,42 & 43 and Summary of Balances. The figures adopted by the Pr.A.O. on `proforma' 
basis are shown distinctly in italics in these forms for early tracing. 

ANNEXURE`C' 

(Referred to in para 5.15.3) 

Illustrative Example 

PART I.    Prior Period Adjustment Account 

  

Sl. 

No. 

      

1. Dr. 
0.10 
crore 

7601-Loans and Advances to State Government 
-Loans for Central Plan Schemes 
-Fisheries-Inland Fisheries  

To 
Government Account Reasons for the `P.P.A.A.':- 
Decision of Govt. vide sanction No. ........dated to treat a grant-in-aid of Rs.0.10 
Crore (booked to head `3601' which is closed to Govt. Account) given to State `A' 
during 1981-82, as a loan with retrospective effect. (This will affect material for 
Statements No.13, 15 &5). 

   

   

Cr. 0.10 
Crore 

2. Dr. 
33 
Crores 

7053-Loans for Civil Aviation 
-Aerodromes and Air Route Services 
To 
Government Account Reason for the `P.P.A.A.' :- 
Decision of Government to book expenditure on debentures to a loan head instead 
of to the investment head (viz. Major Head 5053 which is closed to Govt. Account) 
as was the earlier practice. (This will affect material for Statements No.10, 13 & 5). 

   

Cr. 33 
Crores 

3. Dr. 
12 
Crores 

4858-Capital outlay on Engineering Industries and Ship building Industries. 
04-Ship building Industries 
To 
4858-Capital outlay on Engineering Industries 
05-Aircraft Industries 
Reasons for `P.P.A.A.'. :- 
Decision of Govt. to book outlay on investment in Garden Reach Ship builders and 
Engineers Ltd. to the former head instead of to the latter head as was the earlier 
practice. Both the heads affected close to Govt. Account. 
(This will affect material for Statement No.10 only but will not affect `Government 
Account'). 

   

Cr. 12 
Crores 
(minus 
debit) 

Part II -    Entries relating to Serial No.1 of Part I 

  



  Amount On 
1-4-00 

Receipts Disbursements Account as on 31-3-01 

(a) Entries under material for Statement No.15 of Finance Accounts, 1986-87 

Dr. O1  

Dr. P1  

7601-Loans and Advances to State 
Governments Prior Period Adjustment 
Account 

0.10 crore 

R1 D1 O1+P1+D1-R1  
=0.10 crore 

(b) Entries under material for Statement No.17 of the Finance Accounts 

7601-Loans and Advances to State 
Governments -State of 'A'   

        

-C Loans for Central Plan Schemes         

-Fisheries-Inland Fisheries O2 P2 R2 D2 O2+P2+D2+R2+Rs.0.10 

crores 

Prior Period Adjustment Account 0.10 crore       

Part III -    Entries for Computation of closing balance of GOVERNMENT ACCOUNT as on 31.3.01 on account of 

Serial No.1 of Part I. 

FORM CAM 42 

Sector   Dr. Cr. 

  Opening balance as on 1.4.00 (excluding the Prior 
Period Adjustment Account) 

0   

  Net effect of Prior Period Adjustment Account     33.10 

  Adjusted Opening balance as on 1.4.00  0-33.10    

A + B   Receipts(Revenue)      

A+B+C+D Expenditure(Revenue)     

A+B+C  Expenditure(Capital)       

G(M.H.7999) L(M.H.8675 & 

8680) 

D.D.R. Heads(closed to Govt. Account).       

  Net effect of balances adopted/ transferred proforma 
reversing its side  

    



  Total   O+T1 T2+33.10 

  Closing balance transferred to Summary of balances O+P+T1+T2 
-33.10 

  

O = Opening Balance 
P = Prior Period Adjustment Account 
T1 = Total under Col. Dr. excluding (a) Opening balance and (b) Prior Period Adjustment Account. 
T2 = Total under Col. Cr. excluding figures relating to net effect of balances adopted/transferred proforma and also 
excluding Prior Period Adjustment Account. 

[Authority : 1(14)/83/TA and 1(14)/86/TA] 

 

 

Advanced Accounting  

Chapter 5: A Voucher System  

• An accounting system includes procedures for recording and reporting accurate and up-to-date financial info • 

Should also include procedures to assist management in controlling daily operations • Cash is the asset most likely 

to be misused because its ownership is easily transferred • Ways to control cash: store in a safe place, make deposits 

regularly, approve all cash payments • Voucher: a business form used to show an authorized person’s approval for a 

cash payment • Voucher system: a set of procedures for controlling cash payments by preparing and approving 

vouchers before payments are made • In a voucher system, NO check can be issued without a properly authorized 

voucher  

Section 1: Vouchers and Voucher Registers  

• When receive an invoice, a verification form is stamped on the invoice – this verification form is then filled in as 

the steps are completed • Each person doing a part of the work places a check mark next to the item verified and 

initials the verification form to show responsibility for that part • After an invoice is checked for accuracy, a 

voucher is prepared for each invoice received from a vendor • When a voucher system is used, the source document 

for an approved cash payment is the voucher • Instead of Accounts Payable use Vouchers Payable.  • Also do not 

use an Accounts Payable ledger instead use an unpaid vouchers file • In a voucher system, Vouchers Payable is 

used to record ALL amounts to be paid by check not just amounts of items bought on account • The normal balance 

is on the credit side of Vouchers Payable • Unpaid vouchers file shows all amounts owed and to whom they are 

owed • A form is printed on the outside of a voucher to summarize the contents and provide space for approving 

payments • After the invoice is summarized on the voucher, the voucher is folded so that related documents can be 

placed inside – sometimes called a voucher packet • Prenumbered vouchers serve as an additional control within the 

voucher system  

• Five areas to record info:  

1. Payee Info 2. Accounts affected info 3. Voucher approval 4. Info about where voucher is recorded 5. Payment 

info  

• Sections 1-3 are completed at the time the voucher is prepared • Section 1 – Payee Information o Use verified 

invoice to enter info, discount due date is calculated using the date the invoice is dated.  o Most checks received 



within 2 days so payment date is 2 days before the discount due date.  o After section 1 completed the voucher 

number is recorded on the invoice’s verification stamp • Section 2 – Accounts Affected:  o Section 2 lists preprinted 

account titles for accounts most often affected by cash payments o Only the amount of the invoice needs to be 

entered in Section 2 o Total debits and credits must be calculated and entered • Section 3 – Voucher Approval o As 

a double check, certain people are authorized to approve vouchers before they are journalized o Approve it be 

signing name in this section • After a voucher has been approved, it is recorded in the voucher register – similar to 

and replaced the Purchases journal • A missing voucher number shows that a voucher has not been recorded • 

Voucher registers have special columns: Vouchers Payable –credit, Purchases – debit, Supplies debits for the 

different types of supplies, everything else is recorded in the general columns with the name of the account listed • 

Section 4 – When the Voucher is Recorded  o Person who record the voucher in the register also does this section o 

Person indicates what page the info is recorded in the voucher register o Person also initials the space on the 

voucher • After voucher journalized and noted in section 4, the voucher is filed in the unpaid vouchers file. • Placed 

in file in order of payment due date • Separate accounts recorded in the General Debit and Credit columns of a 

voucher register are posted individually during the month  

• Totals of the special columns in the voucher register are posted to the general ledger accounts.  

Section 2: Voucher Check and Check Registers  

• Businesses pay each voucher by check • Check and voucher are presented to a person authorized to approve 

payment • Voucher check: a check with space for writing details about a cash payment • Prepare checks in duplicate 

– original to the payee and other kept as the source document for the transaction • Recording the details of on a 

voucher check: record voucher #, payee’s invoice number, amount of invoice, amount of discount, net amount that 

check is written for • Payee keeps the detachable portion of the voucher check for their records • Section 5 – 

Payment of a Voucher o Person who prepares the check also completes this part of voucher o Notes the date paid, 

the check number, and the amount o After verification of correct info, sign the check and initials this section • 

Person who prepares the check also usually records the info needed into the voucher register • Date voucher paid 

and check number are written in the Paid columns of the voucher register – on the same line as the original entry for 

the voucher • Check is sent to the payee and the voucher is filed in the paid vouchers file according to the name of 

the vendor • Check register: a journal used in a voucher system to record cash payments • Check register is similar 

to and replaces a cash payments journal • Use a check register to maintain the checking account balance • Two 

“bank” columns in the check register – one to keep a running balance and the other is to indicate deposits made • 

Only three general ledger accounts are impacted by a cash payment: Vouchers Payable debit, Purchases Discount 

credit, and Cash credit. • Each check recorded as a debit to VP and credit to Cash. Only will use the Purchases 

Discount if there was a discount taken • At the end of the month the special columns are totaled and posted. NO 

separate amounts are posted because no general debit or credit columns • Two “Bank” columns are NOT totaled, 

ruled, or posted • Cash is proved if the last amount in the Balance column of the check register equals the balance in 

the general ledger cash account • Starting a New Page in a Check Register:  

o During the month – totals of VP, PD, Cash, and the Bank Balance are brought forward. No amount is brought 

forward for Bank Deposits o At the beginning of the month – only the Bank Balance is brought forward because 

special amount totals have already been posted  

Section 3: Selected Transactions in a Voucher System  



• A purchases returns and allowances transaction reduces the total amount owed for an invoice • Changing the 

Original Amount of a Voucher because of a Purchase Return  

1. Remove the original voucher from the unpaid vouchers file.  2. Write Canceled across the Section 5 3. Prepare a 

new voucher 4. Place the canceled voucher and the debit memorandum (which indicates the PRA) inside the new 

voucher 5. In the voucher register, on the same line as the original voucher, write See Vchr # (of the new voucher) 

in the Paid columns.  6. Record the new voucher on the next available line of the voucher register 1. Enter the new 

voucher amount in the Vouchers Payable credit column 2. Write the title Vouchers Payable in the General account 

title column on the same line as the new voucher and debit it in the General Debit column for the amount of the 

canceled voucher 3. On the next line below Vouchers Payable in the General account title column, write Purchases 

Returns and Allowances and credit it for the amount of the discount in the General Credit column  

7.  File the new voucher by its payment date in the unpaid vouchers file. The payment date is based on the terms of 

the original invoice – so the new voucher has the same due date as the canceled voucher  

• Recording Payroll in a Voucher Register  o Information from a payroll register is used in preparing a voucher for 

payroll o A payroll register is needed for several purposes, so it can NOT be placed inside a voucher for payroll. 

Instead, it is summarized on the inside of the voucher  

o The inside allows additional space so that more detailed info about the transaction can be noted o Outside of the 

voucher is completed as normal o On the left side of the Voucher Register write the date of the payroll and the word 

“Payroll” under the Payee column, then enter the amount of the check to be written for the payroll in Vouchers 

Payable credit o On the right side of the Voucher Register write the Salary Expense for each department (debits), 

and all of the Taxes that are credited • An entry also has to be made to the General Journal to record the employer’s 

payroll taxes – just like from Chapter 3 • Later when the payroll taxes are due, vouchers are prepared, approved and 

paid. • One is prepared for state and one for federal taxes • Advantages of the voucher system o Only a few people 

can authorize and approve payments. Helps protect and control cash o A voucher jacket provides a convenient way 

to file invoices and related business papers for future reference o Unpaid vouchers are filed by their payment dates 

to help ensure prompt payment  o An unpaid vouchers file and a paid vouchers file eliminate posting to an accounts 

payable ledger o A paid vouchers file provides three different and easy ways to find info about a paid voucher  If 

know voucher #, look in the voucher register  If know check #, look in the check register  If know the payee name, 

look in the paid vouchers file under 

 

 

What’s the difference between a bill (or invoice) and a statement? Let’s face it – the English language can 

sometimes be imprecise. You get a cell phone bill, but you get a credit card statement. Both itemize the charges 

made to you – so which one is it, a bill or a statement? While we can’t make the English language any better, we 

can at least shed some light on the distinction between bills (or invoices) and statements as they relate to TurboLaw 

Time and Billing. Click to download a no-obligation 30 day free trial of TurboLaw Time and Billing. In TurboLaw 

Time and Billing, a bill (also called an invoice) is just what you’d think it is – an itemized list of work done for the 

client, and how much they owe you for it. For example, a bill might have the following items on it: Spent 3 hours in 

court: $450.00 Travel expenses to meet with client: $75.00 On-site meeting: $250.00 TOTAL DUE: $775.00 Not a 

lawyer or legal professional, but still want a simple, billing system that anyone can use? Try Instant Invoice free for 

30 days. This is like a bill or invoice that you might get when you purchase something. We tend to call it a “bill” 



because you “bill” for your services, while you get an “invoice” for goods – but in practice the two terms are 

generally interchangeable. A bill doesn’t say anything about money that might have already been paid – it simply 

lists the work or expenses you’ve done and how much they total up to. On the other hand, a statement in TurboLaw 

Time and Billing is a “statement” of the status of the client’s account at a particular point in time. Each line item on 

a statement represents either a bill or a payment. As such, it doesn’t offer as much detail as a bill – but it does show 

payments made towards the account. Statements are often sent out on a regular basis (e.g., monthly – like your 

credit card statement) to show your clients where they stand (and if they still owe you any money). For example, a 

statement might have the following items on it: Balance forward: $85.67 Bill #123: $290.00 Payment #82: $50.00 

TOTAL BALANCE: $325.67 This shows that the client had a balance due of $85.67 from before the period of this 

statement (if you send out statements monthly, your statement period is usually “the last 30 days”) and that in that 

time, a bill for $290 was produced, but the client sent in a payment of $50, resulting in a final balance due of 

$325.67. To see a sample bill and statement, click on the images below.  

Accounting software comes prepacked with standard invoice forms. 

Some programs let you customize the invoice design; for others, you're stuck with the layout they supply. All of 
them, though, will print your company name, address, and phone number on the top of the invoice, and some even 
allow for artwork (such as company logos). Invoices created by accounting software are automatically numbered in 
sequence, unless you manually override the invoice number. They also automatically include all pertinent customer 
information, including the bill to and ship to addresses, contact name, and details of the sales transaction. 

Manual invoices require a little more work on your part, whether you create them on your computer or use 
preprinted manual invoices (available from most stationery stores or print shops). You have to fill in all of the 
customer information, as well as the details of the sale. Be extra careful with your math, especially when it comes to 
calculating any applicable sales tax; if you don't charge the customer enough, your company will take the loss. In 
addition, make sure you have a copy of every invoice somewhere, whether you save it on your computer or make a 
photocopy before handing it over to the customer. 

Preparing Monthly Statements 

A basic customer statement looks like a numeric grocery list: it contains every invoice number, total sales amount, 
payment received — basically a quick review of the month's activity without all the cumbersome detail. At the top, 
your company name and mailing address must appear (even if you enclose a preprinted self-addressed envelope), as 
well as the name and billing address of your customer. 

Customer statements are created automatically by most accounting programs; all you have to do is request them. 
You may have several print options, such as not printing any zero or credit balance accounts, or not printing any 
accounts without activity. While it can be much more efficient to skip over the accounts with no current activity, it's 
a good idea to print zero and credit balance accounts that have had activity during the period. Even though you 
probably won't mail them, you can still look at them to make sure they appear correct. 

Why should I include a self-addressed envelope? 

Customers will pay you more quickly when their bills come with payment envelopes. It's a lot easier to stick a check 
in a ready envelope than to bother with a blank one. Also, you'll avoid address errors. 

With a manual system, you create statements for each customer based on the current information in your accounts 
receivable subledger. Each ledger page contains at least summary information of every invoice, payment, and credit 
transaction that's occurred during the month. That summary information is all you need on the statement, which is 
really just a listing of the monthly activity culminating in a total balance due. 

PART 1304 — RECORDS AND REPORTS OF REGISTRANTS 

GENERAL INFORMATION 



§1304.04 Maintenance of records and inventories.  

(a) Except as provided in paragraphs (a)(1) and (a)(2) of this section, every inventory and other records required to 
be kept under this part must be kept by the registrant and be available, for at least 2 years from the date of such 
inventory or records, for inspection and copying by authorized employees of the Administration. 

(1)Financial and shipping records (such as invoices and packing slips but not executed order forms subject to 
§§1305.17 and 1305.27 of this chapter) may be kept at a central location, rather than at the registered location, if the 
registrant has notified the Administration of his intention to keep central records. Written notification must be 
submitted by registered or certified mail, return receipt requested, in triplicate, to the Special Agent in Charge of the 
Administration in the area in which the registrant is located. Unless the registrant is informed by the Special Agent 
in Charge that permission to keep central records is denied, the registrant may maintain central records commencing 
14 days after receipt of his notification by the Special Agent in Charge. All notifications must include the following: 

i) The nature of the records to be kept centrally. 

(ii) The exact location where the records will be kept. 

(iii) The name, address, DEA registration number and type of DEA registration of the registrant whose records are 
being maintained centrally. 

(iv) Whether central records will be maintained in a manual, or computer readable, form. 

(2)A registered retail pharmacy that possesses additional registrations for automated dispensing systems at long term 
care facilities may keep all records required by this part for those additional registered sites at the retail pharmacy or 
other approved central location. 

(b) All registrants that are authorized to maintain a central recordkeeping system under paragraph (a) of this section 
shall be subject to the following conditions:  

(1) The records to be maintained at the central record location shall not include executed order forms and 
inventories, which shall be maintained at each registered location.  

(2) If the records are kept on microfilm, computer media or in any form requiring special equipment to render the 
records easily readable, the registrant shall provide access to such equipment with the records. If any code system is 
used (other than pricing information), a key to the code shall be provided to make the records understandable. 

(3) The registrant agrees to deliver all or any part of such records to the registered location within two business days 
upon receipt of a written request from the Administration for such records, and if the Administration chooses to do 
so in lieu of requiring delivery of such records to the registered location, to allow authorized employees of the 
Administration to inspect such records at the central location upon request by such employees without a warrant of 
any kind. 

(4) In the event that a registrant fails to comply with these conditions, the Special Agent in Charge may cancel such 
central recordkeeping authorization, and all other central recordkeeping authorizations held by the registrant without 
a hearing or other procedures. In the event of a cancellation of central recordkeeping authorizations under this 
paragraph the registrant shall, within the time specified by the Special Agent in Charge, comply with the 
requirements of this section that all records be kept at the registered location. 

(c) Registrants need not notify the Special Agent in Charge or obtain central recordkeeping approval in order to 
maintain records on an in-house computer system.  

(d) ARCOS participants who desire authorization to report from other than their registered locations must obtain a 
separate central reporting identifier. Request for central reporting identifiers will be submitted to the ARCOS Unit. 
See the Table of DEA Mailing Addresses in Sec. 1321.01 of this chapter for the current mailing address.  

(e) All central recordkeeping permits previously issued by the Administration expired September 30, 1980. 

(f) Each registered manufacturer, distributor, importer, exporter, narcotic treatment program and compounder for 
narcotic treatment program shall maintain inventories and records of controlled substances as follows: 



(1) Inventories and records of controlled substances listed in Schedules I and II shall be maintained separately from 
all of the records of the registrant; and 

(2) Inventories and records of controlled substances listed in Schedules III, IV, and V shall be maintained either 
separately from all other records of the registrant or in such form that the information required is readily retrievable 
from the ordinary business records of the registrant. 

(g) Each registered individual practitioner required to keep records and institutional practitioner shall maintain 
inventories and records of controlled substances in the manner prescribed in paragraph (f) of this section.  

(h) Each registered pharmacy shall maintain the inventories and records of controlled substances as follows:  

(1) Inventories and records of all controlled substances listed in Schedule I and II shall be maintained separately 
from all other records of the pharmacy.  

(2) Paper prescriptions for Schedule II controlled substances shall be maintained at the registered location in a 
separate prescription file.  

(3) Inventories and records of Schedules III, IV, and V controlled substances shall be maintained either separately 
from all other records of the pharmacy or in such form that the information required is readily retrievable from 
ordinary business records of the pharmacy.  

(4) Paper prescriptions for Schedules III, IV, and V controlled substances shall be maintained at the registered 
location either in a separate prescription file for Schedules III, IV, and V controlled substances only or in such form 
that they are readily retrievable from the other prescription records of the pharmacy. Prescriptions will be deemed 
readily retrievable if, at the time they are initially filed, the face of the prescription is stamped in red ink in the lower 
right corner with the letter "C" no less than 1 inch high and filed either in the prescription file for controlled 
substances listed in Schedules I and II or in the usual consecutively numbered prescription file for noncontrolled 
substances. However, if a pharmacy employs a computer application for prescriptions that permits identification by 
prescription number and retrieval of original documents by prescriber name, patient's name, drug dispensed, and 
date filled, then the requirement to mark the hard copy prescription with a red "C" is waived.  

(5) Records of electronic prescriptions for controlled substances shall be maintained in an application that meets the 
requirements of part 1311 of this chapter. The computers on which the records are maintained may be located at 
another location, but the records must be readily retrievable at the registered location if requested by the 
Administration or other law enforcement agent. The electronic application must be capable of printing out or 
transferring the records in a format that is readily understandable to an Administration or other law enforcement 
agent at the registered location. Electronic copies of prescription records must be sortable by prescriber name, 
patient name, drug dispensed, and date filled.  

 

LESSON 2: IMPLEMENTING FINAL ACCOUNTS IN TALLY  

CONTENTS: 2.0. Aims and objectives 2.1. Introduction 2.2. Creation of Ledger 2.3. Final Statements – 

Introduction 2.4. Final Accounts and Tally 2.5. Profit and Loss Account 2.6. Balance Sheet 2.7. Let us Sum Up 2.8. 

Lesson end activities 2.9. Points for Discussion 2.10. Suggested Reading / References / Sources  

2.0. AIMS AND OBJECTIVES When you have completed this lesson, you will be able to: Ø Apply control 

ledgers, Display Reporting Ø Setup menu for Final Accounts Ø Consolidate various option of configuration and 

explore reports using them.  

2.1. INTRODUCTION  

After the creation of necessary masters, you should proceed with the ledger creation.  Ledger account heads are the 

actual account heads to which we identify the transactions i.e., passing of all vouchers using ledgers.  Hence, a 

thorough understanding of account classification is important for working with ledgers.  



Tally creates the following two ledgers on its own and the other ledgers should be created by you.  (i) Cash under 

Cash-in-had group, (ii) Profit & Loss Account under Primary Ledger.  

When you create a new company where Books beginning from and Financial Year From date are the same,  you 

should create all the ledgers appearing in the Balance Sheet as at the previous date with opening balance.  Also 

create ledgers appearing in Profit & Loss Account but with zero (0) opening balances unless Books Beginning 

From date is different than Financial Year From.  

2.2. CREATION OF LEDGER  

Before creation of Ledgers, you must configure the account masters as shown below:  

Configure (F12);  
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Fig. 2.1  

Accounts/ Inventory information -> Account Masters -> Allow Advanced Entries in Masters, Addresses, etc., -> 

Yes  

Process of Creation Ledger    

Fig. 2.2   
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Fig. 2.3 To Create Account Ledgers Individually select Create from Single Ledger under  

Accounts Info -> Ledgers -> Create  

The result will be as follow:   

Fig. 2.4.   
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1. Name Here, enter the name of the ledger. Tally will not accept same names. 2. Under Under this option, you 

should select the group from the list of groups that will be displayed along with the ledger creation screen. 3. 

Inventory values are affected This option should be given ‘Yes’ for those ledgers which will affect the inventory 

position of the company.  For example, Purchase, Purchase Returns, Sales, Sales Returns, etc. 4. Maintain balances 

Bill-by-Bill To get this option give ‘yes’ to Maintain Bill-wise details in Company Features – F11.  This option is 

useful only for Sundry Debtors and Creditors.  It can also be used where some tracking is needed like Project-2ise 

Expenses or income, installments due, installment – wise outstanding details. Enter due date of the bill or credit 

days under the option default credit period. 5. Effective date for reconciliation This is the date from which you can 

reconcile your bank account with the bank statements. 6. Opening Balance Enter the opening balance of the 

respective ledger account as on the date of Books Beginning From option in Company Creation screen. 7. Mailing 

and Related Details Tally by default carries the ledger name here.  You can also enter any other mailing name as 

you wish.  This name is printed in all external documents. i.e., other than internal reports, books of accounts, etc. 

The Address Details, Income tax Number, Sales Tax Number, the person to whom you should contact should be 



given in the respective menus.  This option is available only for parties’ accounts (Capital, Sundry Debtors and 

Creditors).  

Further, you can also give the Telephone number, Details regarding Fax and the E-mail address.  

We can also add Notes for ledger account.  This option is available for all ledgers.  This is useful to add remarks or 

notes about the ledger like the credit worthiness of the party.  

Specifying closing stock values When you are creating stock-in-hand you will be able to specify only the opening 

stock.  Closing stock value can be specified if you choose the ‘No’ option for ‘Integrate Accounts with Inventory’ 

under the Company Features option (F11).  
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Another way of specifying the closing stock value is  

 Accounts Info -> Ledgers -> Alter    

Fig. 2.5.   

Display / Alteration of Individual ledger (Refer Fig. 2.5)    

Fig. 2.6. Select ‘Alter from Single Ledger’ to get list of Ledgers from which you may select the ledger to carry out 

desired modification and save by pressing <Ctrl> + <A>.  

To Delete, select the ledger in Alteration mode, press <Alt> + <D> and respond with Yes to confirm deletion.  

However, if the ledger is transacted in any voucher, the message would not appear and you cannot delete the ledger.  

Accounts Info -> Ledgers -> Display / Alter   

Creation / Display / Alteration of Multiple Legers   
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You can also create many ledger accounts on a particular group at a single time.  This option would be useful when 

you create many accounts under one group like different expenses (Rent, Salary, Interest, Commission et.) under 

the group Indirect Expenses.  

We can also alter many accounts simultaneously using multiple ledgers’ alteration menu.  

2.3. FINAL STATEMENTS: INTRODUCTION  

A financial statement is an organized collection of data according to logical and consistent accounting procedures.  

Its purpose is to convey an understanding of some financial aspects of a business firm.  It may show a position at a 

moment of time as in the case of a Balance Sheet or may reveal a series of activities over a given period of item, as 

in the case of a Income Statement.  

Generally, a business may have many financial statements. The following are the two basic financial statements – 

(i) The Income Statement; and (ii) the Balance Sheet.  

Income Statement (also known as Profit and Loss Account) It is considered to be most the useful of all financial 

statements.  It explains what had happened to a business as a result of operations between two balance sheet dates.  

For the purpose, it matches revenues (incomes) and cost (expenses) incurred in the process of earning revenues and 

shows the gross profit and the net profit earned or loss suffered during a particular period.  



Income statement is a summary of accounts that affects the profit or loss of an enterprise.  Many accounts shown in 

the trial balance relate to expenditure or income, these accounts either increase or decrease the profit.  The accounts 

that increase the profit are shown in the credit side and the accounts that decrease the profit (losses and expenses) 

are shown in the debit side.  The difference between the two sides is either profit or loss.  Income statement has two 

parts, namely  

1. Trading Account 2. Profit and Loss Account  

2.4. FINAL ACCOUNTS AND TALLY  

Final account depicts the summarized position of the activities, performance and state of affairs of the business. 

Naturally, these reports from the essence of the business.  Anyone associated with the company must be quite 

curious to get these reports.  

One of the major advantages of Tally is its report generation.  Using Tally’s display option, you can get the desired 

reports easily.  It provides excellent navigation facilities through buttons at Button bar to jump from one report to 

another without leaving the screen.  Further, you can configure and format the style of a report in your own way, 

decide the columns and contents, etc.  

Based on the voucher that you enter, Tally automatically prepares the books of accounts and financial statements. 

Tally provides you the power to drill down step-by-step, from a top level report until the vouchers that contributed 

the report to verify the integrity, carry out any  
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modification or to add, insert, duplicate, cancel or delete a voucher and the report is updated on- line.  You can also 

alter a Group or Ledger while viewing the report.  

The reports generated by Tally are classified in two major categories, namely  

1. Financial Reports 2. Inventory Reports The financial reports are further divided into: a. Statutory Financial 

Reports ( like Sales Register, Purchase Register, Journal Register, Cash Book, Bank Book, Ledgers, Trial Balance, 

Profit and Loss Account and Balance Sheet). b. Financial MIS reports (like Day Book, Group Vouchers, Group 

Summary, and receivables, Payables, Cost Centre Reports, Ratio Analysis, Cash Flow Statement and Funds Flow 

Statement. Now, we shall see how some of the reports appear in Tally: Trial Balance: In Tally, the Trial Balance is 

displayed as a list of all primary Groups on the left closing Debits and Credits balances on the right. The Trial 

Balance is displayed in grouped form with main groups and their closing balances.  In other words, the Trial 

Balance Report provides account balance listing for all the accounts for the company sorted according to groups.  In 

Tally, the matching of the Trial Balance is a foregone conclusion as all voucher entries are in the debit and credit 

format and must balance at the entry point.  

You can drill down a Group for further details of that particular group or Select Detailed to break down the grouped 

information to another ledger or Select Led-wise to take an alphabetic listing of all ledgers and their closing 

balances or Select Columns to bring up the closing balances for another date.    

Fig. 2.7.   
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Fig. 2.8.    



Fig. 2.9  

Button F4: Group Generally the default Trial Balance will display only primary groups.  If you want to view only 

one group select this button.  From this you can drill down to further details of the sub groups or ledgers.   
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Fig. 2.10 Normally the default Trial Balance is a grouped Trial Balance.  However if you wish to view a Trial 

Balance with only ledgers and their balances, irrespective of which group they fall, you can make use of this option.  

F5: LedWise /Grouped   

Fig. 2.11 To get group vouchers click this button.  This button toggles between vouchers and summary.  
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F7: Vouchers: To configure a trial balance click this button.   

Fig. 2.12   

F12: Configure Show Opening Balance: You should respond Yes to this option to view the Trial Balance in a 

columnar from together with opening balances.  

Show transactions By responding Yes to this option you can view the transaction amounts in a separate column.  

Net Transactions Only Tally by default displays debit and credit transaction figures in separate columns.  To get 

Net balances in a single column set this option to Yes. To get Debit and Credit values in separate columns set his 

option to No.  

The Display screen will show Closing Balances  

2.5. PROFIT AND LOSS ACCOUNT  

The Profit and Loss Account is a statutory report that shows the operational results for a given period of time.  It 

lists out the Incomes and Expenditures based on the Primary Groups of Tally.  The Profit & Loss Account in Tally 

is updated instantly with every transaction voucher that is entered and saved.  No special processing is required to 

produce a Profit & Loss Account.  The following is the syntax to view the Profit & Loss Account:  

Gateway of Tally -> Profit and Loss Account -> <alt> <F1> (to view the profit and loss account in detailed format)  
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Fig. 2.13    

Fig. 2.14  
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Buttons F12 Configure This following screen will appear as soon as you press this button   

Fig. 2.15  

Show Vertical Profit and Loss: To view the Profit and Loss Account in a Vertical form respond with ‘Yes’ to this 

Option.  If you respond with ‘No’ to this option, the Profit and loss Account will be displayed in T Form.  

Show Percentage If you respond with Yes to this Option, you can view the Percentages along with the amounts.  



Show Gross Profit This prompt will appear only if you have responded with No to option Show Vertical Profit & 

Loss.  If Responded with Yes to this option, you will get separate Trading Account showing the Gross Profit or 

Gross Loss.  

2.6. BALANCE SHEET  

The Balance sheet at the Gateway of Tally screen provides redy summary figure still the last voucher entered.  

From here, you ca move on to any direction andy any part of the system, even the lowest level and trace back.  

The following is the syntax for viewing the Balance Sheet  

Gateway of Tally -> Profit And Loss Account -> <Alt> <f1> (to view the profit and loss account in detailed format)   
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Fig. 2.16    

Fig. 2.17  

Buttons F1  
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While ‘Detailed’ displays next level group, ‘Condensed’ displays parent level primary groups.  

If you wish to compare this with the Balance Sheet of another Company or view the Report for Different periods, 

select this button.  

New Column   

Fig. 2.18  

Alter Column This button allows you to alter the parameters of a column that you have already given.  

Del Column This button activates on creation of a new column for deleting a column.  

Auto Column You can click this button when there is a need for multiple period Column etc.    

Fig. 2.19  

F8 Other Reports  Not Functional F9 Inv. Reports This button facilitates the views of inventory reports quickly 

without leaving the current screen.   
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Fig. 2.20  

F10 Acc. Reports Allows to Generate the following Accounting Reports a. Bills payable – Displays all outstanding 

bills b. Bills receivable – Displays all outstanding bills c. Cash/Bank Book – Displays Cash / Bank group summary, 

all gborups and ledgers placed under cash in hand.  Bank Accounts and Bank OCC Groups. d. Cash flow – Displays 

month-wise cash flow summary.  Cost center summary – Displays cost category summary with underlying cost 

centers. e. Day Book _ Displays day Book. f. Funds flow – Displays month – wise funds flow summary. g. Profit 

and loss A/c – Displays profit & loss a/c for the relevant period. h. Purchase order – Displays purchase order 

details. i. i. Purchase Register – Displays purchase register monthly summary. j. Sales order – Displays sales order 



details. k. Sales register – Displays sales register monthly summary l. Statistics – Displays all types of vouchers and 

accounts (masters) with their numbers. F12 Configure   

Fig. 2.21  
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The button allows you to configure the report    

Fig. 2.22  

Show Vertical Balance Sheet: Normally, tally displays Balance Sheet in horizontal form (T-Form) with closing 

balances of Primary Groups of Assets and Liabilities.  If you want vertical format of Balance Sheet with details of 

Sources and Applications of Funds, you should respond with Yes to this query.  In Tally, Balance Sheet can be 

viewed in columnar form only with vertical format.   

Fig. 2.23  

Show Percentage: To get percentage for closing balance of Groups Respond with yes to this option.  I you respond 

so to this query, the values for each Group would be displayed as percentage of the total of Assets and Liabilities.  

Show Working Capital Figures: This option is available for both the formats of Balance Sheet i.e. vertical and 

horizontal.  If you respond with yes to this option, you will get working capital figures.   
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Fig. 2.24  

Method of Showing Balance Sheet The normal format of Balance Sheet is Liabilities / Asset, i.e., the Liabilities on 

the left hand side and Assets on the right hand side.  If you want the Liabilities on right hand side and Assets on the 

left hand side you can configure so in Tally. 

 

3 INTRODUCTION TO TALLY 

Creating Company → Step 1: Select 'Create' company option from Company Info. Menu either by pressing C or by 

clicking on this option. The following screen will appear. 

The above screen shows various fields. These are:- i) Directory → It asks you for the path where you intend to 

create your company. The default data directory is C:\TALLY\DATA ii) Name → Type the name of the company. 

This name will be displayed in the language in which the company is being created. iii) Mailing Name & Address 

→ Type the full address of your company. This will appear on all the reports. iv) Statutory Compliance for → The 

countries are selected from the given list of countries. The statutory features and Base Currency Symbol are enabled 

in accordance with the country selected. v) State → Select the state from the drop down list of Indian state. vi) PIN 

Code → Type the Postal Index Number. vii) Telephone Number → Type office Telephone No. viii) E-mail Address 

→ Type the E-mail address of the company. ix) Currency Symbol → type Rs. For India. x) Maintain → A window 

with two options pops up. These are :  
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a) Accounts only: → Where businesses do not deal with Inventory e.g. Professional. b) Accounts with Inventory ' It 

maintains both Financial accounts as well as Inventory. xi) Financial Year From → Type the starting date of the 

financial year. Tally considers 12 months from the given date e.g. 01/04/2009 xii) Books Beginning From →The 

date from actual transactions started but this date should be later than the starting date of Financial Year. xiii) Tally 

Vault Password (if any) → If you wish to maintain company data in encrypted form. xiv) Use security Control 

→This feature of Tally sets up authority levels that decides the right of the user for data manipulation. xv) Use 

Tally Audit features → If set to 'yes' the changes in transactions or ledger masters can be tracked. xvi) Base 

Currency Information → a) Base currency symbol → Rs. b) Formal name → Indian Rupees c) Number of Decimal 

Places → 2 d) Show Amounts in Millions? → No e) Is symbol SUFFIXED to Amount → No f) Put a space 

between Amounts and Symbol → No g) Symbol for Decimal Portion → It is paise by default for India. h) Decimal 

Places for Printing Amounts in Words ' Specify the number of decimal places for printing the amounts in words. 

Step 2: Press Enter and accept the screen. Now the company gets created which can be loaded from the Company 

Info. Menu as and when desired. Shutting a Company → It means unloading it. Press [Alt + F3] for Company Info 

menu. Select the option shut company by pressing the hotkey H. Highlight the company you wish to shut down 

from the list of companies and press Enter. Altering / Modifying Existing Company → You can modify, at any 

time, any information given whilst creating the company by Alt + F3 ' Enter. Acompany can be DELETED only in 

the alter mode by pressing Alt + D. 

Buttons on the Button Panel There are underlined and non-underlined buttons on the panel. F1 → Select Company 

F1 → De-activates a company F2 → To Change the date F2 → To change the period F3 → Company - to switch 

from one company to another active company. 
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F3 → This invokes company info menu. F12 → Configure F11 → Features. You can select or modify different 

features of a company. 

When you select Accounting Features option, the following screen will appear. 

- Integrate Accounts and Inventory → If set to 'Yes' will consider the inventory / stock as entered in accounting 

entries. If set to 'No' will ignore the inventory books figures and picks up manually entered closing stock. - Income / 

Expenses Statement Instead of Profit and Loss → If non trading accounts then set to 'Yes'. - Allow Multi-currency? 

→ Accounts can be maintained in more than one currency. - Maintain Bill wise Details ? → It set to 'Yes' will 

enable you to track the invoice wise details of the Debtors and Creditors. (for Non Trading A/cs also ?) →If 

required for other than debtors and creditors e.g. to track the installments of loan. - Activate Interest Calculation → 

Interest can automatically be calculated by Tally based on the specified interest rates and style. (use advance 

parameter) → Useful where interest rates change from time to time. - Maintain Payroll → If set to 'yes' salary 

register can be maintained. - Maintain Cost Centers →Allocation of expenses or incomes is possible. - Use cost 

centers for job costing → To track the expenses and incomes related to particular project. - More than one Payroll / 

Cost Category →More than one Primary cost category. - Invoicing → If set to 'yes' sales entries can be done in 

Invoice format in which taxes and duties are calculated automatically. These entries themselves can be treated as 

'Salebills or Tax Invoices'. 
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- Use Debit / Credit Notes → Set 'yes' if required. - Enter Purchases in Invoice Format → If set to 'yes' purchase 

entries can be done in Invoice format. - Use Invoice Mode for Debit / Credit Notes → Set 'yes' if invoice format is 

required. - Budgets and Scenario Management → - Maintain budgets & Controls - Set 'yes' if required. - Use 

Reversing Journals and optional Vouchers - Entries can be made optional if set to yes. - Other Features - Enable 

Cheque Printing - Set / Alter Cheque Printing Configuration - Allow Zero Valued Entries 

When you select Inventory features option in the above window, you have the following Inventory Features 

Window. 
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Configuring Company → Options: 1) Integrate Accounts and Inventory? → Same as in Accounting features option. 

2) Allow Zero Valued Entries → Set it to 'yes' if you want to permit in vouchers. 3) Maintain Multiple Godowns  → 

If more than one locations are required then set the option to 'yes'. 4) Maintain Stock Categories? → If your 

inventory hierarchy requires categories to be maintained then set this option to 'yes'. 5) Maintain Batchwise Details? 

→ If stock items are required to be stored according to batches then set this option to 'yes'. 6) Set Expiry Dates for 

Batches? → If your goods have expiry dates like medicines and other perishables then this option is set to 'yes'. 7) 

Use different Actual and Billed Quantity? → When goods billed are different than those from actually delivered or 

received then this is set to 'yes'. e.g. one on one free. Allow Purchase Order Processing? → 'yes' if orders are 

required to be processed. Allow sales order Processing? → 'yes' if sales order are required. Invoicing → Same as 

explained in Accounting Features. Track Additional Costs of Purchase ? → It displays a break up of purchase cost 

if set to 'yes' Set Multiple Price Level ? →  Multiple price lists can be maintained if set to yes. Use Tracking 

Numbers → The relation between two sales, purchase documents can be maintained. Use Rejection Inward / 

Outward Notes ? → Rejection of goods can be maintained separately and not through Debit / Credit Notes. 

When you select statutory and Taxation option in the above window you get all the taxation option which we will 

discuss later in detail. 

Problem / Exercise: 

Create a company - Aspect Enterprises with 'Accounts only' option. 
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[ F12 : The settings at different levels can be set in the above screen. ] 

Menu related to Accounts: Now we have already created a company. So we will have a following screen of  

Gateway of Tally:- 

Select 'Accounts Info' option. Groups    →              Ledgers     →              Voucher Types    →              Quit 

Groups → It is advisable to Group / Classify ledger information based on their functions. Groups are helpful in 

classifying and identifying account heads based on their nature. Grouping helps in presenting summarized 

information. Regrouping is also permitted in Tally. Tally provides you with a number of pre-defined groups i.e. 28  
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CHAPTER 4 ACCOUNTING INFORMATION 

Predefined Groups 

Step 3: Studying the above predefined groups: Gateway of Tally   →              Account Info   →              Groups   →              

Quit Step 4: Press D for 'display' and Tally will show you all the list in alphabetical order. Some explanation about 

these groups : 1) Capital → It means the capital of a Proprietor, partner or share capital. 2) Reserve and Surplus 

[Retained Earnings] → When some part of the profit is kept aside e.g. Capital reserve, depreciation reserve etc. 
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Capital in Nature Revenue in Nature 1  Capital Account   1 Sales Account  1 Reserves and Surplus [Retained 

Earning]    2  Purchase Account  2 Current Assets i) Bank Accounts ii) Cash in Hand iii) Deposits (Asset) iv) Loans 

& Advances (Asset) v) Stock – in – hand vi) Sundry Debtors    3  4  5  Direct Income [Income direct] Indirect 

Income [Income Indirect] Direct Expenses [Expenses Direct]  3 Current Liabilities  i) Duties and Taxes ii) 

Provisions iii) Sundry Creditors   6 Indirect Expenses [Expenses Indirect]  4 Fixed Assets      5 Investments      6 

Loans (Liability) i) Bank OD Accounts    [Bank OCC Accounts] ii) Secured Loans iii) Unsecured Loans      7 

Suspense Account      8 Miscellaneous Expenses (Asset)      9 Branch / Divisions      

Current Assets → It is furtherly divided into following subgroups: a) Bank Accounts →All savings and current 

accounts b) Cash in hand → Cash, Petty cash etc. c) Deposits (Assets) → Deposits made by the company e.g. FDS, 

Tender deposits, security deposits etc. d) Loans and Advances (Assets) →Any loans or advances given by the 

company. Loan to ---- is always an Asset. e) Stock-in-Hand → Opening and closing stock. f) Sundry Debtors →All 

the parties to whom goods are sold on credit and amount is receivable from them. g) Current Liabilities → 

Anything Payable by the company falls under this groups i.e. h) Duties and Taxes → Custom, excise duties, VAT, 

CST etc. i) Provision → Provision for taxation, depreciation etc. j) Sundry Creditors → All such parties from whom 

goods are purchased on  credit and to whom amount is payable. k) Fixed Assets → All the long term Assets e.g. 

Land and Building, Plant and Machinery, Computers etc. l) Investments → Shares, debentures, bonds etc. m) Loans 

(Liability) →    All such loans taken by the company i.e. secured loans, unsecured loans, overdraft facility etc. n) 

Suspense Account → Advances or expenses for which account head can be decided only after submission of bills. 

o) Miscellaneous Expenses (Assets) → Company formation expenses. p) Branch / Divisions → Company's 

branches or sister concerns. q) Sales Account → Sale of goods and sale return. r) Purchase Account → Purchase of 

goods and purchase return. s) Direct Income → Income directly related to sales or professional fees. t) Indirect 

Income → e.g. Interest received, Dividend received etc. u) Direct Expenses →Which directly affect the production 

e.g. wages, transport and octroi, Factory rent etc. v) Indirect Expenses →All the Administrative Expenses such as 

salary, telephone, printing and stationery etc. Creating a Group You can also create a New Group under the 

predefined group if you want. Single Group    → Create Name → Alias → 

Under Nature of Group ' - Group behaves like a subledger ' 'Yes' ' Then you get group balances like ledgers - Net 

Debit / Credit Balances ' Set 'No' to display both side balances. 
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Altering a Group → Gateway of Tally      →              Accounts Info      →              Groups      →              Single 

Alter But you cannot alter the parent of a predefined group. 



Deleting of Group →              Gateway of Tally      →              Accounts Info      →              Groups      →              

Single Alter   

Select the group to be deleted from pop-up list             Alt + D for deletion 

But you cannot delete predefined groups or groups having subgroups or ledgers under it. And you cannot delete 

groups in Multiple Alter mode. 

Ledgers Ledgers means actual Account Head. Ledgers have to be created for voucher entries under certain groups. 

There are two ledger accounts inbuilt in the Tally package. These are 1) Cash account 2) Profit and Loss account. 

Single Ledger Creation Gateway of Tally     →              Accounts Info     →              Ledgers     →              Create 

You will have a following screen in which details are to be filled e.g. - Name → R K Traders - (Alias) → Give an 

alternate name to ledger if required - Under → Sundry Debtors (a list of groups will pop-up on your screen) - 

Opening Balance →  1,00,000 - Dr 
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- Mailing Details → You have to give these details if  you are opening the accounts of Debtors, Creditors or 

Advances. - Tax Information → PAN / IT / TIN numbers. - Cost Centres are applicable ? →If activated in F11 

features this option will appear on the screen. So if the details of ledger accounts are required to be given then set 

this option to Yes. - Inventory Values are Affected? → Inventory values get affected only by sales and purchase 

ledgers so only in those ledgers this option will remain yes. 

YOU CAN CONFIGURE THE LEDGER SCREEN BY PRESSING F12. Displaying Ledgers → Gateway of Tally      

→              Accounts Info     →              Ledgers     →          Single     →      Display Altering Ledgers → Gateway of 

Tally     →          Accounts Info    →          Ledgers     →            Single 

Alter [Select a ledger account to be altered and press Enter] Deleting a Ledger →    It can be deleted only in alter 

mode by pressing 'Alt + D' and it can be deleted only if no accounting transaction has taken place. Multiple ledger 

Creation :- Gateway of Tally --------- Accounts Info -------Ledgers-------------Multiple-------Create or just press 

highlighted alphabet 'R'. You will have a following ledger creation screen :- 

The fields in this screen are i. Under Group : Type the name of the group under which you desire to create the 

ledgers. ii. Name of Ledger : Type the ledger name iii. Under : It will take the copy of the same group-name, which 

you have recently selected for Under Group Screen in the current screen. iv. Opening balance : Type the opening 

balance. v. Dr/Cr : Specify whether Debit or Credit balance. 
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You can also Display and Alter the ledgers in Multiple mode. The ledger may also be created during the Voucher 

Entry. You get a ledger creation (secondary) screen by pressing Alt + C key combination. Cost Categories and Cost 

Centers → This option appear only if set to 'yes' in F11 features. You can give the 'details' of revenue items by 

option yes. e.g. paid salary Rs. 25,000/- to Mr A of Marketing Department Then. Salary A/c -----------------                                   

Dr-----  25,000/- Category ' Marketing Department Cost Centre ' Mr. A. To Cash / Bank 25,000/- Gateway of Tally 

→ Accounts Info → Cost Category → Single → Create. You will get the following screen. 

Cost Category Creation → Name → (Alias) → 



Allocate Revenue Items →    'Yes' so you can allocate all sales, purchases, income and expenditure accounts. 

Allocate Non-revenue Items → If you want to have the details of Capital Expenditure (balancesheet items) 

Displaying Cost Categories → Gateway of Tally →Accounts Info → Cost Categories → Single → Display. 

Altering a Cost Category →Gateway of Tally →Account Info →Cost Category →Single →Alter. Deleting a Cost 

Category → In Alter mode you can delete a cost category by 'Alt + D'. Cost Centers → These are used to give 

additional information to the accounts. They can be organized in primary and secondary levels eg. salary expenses 

can be allocated personwise, departmentwise etc. Telephone Expenses can be allocated numberwise, branchwise, or 

personwise. In such transactions the hierarchy is → Ledgers → Cost Category → Cost Centers  

Salary Accounts Department → Mr. Gokhale Marketing Department     → Mr. Vaidya 

Telephone Expenses  → Land Line → 25440898 Mobile Phone    → 9823923491 
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Creating a Cost Centre → Gateway of Tally → Accounts Info → Cost Centre → Create Category → Select the 

category from the above created list which will pop-up on the screen. Name → Type the name of the cost centre. 

Alias → Optional Under → Primary Displaying a Cost Centre → Gateway of Tally →Accounts Info → Cost 

Centre → Single → Display. Altering a Cost Centre →    Gateway of Tally Accounts Info → Cost Centre → Single 

→ Alter. Deleting a Cost Centre → In Alter mode by pressing 'Alt + D'. You can also create and alter the cost 

centers and cost categories in multiple mode but cannot 'delete' them. Problem / Exercise: In the above created 

company i.e. Aspect Enterprises create following 'Ledger Accounts' under appropriate groups ' [All the options in 

F11 will remain 'No'.] 
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Name of the Ledger Accounts Group Capital Capital Share Capital Capital ICICI Bank Overdraft Account Bank 

OD Account Cash Credit with HDFC Bank Bank OCC Account Swan Enterprises Sundry Creditors State Bank of 

India Bank Accounts Y Company Sundry Debtors Manish Enterprises Sundry Creditors Purchase Return Purchases 

Sales Return Sales Land and Building Fixed Assets Machinery Fixed Assets Computer Fixed Assets Office 

Equipments Fixed Assets Mobile Phone Fixed Assets Jeet Enterprises Sundry Debtors Closing Stock Stock in Hand 

Prepaid Expenses Current Assets Purchases Purchase Account 

Problem of Cost Centre Create a Company 'Anish Enterprises' with Accounts only option. 

Financial Year : 1.4.2009 Books Beginning From : 1.4.2009 Address : 21 Mayur Complex Shivajinagar, Pune-411 

005 - Gateway of Tally ' F11 ' Accounting Features ' 'Set Yes' to Maintain Cost Centers and more than one cost 

categories. - Create following cost categories ' Accounts Department, Marketing Department, Savings Bank Interest 

Received, Factory Electricity Charges, Office Electricity Charges. - Create following cost centers under respective 

cost categories Cost Category Cost Centers Accounts Department Mr. Sane Marketing Department Mr. Shete 

Savings Bank Interest Received Indian Bank Savings Bank Interest Received Dena Bank Factory Electricity 

Charges Meter no. 57011210 Office Electricity Charges Meter no. 57011220 

Voucher Entries 1/7/2009 Started business with Cash Rs. 30,000/-, building Rs. 75,000/- and Furniture Rs. 20,000/- 

2/7/2009 Opened a Bank account with Indian Bank by depositing Rs. 5,000/- 5/7/2009 Paid salary to Mr. Sane Rs. 

3,000/- and Mr. Shete Rs. 2,500/- 12/7/2009 Paid commission Rs. 1,500/- to Anand. 28/7/2009 Paid electricity bill 



of meter no 57011210 Rs. 750/- and meter no. 57011220 Rs. 1,250/- 31/7/2009 Received interest Rs. 350/- from 

Indian Bank and Rs. 250/- from Dena Bank. 

Name of the Ledger Accounts Group Wages Direct Expenses Transport Freight and Octroi Direct Expenses Sales 

Sales Account Salary Indirect Expenses Advertisement Indirect Expenses Postage and Telephone Indirect Expenses 

Professional and Consultation Charges Indirect Expenses Commission Received Indirect Income 
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A voucher is the basic recording document. They are used for recording day to day transactions with which several 

books of accounts are formed. These are 1) Cash book 2) Bank Book 3) Ledger 4) Sales Register 5) Purchase 

Register Journal Following keys are used to record the transactions → Keys Voucher Type F1 Inventory button F2 

To change the date of a voucher F4 Contra F5 Payment F6 Receipt F7 Journal F8 Sales F9 Purchases F8 Credit note 

F9 Debit note F10 Reverse Journal [If activated 'Yes' in F11] F10 Memo vouchers 

You can configure a voucher by pressing 'F12' and you will have a following screen.   

Creating a new voucher type or customizing the existing one → 

You can create a new 

voucher type under the existing one but cannot a completely new one. 

CHAPTER 5 VOUCHER ENTRIES IN TALLY 

Let us see the examples of each voucher type. 

1) Started business with cash Rs. 20,000/- Cash A/c ----------- Dr 20,000 To Capital A/c 20,000 [Voucher Type: 'F6' 

- Receipt] 2) Deposited cash in State Bank of India Rs. 5,000/- State Bank of India A/c ----------- Dr 5,000 To Cash 

A/c 5,000 [Voucher Type : 'F4' Contra] 3) Paid Salary Rs. 2,000/- Salary A/c ----------- Dr 2,000 To Cash A/c 2,000 

[Voucher Type : 'F5' Payment] 4) Purchased computer on credit from Hi-Tech for Rs. 40,000/- Computer A/c -------

---- Dr 40,000 To Hi-Tech A/c 40,000 [Voucher Type : 'F7' Journal] 5) Credit Sales of Rs. 10,000/- to Mr X X's  

A/c ----------- Dr 10,000 To Sales A/c 10,000 [Voucher Type : 'F8' Sales] 6) Credit Purchases of Rs. 15,000/- from 

Mr Y Purchases A/c ----------- Dr 15,000 To Y's A/c 15,000 [Voucher Type : 'F9' Purchases] 7) Received goods 

returned by Mr X Sales Return A/c ----------- Dr 1,000 To X's  A/c 1,000 [Voucher Type : 'Ctrl + F8' Credit Note] 

8) Returned goods to 'Y' Rs. 2,000/- Y's  A/c ----------- Dr 2,000 To Purchase Return A/c 2,000 [Voucher Type : 

'Ctrl + F9' Debit Note] 
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Memo Voucher → It is a non accounting voucher whose entries do not affect your accounts at all. Optional 

Vouchers → This is not a separate voucher type. You can mark a Regular voucher as optional and then can be 

regularized the same. Reversing Journals → These are the vouchers for a single day. Post-dated Vouchers → You 

can mark voucher as post-dated while entering it. Tally will include the same on the due date. 

Problem / Exercise:  



In the same company Aspect Enterprises Pass, following Voucher Entries Now go to F11    →          Accounting 

Features     →        Set 'Yes' to use Debit / Credit Notes 

1.4.2009 1) Started business with cash Rs. 50,000/- Hint ' F6 ' Receipt 2.4.2009 2) Deposited cash in State Bank of 

India Rs. 15,000/- Hint ' F4 ' Contra 3.4.2009 3) Paid Salary Rs. 5,000/- to Mrs. Asmita Hint ' F5 ' Payment 

4.4.2009 4) Purchase Goods worth Rs. 45,000/- on credit from Swan Enterprises. Hint ' F9 ' Purchase 5.4.2009 5) 

Credit Sales of goods worth Rs. 75,000/- to 'Y' Company Hint ' F8 ' Sales 6.4.2009 6) Returned goods to 'Swan 

Enterprise' Rs. 5,000/- Hint ' F9 ' Debit Note 7.4.2009 7) Received goods returned by 'Y' Company. Hint ' F8 ' 

Credit Note 8.4.2009 8) Purchased Machinery on Credit Rs. 40,000/- from Manish Enterprises Hint ' F7 ' Journal 

9.4.2009 9) Received commission in cash Rs. 2,000/- Hint ' F6 ' Receipt 10.4.2009 10) Withdrawn from State Bank 

of India Rs. 5,000/- Hint ' F4 ' Contra 

Answers: Trail Balance: 2,12,000 Gross Profit : 32,000 Net Profit : 29,000 Balance Sheet : 1,59,000 
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36.1 Understanding Financial Reports 

In most businesses, the accounting department or controller's office is required to produce certain financial reports 
on a regular basis. Typically, these reports are produced at the end of a period or fiscal year. To compare current 
period and year-to-date amounts to amounts for the same period in the prior year, you can print an income statement. 
To assess your company's financial position, you can print a balance sheet. 

Financial reports combine information from the Business Unit Master (F0006), Account Master (F0901), and 
Account Balances (F0902) tables. 

36.1.1 Types of Financial Reports 

Review the types of financial reports: 

• Standard reports 

You can use any of the standard templates that are provided with the JD Edwards EnterpriseOne General 
Accounting system. A report template contains a fixed format for your data and predefines the number of 
columns, their order, and their headings. 

• Custom reports 

You can create your own version using any report template. A single report version can contain amounts 
for individual companies or consolidated totals for several companies. 

You can design additional, customized financial reports using the Report Design Aid tool. 

• Detail and summary information on reports 

You can print different levels of summarization on financial reports by specifying a level of detail in which 
to show accounts. Using AAIs, you assign the account ranges and subtotals that the system uses for the 
reports. 

36.2 Setting Up Data Selection and Data Sequence for the Simple Income Statement and Simple Balance Sheet 



You must select the object accounts to include on the report. You must also specify a ledger type. If you do not, the 
system combines all ledger types, which could produce inaccurate results. 

Financial reports are designed to print in this sequence: 

• Company 

• Object account 

• Subsidiary 

If you do not use company as your first sequence, the system uses the information for company 00000 to determine 
the financial reporting date. 

You must always use a sequence by object account and subsidiary to protect the integrity of your data and to ensure 
that the level-of-detail subtotals are accurate. To print a report across many business units or companies, use a 
sequence by object account and subsidiary only. 

The data sequence item that immediately precedes the object account determines page breaks and totals for all 
financial reports. For example, if the data sequence is by company, object account, and subsidiary, page breaks and 
totals occur when the company number changes. If the object account is the first data sequence item, the report has 
no page breaks and totals appear at the end of the report. 

You can change the subtotals by changing the sequence and level breaks. For example, you could create subtotals by 
specifying category codes for level breaks. 

This table shows the data sequence that is required for specific types of reports: 

Report Type Data Sequence Setup 

Business unit report The data sequence should be:  

• Business Unit 

• Object Account 

• Subsidiary 

Business unit consolidation report The data sequence should be:  

• Company 

• Object Account 

• Subsidiary 

Company consolidation report The data sequence should be:  

• Object 

• Subsidiary 

 

36.3 Generating a Simple Income Statement 
This section provides an overview of the simple income statement, lists prerequisites, and discusses how to: 

• Print a simple income statement. 

• Set data selection and data sequence for Simple Income Statement. 

• Set processing options for Simple Income Statement (R10211B). 

36.3.1 Understanding the Simple Income Statement 
The Simple Income Statement (R10211B) tracks revenues and expenses and the net income or loss for a specific 
period of time. To print a simple income statement, all of your profit and loss accounts must be grouped together in 
your chart of accounts and cannot be interrupted by any balance sheet accounts. 
The system uses AAI item FSxx to establish the optimal interim totals on the income statement. Some examples of 
special interim totals include: 

• Gross Margin 

• Net Profit Before Taxes 

• Net Income (Loss) 

36.3.2 Prerequisites 
Before you complete the tasks in this section: 

• Verify that you have set up AAI items FSxx. 



• Verify that your financial reporting period is set correctly. 
See Changing Financial Reporting Periods. 

36.3.3 Printing a Simple Income Statement 
Select Financial Reports (G10), Simple Income Statement. 

36.3.4 Setting Data Selection for Simple Income Statement 
You must select the object accounts to include on the report. For example, if your profit and loss accounts begin 
with object account 5000, select an object account greater than or equal to 5000. 
See Setting Up Data Selection and Data Sequence for the Simple Income Statement and Simple Balance Sheet. 

36.3.5 Setting Processing Options for Simple Income Statement (R10211B) 
Processing options enable you to specify the default processing for reports. 
36.3.5.1 Date 

1. Period Number and 2. Fiscal Year 

Enter the period number and fiscal year that the report should be based on. If you leave these processing 
options blank, the system uses the financial reporting date of the company. 

36.3.5.2 LOD 

1. Level of Detail 

Enter the lowest level of account detail to print on the report. 
36.3.5.3 Signs 

1. Reverse Sign 

Specify how to print amounts. Values are: 
0: Print amounts in their original debit and credit format. 
1: Reverse the sign for all account types (revenues print as positive and expenses as negative). 
2: Reverse the sign of revenue accounts only (revenues and expenses print as positive). 

36.3.5.4 Calculations 

1. Calculate Net Income 

Specify whether to calculate net income. Values are: 
Blank: Do not calculate net income. 
1: Calculate net income. 

36.3.5.5 Headings 

1. Print Heading 

Specify how to print headings. Values are: 
Blank: Print headings on the first page only. 
1: Print headings with page number and run date on each page. 
2: Print headings without page number and run date. 

2. Date Title Type 

Enter the date title type to print in the page heading. If you leave this processing option blank, a date title 
does not print. 

36.4 Generating a Simple Balance Sheet 
This section provides an overview of the simple balance sheet, lists prerequisites, and discusses how to: 

• Print a simple balance sheet. 

• Set data selection and data sequence for Simple Balance Sheet. 

• Set processing options for Simple Balance Sheet (R10111B). 

36.4.1 Understanding the Simple Balance Sheet 
The Simple Balance Sheet (R10111B) tracks assets, liabilities, and equity by business unit or company. To print a 
simple balance sheet, all of your balance sheet accounts must be grouped in your chart of accounts, and cannot be 
interrupted by any profit and loss accounts. 
You can use a balance sheet to track financial information for: 

• Current period. 

• Prior period end. 

• Prior year end. 

• Net change for the period and year. 
AAI items GLG2, GLG3, and GLG5 establish the beginning and ending ranges for balance sheet accounts. 
36.4.1.1 How Net Income Is Calculated 

The system does not perform calculations on the actual revenue and expense accounts (5000–9999) to derive a net 
income amount. Instead, it uses this equation: 
Assets – (Liabilities + Equity) = Net Income 
This method of calculating the net income saves a considerable amount of processing time when you produce a 
balance sheet. 



36.4.1.2 Example: Net Income Calculation 

Review this example to see how the system uses the computed total in the net income calculation: 
Assets = 6,966,772.54 
Liabilities + Equity = – 6,592,393.31 
Net Income = 374,379.23 
This calculation is based on: 
Assets = 6,966,772.54 
Liabilities + Equity: 

• Current Liabilities = 755,755.74 

• Long-Term Liabilities = 2,027,576.49 

• Common Stock = 267,500.00 

• Paid-in-Capital = 1,535,017.77 

• Retained Earnings = 2,006,543.31 

• Total Liabilities + Equity = 6,592,393.31 

36.4.2 Prerequisites 
Before you complete the tasks in this section: 

• Validate the net income amount on your income statement. 
This amount is the year-to-date income (loss) on the balance sheet. 

• Verify that AAI items GLG2, GLG3, and GLG5 are set up. 

• Verify that your financial reporting period is set correctly. 
See Changing Financial Reporting Periods. 

• For reports that cross over to a new year, verify that the Annual Close Report (R098201) ran successfully. 
Balance forward amounts are not created until the close process is complete. 
See Closing the Fiscal Year. 

36.4.3 Printing a Simple Balance Sheet 
Select Financial Reports (G10), Simple Balance Sheet. 

36.4.4 Setting Data Selection for Simple Balance Sheet 
You must select the object accounts to include on the report. For example, if your profit and loss accounts begin 
with object account 5000, you could select an object account that is less than or equal to 4999. 

36.4.5 Setting Processing Options for Simple Balance Sheet (R10111B) 
The processing options for the Simple Balance Sheet are the same as those for the Simple Income Statement except 
for those described in this section.  
36.4.5.1 Signs 

Reverse Sign 

Specify how to print amounts. Values are: 
0 (zero): Print amounts in their original debit and credit format. 
1: Reverse the sign for liability and equity accounts. 

36.4.5.2 Computations 

Calculate YTD Net Income 

Specify whether to calculate and print a year-to-date net income amount. Values are: 

Blank: Do not print a year-to-date net income amount. 

1: Print a year-to-date net income amount. 

36.5 Generating a Statement of Cash Flow 

This section provides an overview of the statement of cash flow, lists prerequisites, and discusses how to: 

• Print the statement of cash flow. 

• Set data selection for Statement of Cash Flows Report. 

• Set processing options for Statement of Cash Flows Report (R10521). 

See Also: 

• Setting Up Statements of Cash Flow. 



36.5.1 Understanding the Statement of Cash Flow 

The Statement of Cash Flows Report (R10521), which reports on the cash flows of a reporting entity, meets 
International Accounting Standards (IAS) requirements for financial reporting. The statement of cash flow consists 
of accounts that are part of a company's operating, investing, and financing activities and provides information about 
how cash and cash equivalents are generated and used by a company. 

The system retrieves information for cash flow statements from these tables: 

• Statement of Cash Flow Rules (F10520). 

This table contains the descriptions that appear on the report, the accounts associated with each description, 
and an indication of whether the accounts normally have a debit or credit balance. 

This table does not include the subtotal descriptions. The subtotal descriptions are hard-coded in the 
Statement of Cash Flow Report and are based on International Accounting Standards (IAS) 7. 

• Account Balances (F0902) 

This table contains the account balances for the accounts in the F10520 table. The system calculates the net 
year-to-date postings for the period, based on the F0902 table and the fiscal period specified in a processing 
option. 

On the Statement of Cash Flow Report, the system inserts the words Increase in or Decrease in before the account 
descriptions for each line as follows: 

• If the accounts associated with the description normally have a debit balance (as specified in the F10520 
table) and the balances in the F0902 table are positive (zero or greater), the system concatenates the text 
Increase in before the description. If the balances are negative (less than zero), it concatenates the text 
Decrease in. 

• If the accounts associated with the description normally have a credit balance (as specified in the F10520 
table) and the balances in the F0902 table are positive, the system concatenates the text Decrease in before 
the description. If the balances are negative, it concatenates the text Increase in. 

If amounts on the Statement of Cash Flows Report are out of balance, an error message prints at the end of the 

report. An out-of-balance condition occurs when the difference between beginning and ending cash and cash 
equivalents is not equal to the net increase or decrease in cash and cash equivalents. 

36.5.1.1 Example: Statement of Cash Flow 

This example shows the contents of a statement of cash flow. The left column shows the description as it appears on 
the report, the middle column shows the activity code and line item that correspond to that description, and the right 
column shows amounts, which are typically subtotal amounts. 

You define line items for activity codes 20–70 (UDC table 10/CF) and assign accounts to each line item. The system 
uses those account numbers to calculate the amounts that appear on your report. For most activity codes, the system 
summarizes the line item amounts into a subtotal. For example, the subtotal description for activity code 20 is 
Operating Profit Before Working Capital Changes and the subtotal amount is 100. 

For activity code 10, you do not assign an account. Instead, you assign AAI item FSxx, which you use for Net Profit 
Before Tax, and the system locates the corresponding amount. This amount is from the Simple Income Statement 
(R10211B), which is generated when you run the Statement of Cash Flows Report. 

For the Depreciation line item, you use accumulated depreciation accounts, which are credit accounts, so that when 
the amounts are reversed for the report they are added to the Net Income Before Tax line item. 

Figure 36-1 Statement of Cash Flows 



 
 

** This amount equals the difference between the beginning balance and ending balance of cash and cash 
equivalents. 

36.5.2 Prerequisites 
Before you complete the tasks in this section: 

• Ensure that all financial statements for the fiscal period have been generated. 

• Ensure that you have access to the programs in the Financial Reports system (system code 10). 

36.5.3 Printing the Statement of Cash Flow 
Select Statement of Cash Flow (G1031), Statement of Cash Flows Report. 

36.5.4 Setting Data Selection for Statement of Cash Flow Report 
To generate a Statement of Cash Flows Report that includes more than one company, the currency, the fiscal date 
pattern and account structure must be the same for the companies that you specify in the data selection. 

36.5.5 Setting Processing Options for Statement of Cash Flow Report (R10521) 
Processing options enable you to specify the default processing for reports. 
36.5.5.1 Select 

1. Fiscal Date Pattern Company 

Specify which company fiscal date pattern you want to use to print the date on the report. If you leave this 
processing option blank, the system uses the current period for company 00000 and prints the 
corresponding date. 

2. Thru Period Number and 3. Fiscal Year 



Specify the through period number and fiscal year n which to run the Statement of Cash Flows Report. If 
you leave these processing options blank, the system uses the current period number and current fiscal year 
of the company in the Fiscal Date Pattern Company processing option. If that processing option is blank, 
the system uses the current period number and fiscal year of company 00000. 

4. Ledger Type 

Specify the ledger type to use for the Statement of Cash Flows Report. If you leave this processing option 
blank, the system uses ledger type AA. If you work in a multicurrency environment, the currency of the 
ledger type must be the same as the currency of the company on the report. 

36.5.5.2 Display 

1. Scaling 

Specify the value in which to scale amounts on the report. Values are 1, 10, 100, 1000, 10000, 100000, 
1000000, 10000000, 100000000, and 1000000000. The system performs rounding when it scales amounts. 
If you leave this processing option blank, the system does not scale amounts. 

36.6 Generating Consolidated Financial Reports 

This section provides an overview of consolidated financial reports, lists a prerequisite, and discusses how to: 

• Print a Consolidated Income-7 column statement. 

• Set data selection and data sequence for Consolidated Income-7 column. 

• Set processing options for Consolidated Income-7 column (R103121A). 

• Print a consolidated balance sheet. 

• Set data selection and data sequence for Consolidated Balance Sheet. 

• Set processing options for Consolidated Balance Sheet (R10311A). 

36.6.1 Understanding Consolidated Financial Reports 

At the end of each financial period, most companies produce financial reports. To combine income or balance sheet 
information across companies or business units, you can print consolidated financial reports. These reports use 
information that is stored in the F0006, F0901, and F0902 tables. 

The JD Edwards EnterpriseOne General Accounting system provides several sample versions of consolidated 
financial reports. Before you print them, you must first define the column headings and data to appear in each 
column of the report. This information also applies to consolidated financial reports: 

• Each report includes a consolidated column. 
The system calculates the consolidated column based on the amounts in the other columns. 

• Amounts on the report appear as whole currency amounts. 
Decimal amounts are omitted. 

• You can define as many columns as fit on the printed report. 

36.6.2 Prerequisite 
Define the column headings and data to appear in each column of the consolidated financial report. 
. 

36.6.3 Printing a Consolidated Income- 7 Column Statement 
Select Financial Reports (G10), Consolidated Income-7 column. 
To see income (profit and loss) information that is combined for companies or business units, print the Consolidated 
Income-7 column statement (R103121A). Amounts on consolidated income statements include a maximum of 999 
million with separators and 999 billion without separators. You can include information for the current period or 
year to date. 
The XJDE versions for the Consolidated Income-7 column statement have predefined columns for specific 
companies. To create a report for companies other than those that are defined in the XJDE versions, you must use 
the Report Design Aid tool to set up data selection and column titles. 

36.6.4 Setting Data Selection and Sequence for Consolidated Income-7 Column 
The first data selection must be the object account range for your profit and loss accounts. 
You must sequence by object and subsidiary account. If you do not, your column data is spread over many pages. 

36.6.5 Setting Processing Options for Consolidated Income-7 Column (R103121A) 



The processing options for the Consolidated Income-7 column statements are the same as those for the Simple 
Income Statement except for those described in this section.  
Period/YTD 

Specify the account balances to appear on the report. Values are: 
Blank: Print year-to-date account balances. 
1: Print account balances for a single period. 

36.6.5.2 Calculations 

Calculate Net Income 

Specify whether to calculate net income. Values are: 
Blank: Do not calculate net income. 
If the version uses AAI sub totaling, leave this processing option blank. The system automatically 
calculates and prints net income. 
1: Calculate net income. 

36.6.6 Printing a Consolidated Balance Sheet 
Select Financial Reports (G10), Consolidated Balance Sheet. 
To make balance sheet comparisons using combined totals for companies or business units, print the Consolidated 
Balance Sheet (R10311A) for the current period or the year to date. You can consolidate up to seven different 
reporting entities on the consolidated balance sheet. 
The XJDE versions of the Consolidated Balance Sheet have predefined columns for specific companies. To create a 
report for companies other than those that are defined in the XJDE versions, you must use the Report Design Aid 
tool to set up data selection and column titles. 

36.6.7 Setting Data Selection and Sequence for Consolidated Balance Sheet 
The first data selection must be the object account range for the balance sheet accounts. 
You must sequence by object and subsidiary account. If you do not, the column data is spread over many pages. 

36.6.8 Setting Processing Options for Consolidated Balance Sheet (R10311A) 
The processing options for the Consolidated Income- 7 Column statements are the same as those for the Simple 
Income Statement with this exception.  

Specify whether to calculate year-to-date income. Values are: 
Blank: Do not calculate year-to-date income. 
1: Calculate year-to-date income. 
Specify how to print amounts. Values are: 
0: Print amounts in their original debit and credit format. 
1: Reverse the sign for liability and equity accounts. 

36.7 Generating Monthly Spreadsheets 
This section provides an overview of monthly spreadsheets, lists a prerequisite, and discusses how to: 

• Print the monthly spreadsheet. 

• Set processing options for Monthly Spreadsheet (R10412A). 

36.7.1 Understanding Monthly Spreadsheets 
To examine trends in your company's financial activity, print the Monthly Spreadsheet (R10412A). You can analyze 
actual and budget amounts for period-to-date, as well as year-to-date. You can also show current period amounts 
with budget amounts for future periods. 
The monthly spreadsheet rounds to the thousands. For example, if the amount is 2700, it rounds to 3000 and prints 
as 3. If you want a spreadsheet with different specifications, you can design your own by using the Report Design 
Aid tool. 
The monthly spreadsheet uses information stored in the F0902 table. 
Note: 
You must use version XJDE0006 or create a copy of the version if you want AAI subtotals to appear on your report. 

XJDE0006 contains additional event rules for AAI sub totaling; therefore, you cannot add a version and achieve the 

desired results. 

Specify how to print amounts. Values are: 
0: Print amounts in their original debit and credit format. 
1: Reverse the sign for income statement accounts (revenues print as positive and expenses print as 
negative). 
2: Reverse the sign for liability and equity accounts. 
3: Reverse the sign for revenue accounts only (revenues and expenses print as positive). 

36.7.4.2 Calculations 

1. Calculate Net Income 

Specify the type of net income to calculate. Values are: 



1: Calculate balance sheet net income. 

2: Calculate profit and loss net income. 

3: Do not calculate net income (default) 

36.7.4.3 Columns 

1. Column Format 

Specify the format of the twelve columns that print on the spreadsheet: 

1: Last 12 Months Actual (default) 

2: Year-to-Date Actual 

3: Year-to-Date Actual plus Remaining Budget. 

2. Budget Ledger Type 

If the Column Format processing option is set to 3, enter the ledger type for the remaining budget. If you 
leave this processing option blank, the system uses ledger type BA. 

3. Ledger Type 

Enter the ledger type in which to base the spreadsheet. If you leave this processing option blank, the system 
uses ledger type AA. 

36.8 Generating Variance Analysis Reports 

To compare actual to budget amounts and compute current period and year-to-date variances, use the variance 
analysis reports. 

The processing options for this report are the same as those for the Monthly Spreadsheet except for the processing 
option described in this section. 

 

 

Unit – V     [ Database Management System ] 

 

Traditional File Management 

File processing systems was an early attempt to computerize the manual filing system that we are all familiar with. 

A file system is a method for storing and organizing computer files and the data they contain to make it easy to find 

and access them. File systems may use a storage device such as a hard disk or CD-ROM and involve maintaining the 

physical location of the files. 

In our own home, we probably have some sort of filing system, which contains receipts, guarantees, invoices, bank 

statements, and such like. When we need to look something up, we go to the filing system and search through the 

system starting from the first entry until we find what we want. Alternatively, we may have an indexing system that 



helps to locate what we want more quickly. For example we may have divisions in the filing system or separate 

folders for different types of item that are in some way logically related.  

The manual filing system works well when the number of items to be stored is small. It even works quite adequately 

when there are large numbers of items and we have only to store and retrieve them. However, the manual filing 

system breaks down when we have to cross-reference or process the information in the files. For example, a typical 

real estate agent's office might have a separate file for each property for sale or rent, each potential buyer and renter, 

and each member of staff.  

Clearly the manual system is inadequate for this' type of work. The file based system was developed in response to 

the needs of industry for more efficient data access. In early processing systems, an organization's information was 

stored as groups of records in separate files.  

In the traditional approach, we used to store information in flat files which are maintained by the file system under 

the operating system's control. Here, flat files are files containing records having no structured relationship among 

them. The file handling which we learn under C/C ++ is the example of file processing system. The Application 

programs written in C/C ++ like programming languages go through the file system to access these flat. files as 

shown.  

                             

 

Characteristics of File Processing System 

Here is the list of some important characteristics of file processing system:  

• It is a group of files storing data of an organization.  

• Each file is independent from one another.  

• Each file is called a flat file.  

• Each file contained and processed information for one specific function, such as accounting or inventory.  

• Files are designed by using programs written in programming languages such as COBOL, C, C++.  

• The physical implementation and access procedures are written into database application; therefore, physical 

changes resulted in intensive rework on the part of the programmer.  

• As systems became more complex, file processing systems offered little flexibility, presented many limitations, 

and were difficult to maintain.  



Limitations of the File Processing System I File-Based Approach 

There are following problems associated with the File Based Approach:  

  1. Separated and Isolated Data: To make a decision, a user might need data from two separate files. First, the files 

were evaluated by analysts and programmers to determine the specific data required from each file and the 

relationships between the data and then applications could be written in a programming language to process and 

extract the needed data. Imagine the work involved if data from several files was needed.  

2. Duplication of data: Often the same information is stored in more than one file. Uncontrolled duplication of data 

is not required for several reasons, such as:  

• Duplication is wasteful. It costs time and money to enter the data more than once  

• It takes up additional storage space, again with associated costs.  

• Duplication can lead to loss of data integrity; in other words the data is no longer consistent. For example, consider 

the duplication of data between the Payroll and Personnel departments. If a member of staff moves to new house and 

the change of address is communicated only to Personnel and not to Payroll, the person's pay slip will be sent to the 

wrong address. A more serious problem occurs if an employee is promoted with an associated increase in salary. 

Again, the change is notified to Personnel but the change does not filter through to Payroll. Now, the employee is 

receiving the wrong salary. When this error is detected, it will take time and effort to resolve. Both these examples, 

illustrate inconsistencies that may result from the duplication of data. As there is no automatic way for Personnel to 

update the data in the Payroll files, it is difficult to foresee such inconsistencies arising. Even if Payroll is notified of 

the changes, it is possible that the data will be entered incorrectly.  

3. Data Dependence: In file processing systems, files and records were described by specific physical formats that 

were coded into the application program by programmers. If the format of a certain record was changed, the code in 

each file containing that format must be updated. Furthermore, instructions for data storage and access were written 

into the application's code. Therefore, .changes in storage structure or access methods could greatly affect the 

processing or results of an application.  

In other words, in file based approach application programs are data dependent. It means that, with the change in the 

physical representation (how the data is physically represented in disk) or access technique (how it is physically 

accessed) of data, application programs are also affected and needs modification. In other words application 

programs are dependent on the how the data is physically stored and accessed.  

If for example, if the physical format of the master/transaction file is changed, by making he modification in the 

delimiter of the field or record, it necessitates that the application programs which depend on it must be modified.  

Let us consider a student file, where information of students is stored in text file and each field is separated by blank 

space as shown below:  



Then, the application programs using this file must be modified, because now it will token the field on semicolon; 

but earlier it was blank space.  

4. Difficulty in representing data from the user's view: To create useful applications for the user, often data from 

various files must be combined. In file processing it was difficult to determine relationships between isolated data in 

order to meet user requirements.  

5. Data Inflexibility: Program-data interdependency and data isolation, limited the flexibility of file processing 

systems in providing users with ad-hoc information requests  

6. Incompatible file formats: As the structure of files is embedded in the application programs, the structures are 

dependent on the application programming language. For example, the structure of a file generated by a COBOL 

program may be different from the structure of a file generated by a 'C' program. The direct incompatibility of such 

files makes them difficult to process jointly.  

7. Data Security. The security of data is low in file based system because, the data is maintained in the flat file(s) is 

easily accessible. For Example: Consider the Banking System. The Customer Transaction file has details about the 

total available balance of all customers. A Customer wants information about his account balance. In a file system it 

is difficult to give the Customer access to only his data in the· file. Thus enforcing security constraints for the entire 

file or for certain data items are difficult.  

8. Transactional Problems. The File based system approach does not satisfy transaction properties like Atomicity, 

Consistency, Isolation and Durability properties commonly known as ACID properties.  

For example: Suppose, in a banking system, a transaction that transfers Rs. 1000 from account A to account B with 

initial values' of A and B being Rs. 5000 and Rs. 10000 respectively. If a system crash occurred after the withdrawal 

of Rs. 1000 from account A, but before depositing of amount in account B, it will result an inconsistent state of the 

system. It means that the transactions should not execute partially but wholly. This concept is known as Atomicity 

of a transaction (either 0% or 100% of transaction). It is difficult to achieve this property in a file based system.  

9. Concurrency problems. When multiple users access the same piece of data at same interval of time then it is 

called as concurrency of the system. When two or more users read the data simultaneously there is ll( problem, but 

when they like to update a file simultaneously, it may result in a problem.  

For example:  

Let us consider a scenario where in transaction T 1 a user transfers an amout1t 1000 from  

Account A to B (initial value of A is 5000 and B is 8000). In mean while, another transaction T2, tries to display the 

sum of account A and B is also executed. If both the transaction runs in parallel it may results inconsistency as 

shown below:  



                         

The above schedule results inconsistency of database and it shows Rs.12,000 as sum of accounts A and B instead of 

Rs .13,000. The problem occurs because second concurrently running transaction T2, reads A and B at intermediate 

point and computes its sum, which results inconsistent value.  

10. Poor data modeling of real world. The file based system is not able to represent the complex data and 

interfile relationships, which results poor data modeling properties.  

  In case of college database, there may be the number of applications like General Office, Library, Account 

Office, Hostel etc. Each of these applications may maintain the following information into own private file 

applications in case of file management system:  

                           

It is clear from the above file systems, that there are some common data items of the student which has to be 

mentioned in each application, like Rollno, Name, Class, Father_Name, Address, Phone_No, Date_of_birth etc. 

which are stored repeatedly in file system in each application. It will cause the problem of redundancy which results 

in wastage of storage space and difficulty in maintenance. So, we should look for a solution to these types of 

redundancies. The database approach discussed below will help us to provide the solution for above problems 

AN ARCHITECTURE FOR DATABASE SYSTEM 

 

EXTERNAL LEVEL 

How data is viewed by an individual user 

 

CONCEPTUAL LEVEL 

How data is viewed by a community of users 

 

INTERNAL LEVEL 



How data is physically stored  

 

 

DATA MODELS AND SCHEMAS 

 

  DATA MODEL 

 

A data model is a set of concepts that can be used to describe the structure of the database: data types, relationships, 

and constraints that should hold on the data. 

 

Most data models also include a set of operations for specifying retrievals and updates on the database.  

  DATABASE SCHEMA 

 

A database schema is the description of a database. 



 

 

 

THE EXTERNAL LEVEL 

  Application programmer uses a HOST LANGUAGE: COBOL, PL/1, C  

  Embedded in the host language is a DATA SUBLANGUAGE DSL 

 

Example: SQL, dBASE 

  Data Sublanguage consists of: 

Data Definition Language DDL 

Data Manipulation Language DML 

  Data Definition Language declares database objects 

  Data Manipulation Language manipulates database objects 

e.g. retrievals and updates 

 

THE CONCEPTUAL LEVEL 

 

A representation of the entire information content of the database 

  The conceptual schema is a definition of the view of the total database content 

  Conceptual schema, in most cases, is the union of external schemas 

  One can add: security and integrity checks, semantic models and data dictionary (see later) 

 

THE INTERNAL LEVEL 

  The internal view is a low-level representation of the entire database 

  Internal record, or stored record, is built upon physical records, or pages and blocks 

 

 



 
 

 

MAPPINGS 

  External/Conceptual 

  Conceptual/Internal 

 

THE DATABASE ADMINISTRATOR 

  Defines conceptual schema 

  Defines internal schema 

  Communicates with users 

  Defines security and integrity checks 

  Defines backup and recovery procedures 

  Monitors performance and decide when to reorganize the database 

THE DATABASE MANAGEMENT SYSTEM 
1. A user issues an access request 
2. DBMS interpretes the request 
3. DBMS performs external/conceptual and conceptual/interal mappings 
4. DBMS executes the necessary operations on stored database 
 
 
THUS DBMS MUST SUPPORT 
  data definition 

  data manipulation 

  routine and unplanned requests 

  data security and integrity 

  data recovery and concurrency 

  data dictionary 

  performance tuning 

 



DISTRIBUTED DATABASE SYSTEMS 

  Databases and Data Communications (DB/DC) are coming together 

  Frontend vs. Backend 

 

 
  Frontend vs. Backend running on different machines 

 

 



  One backend with multiple frontends 

 

 

  Each machine is both backend and frontend 

 

 

Three Level Database Architecture 

last updated 29-aug-13  

Data and Related Structures 

Data are actually stored as bits, or numbers and strings, but it is difficult to work with data at this level. 



It is necessary to view data at different levels of abstraction. 

Schema:  

• Description of data at some level. Each level has its own schema. 

We will be concerned with three forms of schemas:  



• physical,  

• conceptual, and  

• external. 

  

 

Physical Data Level 

The physical schema describes details of how data is stored: files, indices, etc. on the random access disk system.  It 
also typically describes the record layout of files and type of files (hash, b-tree, flat). 

Early applications worked at this level - explicitly dealt with details. E.g., minimizing physical distances between 
related data and organizing the data structures within the file (blocked records, linked lists of blocks, etc.)  

Problem:  

• Routines are hardcoded to deal with physical representation. 

• Changes to data structures are difficult to make. 

• Application code becomes complex since it must deal with details. 

• Rapid implementation of new features very difficult. 

 Conceptual Data Level Also referred to as the Logical level 

Hides details of the physical level. 

• In the relational model, the conceptual schema presents data as a set of tables. 

The DBMS maps data access between the conceptual to physical schemas automatically. 

• Physical schema can be changed without changing application: 

• DBMS must change mapping from conceptual to physical. 

• Referred to as physical data independence. 

 External Data Level 

In the relational model, the external schema also presents data as a set of relations. An external schema specifies a 
view of the data in terms of the conceptual level. It is tailored to the needs of a particular category of users. Portions 
of stored data should not be seen by some users and begins to implement a level of security and simplifies the view 
for these users  

Examples: 

• Students should not see faculty salaries. 

• Faculty should not see billing or payment data. 

Information that can be derived from stored data might be viewed as if it were stored. 

• GPA not stored, calculated when needed. 

Applications are written in terms of an external schema. The external view is computed when accessed.  It is not 
stored. Different external schemas can be provided to different categories of users. Translation from external level to 
conceptual level is done automatically by DBMS at run time. The conceptual schema can be changed without 
changing application: 

• Mapping from external to conceptual must be changed. 



• Referred to as conceptual data independence. 

  

 

Data Model 

Schema: description of data at some level (e.g., tables, attributes, constraints, domains) 

Model: tools and languages for describing: 

• Conceptual/logical and external schema described by the data definition language (DDL) 

• Integrity constraints, domains described by DDL 

• Operations on data described by the data manipulation language (DML) 

• Directives that influence the physical schema (affects performance, not semantics) are described by the 
storage definition language (SDL) 

  

   

 

Data Independence 

Logical data independence 

• Immunity of external models to 
changes in the logical model 

• Occurs at user interface level 

Physical data independence 

• Immunity of logical model to 
changes in internal model 

• Occurs at logical interface level 

  

  

  

 

  

 

Relational Model 

Record- and table-based model  



Relational database modeling is a logical-level model 

Proposed by E.F. Codd 

• Based on mathematical relations 

• Uses relations, represented as tables 

• Columns of tables represent attributes 

• Tables represent relationships as well as entities 

Successor to earlier record-based models—network and hierarchical 

  

  

   

 

Object-oriented Model 

Uses the E-R modeling as a basis but extended to include encapsulation, inheritance 

Objects have both state and behavior 

• State is defined by attributes 

• Behavior is defined by methods (functions or procedures) 

Designer defines classes with attributes, methods, and relationships 

Class constructor method creates object instances 

• Each object has a unique object ID 

• Classes related by class hierarchies 



• Database objects have persistence 

Both conceptual-level and logical-level model 

  

  

 

Object-relational model 

Adds new complex datatypes to relational model 

Adds objects with attributes and methods 

Adds inheritance 



SQL extended to handle objects in SQL:1999 

  

  

  

 

Semi-structured Model 
Collection of nodes, each with data, and with different schemas 
Each node contains a description of its own contents 
Can be used for integrating existing databases 
XML tags added to documents to describe structure 
XML tags identify elements, sub-elements, attributes in documents 
XML DTD (Document Type Definition) or XML Schema used to define structure 

 

 

 

Components of DBMS  
A database management system (DBMS) consists of several components. Each component plays very important role 

in the database management system environment. The major components of database management system are: 

• Software 

• Hardware 

• Data 

• Procedures 

• Database Access Language 

Software 

The main component of a DBMS is the software. It is the set of programs used to handle the database and to control 

and manage the overall computerized database 

1. DBMS software itself, is the most important software component in the overall system 
2. Operating system including network software being used in network, to share the data of database among 

multiple users. 
3. Application programs developed in programming languages such as C++, Visual Basic that are used to to 

access database in database management system. Each program contains statements that request the DBMS 
to perform operation on database. The operations may include retrieving, updating, deleting data etc . The 
application program may be conventional or online  workstations or terminals. 

Hardware 

Hardware consists of a set of physical electronic devices such as computers (together with associated I/O devices 

like disk drives), storage devices, I/O channels, electromechanical devices that make interface between computers 

and the real world systems etc, and so on. It is impossible to implement the DBMS without the hardware devices, In 

a network, a powerful computer with high data processing speed and a storage device with large storage capacity is 

required as database server. 

Data 

Data is the most important component of the DBMS. The main purpose of DBMS is to process the data. In DBMS, 

databases are defined, constructed and then data is stored, updated and retrieved to and from the databases. The 

database contains both the actual (or operational) data and the metadata (data about data or description about data). 

Procedures 



Procedures refer to the instructions and rules that help to design the database and to use the DBMS. The users that 

operate and manage the DBMS require documented procedures on hot use or run the database management system. 

These may include. 

1. Procedure to install the new DBMS. 
2. To log on to the DBMS. 
3. To use the DBMS or application program. 
4. To make backup copies of database. 
5. To change the structure of database. 
6. To generate the reports of data retrieved from database. 

Database Access Language 

The database access language is used to access the data to and from the database. The users use the database access 

language to enter new data, change the existing data in database and to retrieve required data from databases. The 

user write a set of appropriate commands in a database access language and submits these to the DBMS. The DBMS 

translates the user commands and sends it to a specific part of the DBMS called the Database Jet Engine. The 

database engine generates a set of results according to the commands submitted by user, converts these into a user 

readable form called an Inquiry Report and then displays them on the screen. The administrators may also use the 

database access language to create and maintain the databases. 

The most popular database access language is SQL (Structured Query Language). Relational databases are required 

to have a database query language. 

Users 

The users are the people who manage the databases and perform different operations on the databases in the 

database system.There are three kinds of people who play different roles in database system 

 

1. Application Programmers 
2. Database Administrators 
3. End-Users 

Application Programmers 

The people who write application programs in programming languages (such as Visual Basic, Java, or C++) to 

interact with databases are called Application Programmer. 

Database Administrators  

A person who is responsible for managing the overall database management system is called database administrator 

or simply DBA. 

End-Users 

The end-users are the people who interact with database management system to perform different operations on 

database such as retrieving, updating, inserting, deleting data etc. 

 

Components of DBMS  

A typical structure of a DBMS with its components and relationships between them is show. The DBMS software is 

partitioned into several modules. Each module or component is assigned a specific operation to perform. Some of 

the functions of the DBMS are supported by operating systems (OS) to provide basic services and DBMS is built on 

top of it. The physical data and system catalog are stored on a physical disk. Access to the disk is controlled 



primarily by as, which schedules disk input/output. Therefore, while designing a DBMS its interface with the as 

must be taken into account. 

Components of a DBMS 

The DBMS accepts the SQL commands generated from a variety of user interfaces, produces query evaluation 

plans, executes these plans against the database, and returns the answers. As shown, the major software modules or 

components of DBMS are as follows:  

   

(i) Query processor: The query processor transforms user queries into a series of low level instructions. It is used to 

interpret the online user's query and convert it into an efficient series of operations in a form capable of being sent to 

the run time data manager for execution. The query processor uses the data dictionary to find the structure of the 

relevant portion of the database and uses this information in modifying the query and preparing and optimal plan to 

access the database.  

(ii) Run time database manager: Run time database manager is the central software component of the DBMS, which 

interfaces with user-submitted application programs and queries. It handles database access at run time. It converts 

operations in user's queries coming. Directly via the query processor or indirectly via an application program from 

the user's logical view to a physical file system. It accepts queries and examines the external and conceptual 

schemas to determine what conceptual records are required to satisfy the user’s request. It enforces constraints to 

maintain the consistency and integrity of the data, as well as its security. It also performs backing and recovery 

operations. Run time database manager is sometimes referred to as the database control system and has the 

following components:  

• Authorization control: The authorization control module checks the authorization of users in terms of various 

privileges to users.  

• Command processor: The command processor processes the queries passed by authorization control module.  



                        

Integrity checker: It .checks the integrity constraints so that only valid data can be entered into the database.  

Query optimizer: The query optimizers determine an optimal strategy for the query execution.  

• Transaction manager: The transaction manager ensures that the transaction properties should be maintained by the 

system.  

• Scheduler: It provides an environment in which multiple users can work on same piece of data at the same time in 

other words it supports concurrency.  

(iii) Data Manager: The data manager is responsible for the actual handling of data in the database. It provides 

recovery to the system which that system should be able to recover the data after some failure. It includes Recovery 

manager and Buffer manager. The buffer manager is responsible for the transfer of data between the main memory 

and secondary storage (such as disk or tape). It is also referred as the cache manger.  

Execution Process of a DBMS 

As show, conceptually, following logical steps are followed while executing users to request to access the database 

system:  

(I) Users issue a query using particular database language, for example, SQL commands.  



(ii) The passes query is presented to a query optimizer, which uses information about how the data is stored to 

produce an efficient execution plan for the evaluating the query.  

(iii) The DBMS accepts the users SQL commands and analyses them.  

(iv) The DBMS produces query evaluation plans, that is, the external schema for the user, the corresponding 

external/conceptual mapping, the conceptual schema, the conceptual/internal mapping, and the storage structure 

definition. Thus, an evaluation\ plan is a blueprint for evaluating a query.  

(v) The DBMS executes these plans against the physical database and returns the answers to the user.  

Using components such as transaction manager, buffer manager, and recovery manager, the DBMS supports 

concurrency and recovery. 

Functions of DBMS 

A DBMS performs several important functions that guarantee integrity and consistency of data in the database. Most 

of these functions are transparent to end-users. There are the following important functions and services provided by 

a DBMS: 

  (i) Data Storage Management: It provides a mechanism for management of permanent storage of the data. The 

internal schema defines how the data should be stored by the storage management mechanism and the storage 

manager interfaces with the operating system to access the physical storage.  

(ii) Data Manipulation Management: A DBMS furnishes users with the ability to retrieve, update and delete existing 

data in the database.  

(iii) Data Definition Services: The DBMS accepts the data definitions such as external schema, the conceptual 

schema, the internal schema, and all the associated mappings in source form.  

(iv) Data Dictionary/System Catalog Management: The DBMS provides a data dictionary or system catalog function 

in which descriptions of data items are stored and which is accessible to users.  

(v) Database Communication Interfaces: The end-user's requests for database access are transmitted to DBMS in the 

form of communication messages.  

(vi) Authorization / Security Management: The DBMS protects the database against unauthorized access, either 

international or accidental. It furnishes mechanism to ensure that only authorized users an access the database.  

{vii) Backup and Recovery Management: The DBMS provides mechanisms for backing up data periodically and 

recovering from different types of failures. This prevents the loss of data,  

(viii) Concurrency Control Service: Since DBMSs support sharing of data among multiple users, they must provide 

a mechanism for managing concurrent access to the database. DBMSs ensure that the database kept in consistent 

state and that integrity of the data is preserved.  

(ix) Transaction Management: A transaction is a series of database operations, carried out by a single user or 

application program, which accesses or changes the contents of the database. Therefore, a DBMS must provide a 

mechanism to ensure either that all the updates corresponding to a given transaction are made or that none of them is 

made.  

(x) Database Access and Application Programming Interfaces: All DBMS provide interface to enable applications to 

use DBMS services. They provide data access via Structured Query Language (SQL). The DBMS query language 

contains two components: (a) a Data Definition Language (DDL) and (b) a Data Manipulation Language (DML). 
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